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About this PDF Version of Online Help
This document is a PDF version of the online help. This PDF file is provided so you can easily print multiple topics from the help information or read the online help in
PDF format. Because this content was originally created to be viewed as online help in a web browser, some topics may not be formatted properly. Some interactive
topics may not be present in this PDF version. Those topics can be successfully printed from within the online help.
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Getting Started with Administration Tasks
Getting Started with administrative tasks:

l Understand the logon, password and tab access issues. For details, see "Logon" on page
11.

l Understand the LW-SSO, Identity management SSO, logs, Web server, cryptography,
Supervisor, and working with Xcelsius. For details, see "General Information" on page 18.

l Understand the Start menu. For details, see "Start Menu" on page 34.

Manage Licenses. For details, see "Licenses" on page 39.

l Manage users, roles, and resources. For details, see "Users, Roles, Resources, and
Permissions" on page 52.

l Configure Foundation, pages, Single Sign On, and Website settings. For details, see
"Perform Administration Tasks for Foundation" on page 130.

l Configure Dashboard Settings, Score thresholds, XS settings and engine settings. For
details, see "Scorecard" on page 153

l Configure ITFM settings. For details, see "ITFM Settings" on page 163

l Connect servers in a distributed configuration. For details, see "Distributed Configuration -
Server Connection" on page 261

l Add dimensions to the FinancialManagement context For details, see "Add Dimensions to
FinancialManagement Context and Integrate with PPM" on page 267.

l Manage the Semantic Layer (Business Contexts and Universes). This includes information
about SAP BusinessObjects universes, out-of-the-box Contexts, user-defined Contexts and
explains how to Import Data from Static Files using Context Designer. For details, see
"Contexts and Universes - Semantic Layer" on page 165.

l Manage Contexts and KPIs. This section provides information about adding components to a
page in Dashboard to provide reports about the KPI templates currently in the KPIs Library,
Contexts currently in Executive Scorecard, the structure of Contexts, the list of KPIs included in
a Context, and a list of the fields with names include a specific string that are part of a Context,
or that are used in a specific KPI formula. For details, see "Contexts and KPIs-Related Reports"
on page 213.

l View the Data Lineage of a KPI. The data lineage of a KPI enables you to view, in graphical
format, all the entities, fields, views, tables, contexts, andmore, up to the data source fields that
provide the data used to calculate the KPI. For details, see KPIs, Metrics, Contexts, and Data
Source Integrations.

l Work with Telcom Management Forum KPIs. For details, see "Work with Enhanced
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TelecomOperations Map KPIs" on page 271.

l Localize and Globalize IT Executive Scorecard. For details, see "Localization and
Globalization" on page 281.

l Manage Content Acceleration Packs. Content Acceleration Packs are used for Proof of
Concepts (POCs) sessions or to start creating your own application. For details, see "Content
Acceleration Pack" on page 232. You can also create your ownCAPs using existing Dashboard
pages, Contexts, Scorecards, KPIs, Metrics, and Data (.CSV files). For details, see "Create
Content Acceleration Packs" on page 246.

l Configure Data WarehouseSettings. Information about DataWarehouse configuration is
provided in "DataWarehouse Settings" on page 140.

l Integrate the Data Sources. This section provides information about the Data Source
Management User Interface and a sample data source integration. For details, see "Data Source
Management" on page 95. The complete integration procedures are available in the relevant IT
Executive Scorecard Content ReferenceGuides.

l Manage the ETL. Information about the ETLManagement UI is provided in " ETLManagement
" on page 112.

l Partitioning. Activate partitioning. For details, see "Partitioning" on page 262.

l Use Entity Relationship Tools. For details, see "Enterprise Readiness (ER) Tools" on page
284

l Perform Tasks for Data Source Management. Information about the Data Source
Management UI is provided in "Data SourceManagement" on page 95.

l Perform Administration Tasks for the Back-end. Information about administration tasks that
need to be performed in IT Executive Scorecard and IT Financial Management is provided in
"General Information" on page 18.

l Migrate from a Development or Test Environment to Production. For details, see "Migrate
from Development or Test Environment to Production" on page 290.

l Back up Data Warehouse. For details, see "DataWarehouse Back Up " on page 313.

l Back up Executive Scorecard. For details, see "Executive Scorecard Back Up " on page 317.

l Perform recovery tasks. This includes the backup tasks (Executive Scorecard, and Data
Warehouse back ups). For details, see "Disaster and Recovery" on page 319.

l Legacy and Backward Compatibility Procedures. For details, see "Legacy and Backward
Compatibility Procedures" on page 331.
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Logon
You access the Dashboard, Studio, Explorer, Finance, and Admin tabs from themain logon page:

Note: Only users with the required permissions can view specific tabs.

When you have completed your session, it is recommended that you log out to prevent
unauthorized entry.

You access the IT Executive Scorecard application using a supportedWeb browser, from any
computer with a network connection (intranet or Internet) to the servers. It is recommended to
restore your browser settings to default.

The level of access granted to a user depends on the user’s permissions. For details, see "User
Management" on page 78.

You can initially access the Admin tab through the IT Executive Scorecard logon page, using your
administrator user name and password, created during installation.

Tasks
This section includes:

"Access the logon page " below

"Change the default session timeout of the automatic Log out" on the next page

"Configure the default lockout on log on" on the next page

"Access the logon page and all tabs" on the next page

"User Authentication" on page 13

"User Passwords" on page 13

"Working with Secure Sockets Layer (SSL) in a Distributed Environment" on page 13

"Log out" on page 16

"Shared Secret Key" on page 16

Access the logon page
To access the logon page, enter:

l http://<full resolution host>:<port>/xs. If you are using a non-default port youmust update it
in the URL. For details, see "Web Server" on page 30.

l If you are using a default http port, the port can remain empty.

The Admin tab is configured by default with Lightweight Single Sign-On (LW-SSO). LW-SSO
enables you to log on and automatically have access to LW HP applications, without needing to log
on to those applications. For details, see "LW-SSO " on page 21.

HP IT Executive Scorecard (9.41) Page 11 of 413



Change the default session timeout of the automatic Log out
Executive Scorecard automatically performs a security log out of the XS session. When the
application is idle for a set amount of time the session times out, an automatic log out occurs, and
the logon screen is displayed within the XS application. The timeout is set by default to 30minutes
and can be configured using:

<Installation
directory>\agora\glassfish\glassfish\domains\BTOA\applications\fndwar\WEB-
INF\web.xml

<session-config>
<session-timeout>

30
</session-timeout>

</session-config>

Note: The automatic log out works in conjunction with the Executive Scorecard ping interval,
configured in "Website Settings" on page 138. Youmust select theEnable Keepalive
Session check box to enable the automatic session timeout. An automatic log out occurs only
after the session timeout has been attained and only on a ping request. If the pingmechanism
has been turned off, then no automatic log out occurs. If a user-initiated request comes in
between the time of the timeout and the ping, then the session idle time will be reset and the
timer will start over again.

Configure the default lockout on log on
Executive Scorecard logon allows you, by default, 5 consecutive logon attempts before a 15minute
lockout. You can configure the lockout parameters using the following properties file.

To configure the lockout parameters:

1. Access the following file:
\<HPXS>\agora\glassfish\glassfish\domains\BTOA\config\conf\bsf.properties.

2. Search for the following parameters: 

n accountLockoutMaxAttempts=5

n accountLockoutLockoutPeriod=15

3. Change the default logon attempts and lockout period. 0means that there is no lockout time
configured.

4. Save and restart the Glassfish service.

Access the logon page and all tabs

1. In aWeb browser, enter the http://<server_name>.<domain_name>/XS URL for the fully
qualifiedmachine where XS is installed.
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2. Enter the logon parameters (logon name and password) of a user, and click Log In. After a
successful logon, the user name appears at the top right of the page of the application.

3. Close the original logon window once the application has loaded.

4. Click the Admin tab to navigate the admin pages. Only users with the required permissions can
view the Admin tab.

Note: To log on for the first time, use your administrator password created during installation.

User Authentication
User authentication depends on your configuration. For details, see "User Management" on page
78.

User Passwords
Passwords can be changed in theUser Details pane of the User Management page. Click Edit
Details to change a user's password. For details, see "User Management" on page 78.

Note: Depending on your configuration (working with or without SAP BusinessObjects and
with or without LDAP), the handling of the password can be different. For details, see "User
Management" on page 78.

A passwordmust contain the following:

l At least 6 characters.

l Characters in upper and lower case or numbers.

l Must be different from username.

For example: the user name "Jhon" cannot have a "Jhon11" or "11Jhon" password.

Note:

l Logon parameters are case-sensitive.

l If a password does not follow the correct conventions then the user is still created in SAP
BusinessObjects Enterprise, however the password is not valid andmust be changed.

Working with Secure Sockets Layer (SSL) in a Distributed Environment
When you log on to the IT Executive Scorecard application using the http or https format in a
distributed environment, the following scenarios can occur:
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1. http.

a. When you use the http format to access directly the Executive Scorecard application, the
authentication transfers you to the DataWarehouse application. A message states that a
security certificate is issued. Click theContinue to this website link. In the Data
Warehouse page, click the Certificate Error button in the browser toolbar. In the Certificate
dialog box that opens, click theView Certificate link. In the wizard that opens, select the
Place all certificates in the following store, select the Trusted Root Certification
Authorities location, and click OK. Once you have installed the certificate, and entered
your user and password, the DataWarehouse application transfers you back to the
Executive Scorecard application.

b. When you use the http format to access directly the DataWarehouse application, a
message states that a security certificate is issued. Click theContinue to this website
link. In the DataWarehouse page, click the Certificate Error button in the browser toolbar.
In the Certificate dialog box that opens, click theView Certificate link. In the wizard that
opens, select thePlace all certificates in the following store, select the Trusted Root
Certification Authorities location, and click OK. Once you have installed the certificate,
and entered your user and password, the DataWarehouse application opens.

2. https.When you use the https format:

n IE and Chrome.

i. When you use the https format to access the Executive Scorecard application, the
security certificate issue is displayed. Click the security certificate. In the Certificate
dialog box that opens, click theView Certificate link. In the wizard that opens, select
thePlace all certificates in the following store, select the Trusted Root
Certification Authorities location, and click OK. Continue running the wizard. This
warningmessage is not displayed again. The DataWarehouse application opens in
SSL mode. After performing the logon operation, you can add the Executive Scorecard
certificate in the successfully launched Executive Scorecard application page, not in
the application page itself. When the Java security warning contains the correct
publisher (Hewlett-Packard Company) you should accept the Java security warning
by marking theAlways trust content from this publisher check box in order for this
popup not to be displayed again.

ii. When you use the https format to access directly the DataWarehouse application, a
message states that a security certificate is issued. In the Certificate dialog box that
opens, click theView Certificate link. In the wizard that opens, select thePlace all
certificates in the following store, select the Trusted Root Certification
Authorities location, and click OK. This warningmessage is not displayed again. The
DataWarehouse application opens in SSL mode. When the Java security warning
contains the correct publisher (Hewlett-Packard Company) you should accept the
Java security warning by marking theAlways trust content from this publisher
check box in order for this popup not to be displayed again.

n Firefox.
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When you use the https format to access directly the Executive Scorecard application or
the DataWarehouse application, and you work with Firefox, youmust perform the following
procedure:

i. Open each of the servers using https. The following screen opens:

ii. Click I Understand the Risks. The following page opens:
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iii. Click Add Exception. The following screen opens:

iv. Click Confirm Security Exception.

Note:When you use the https format and you want to access SAP BusinessObjects
Enterprise reports, the reports are displayed using the http format.

Log out
To log out:

You can log out by clicking Logout (in the top right corner of the application). The session closes.
To log on again, youmust provide the user and password.

Shared Secret Key
Executive Scorecard functionality requires a connection to SAP BusinessObjects Enterprise
through a trusted authentication. In order to configure the trusted authentication policy youmust
define the shared secret key.
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The shared secret key, created in the post-install process, is used by the client and the CMS to
create the trusted authentication password. This password is used to establish trust.

Note: To change the shared secret key youmust change the key in SAP BusinessObjects
Enterprise, run the post-install wizard and enter the new shared secret key. For details, see the
IT Executive Scorecard Installation and Configuration Guide.
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General Information
The following sections contain general information pertaining to the administration of Executive
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Security Recommendations
Immediately following installation or upgrade procedures, perform the following steps.

For MSSQL Database improved security:

l Disable xs_cmdshell. For details, see http://technet.microsoft.com/en-
us/library/ms175046.aspx.

l Revoke the public permissions from xp_instance_regread and xp_regread . For details, see
http://technet.microsoft.com/en-us/library/ms187719.aspx.

For Database Stored Procedures:

The database contains extended stored procedures that allow read and write capabilities for
sensitive data from theWindows registry.

In order to remove an extended stored procedure, use: sp_dropextendedproc @functname='
{name of extended stored procedure}.

Note: Some applications may not work properly without these stored procedures. Make sure to
verify that they are not in use by a production application before removal.

l xp_instance_regaddmultistring

l xp_instance_regdeletekey

l xp_instance_regdeletevalue

l xp_instance_regenumkeys

l xp_instance_regenumvalues

l xp_instance_regread

l xp_instance_regremovemultistring

l xp_instance_regwrite

l xp_regaddmultistring

l xp_regdeletekey

l xp_regdeletevalue

l xp_regenumkeys

l xp_regenumvalues

l xp_regread
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l xp_regremovemultistring

l xp_regwrite

For User Management:

l To improve password policy, use LDAP. For details, see "User Management" on page 78.
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LW-SSO
HP Lightweight Single Sign-On is amethod of access control that enables you to navigate to other
HP products that implement LW-SSOwithout supplying credentials again. A user can log on once
and gain access to the resources of HP software systems without being prompted to log on again.
The applications inside the configured group of software systems trust the authentication, and there
is no need for further authentication whenmoving from one application to another.

For details, see "Single Sign-On Settings" on page 133.

Secure Socket Layer (SSL)
A Secure Socket Layer (SSL) connection give Executive Scorecard the ability to encrypt the
network data transfer between two servers.

This section explains how to configure a Secure Socket Layer (SSL) connection between the
application server and the database server or between the DWH) server and the database server.

Tasks
Create a Certificate

1. Pre-requisite:

a. Install SP3 for SQL server 2008.

b. Install SP2 for SQL server 2008 R2.

2. Generate a certificate and export it on your MS SQL server. You can get a certificate from a
third-party CA or generate a self-certificate.

Example: You can generate a self-certificate by using the selfssl tool (either you can use
makecert from .net SDK or pvk2pfx). You can download it from
http://www.microsoft.com/en-us/download/details.aspx?id=17275 and install it on your
database server.

a. To create a certificate using the selfssl tool, go toC:\Program Files (x86)\IIS
Resources\SelfSSL and run:
selfssl.exe /N:CN=<FQDN> /K:1024 /V:7 /S:1 /P:442 /T

where <FQDN> is the database server full qualified domain name and /V:7 indicates the
number of days after which the certificate expires.

Enter y to theDo you want to replace the SSL settings for site 1? question.

Open the Certificate

Open the Certificate snap-in and proceed as follows:
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1. Open theMMC console, click Start, and then click Run.

2. In the Run dialog box type:MMC.

3. In the Consolemenu, click Add/Remove Snap-in....

4. Click Add, and then click Certificates.

5. Click Add again.

6. You are prompted to open the snap-in for the current user account, the service account, or for
the computer account. Select theComputer Account.

7. Select Computer computer, and then click Finish.

8. Click Close in theAdd Standalone Snap-in dialog box.

9. Click OK in theAdd/Remove Snap-in dialog box.

Your installed certificates are located in theCertificates folder in thePersonal container.

Export the certificate

1. In theMMC console, expand the list tree to access Certificates under Trusted root
certification authorities.

2. Right-click the name of the certificate you created.

3. Click Export in all tasks.

4. Click Next, Next, andNext.

5. Input the path and the name of the file you want to save.

6. Click Save, Next, and then Finish.

Configure your MS SQL server

1. Run the SQL server ConfigurationManager.

2. Expand theSQL server network Configuration, right-click theProtocols of the
MSSQLSERVER, and click Properties.

3. In the Certificate tab, select the certificate name that was created in "Export the certificate"
above, and click OK.

4. Restart the SQL server engine.

Generate a trust store

Generate a trust store using Java keytool in your application server and DWH server.
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1. Copy the certificate you created in "Create a Certificate" on page 21 to the application server
and the DWH server.

2. Go to <HPXS>\agora\jdk\bin.

3. Run keytool -import -alias SGDLITVM0078.fpazsh.com -file
C:\Users\Administrator\Desktop\test.cer -keystore c:\truststore

4. Input the trust store password.

Configure JDBC connection pool in your application server and DWH server

Perform the following in both the application server and the DataWarehouse (DWH) server:

1. In the application server and in the DWH server, open a Browser, and open
http://127.0.0.1:10001.

2. Expand the list tree and click Resources > JDBC > JDBC Connection Pools:

a. Click CentralDBConnectionPool.

In the right frame, click Additional Properties > Add Property.

o Input Name “EncryptionMethod”, Value “SSL”

o Input Name “TrustStore”, Value “C:\\Mytruststore”

o Input Name “TrustStorePassword”, Value “Mypassword”

b. Click Save.

a. Click DataDbConnectionPool.

In the right frame, click Additional Properties > Add Property.

o Input Name “EncryptionMethod”, Value “SSL”

o Input Name “TrustStore”, Value “C:\\Mytruststore”

o Input Name “TrustStorePassword”, Value “Mypassword”

b. Click Save.

a. Click ManagementDbConnectionPool.

In the right frame, click Additional Properties > Add Property.
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o Input Name “EncryptionMethod”, Value “SSL”

o Input Name “TrustStore”, Value “C:\\Mytruststore”

o Input Name “TrustStorePassword”, Value “Mypassword”

b. Click Save.

a. Click TargetDbConnectionPool.

In the right frame, click Additional Properties > Add Property.

o Input Name “EncryptionMethod”, Value “SSL”

o Input Name “TrustStore”, Value “C:\\Mytruststore”

o Input Name “TrustStorePassword”, Value “Mypassword”

b. Click Save.

3. Test the connection: click theGeneral tab, and then click thePing button.
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Logs
IT Executive Scorecard records the procedures and actions performed by the various components
in log files. The log files are usually designed to serve HP Software Support when Executive
Scorecard does not perform as expected. The default severity threshold level for log files differs per
log, but is generally set to eitherWarning or Error.

You can view log files with any text editor.

Log File Locations
The following tables list the log files created in an Executive Scorecard implementation by
component.

Common Component Log Files

Description Log Filename Location

Records all requests
processed by the
server.

access.log <Installationdirectory>
\agora\webserver\logs

The server error log is
themost important
log file.

This is the place
where Apache httpd
sends diagnostic
information and
records any errors
that it encounters
when processing
requests.
It is the first place to
look when a problem
occurs
with starting or
operating theWeb
Server.

error.log <Installationdirectory>
\agora\webserver\logs

install.log <Installationdirectory>
\agora\webserver\logs
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Description Log Filename Location

Contains information
about
communications
between theWeb
Server and the
application server
(Glassfish).

jk.log <Installationdirectory>
\agora\webserver\logs

Log records of all
secured requests
processed by the
Web Server.

ssl_request.log <Installationdirectory>
\agora\webserver\logs

Logs the post-install
flow. Is useful when
the post-install
configuration wizard
fails.

ConfigWizard.log <Installationdirectory>
\agora\confwizard\log

Logs file parsing
tasks during post-
install configuration
wizard.

FileParser.log <Installationdirectory>
\agora\confwizard\log

Logs application
loading and
permission
enforcement related
to the application
framework.

applicationfw.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

Logs requests for
authentication and
population of user
roles and
permissions.

athN.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

Logs user
management user
interface details.

aui.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs
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Description Log Filename Location

Logs the usage of
SAP
BusinessObjects
services, including
issues locating the
SAP
BusinessObjects
CMS.

bo-services.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

BTOSecurity
Framework (BSF)
server side logs
authentication
information about
authn, LW-SSO, and
user mng.

bsf.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

Logs the usage of
foundation services.

btoe-services.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

Logs SAP
BusinessObjects
datalayer
transactions such as
problems with SAP
BusinessObject
Universes or queries.

datalayer.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

Foundation core
components log.

foundation.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

Hibernate log . hibernate.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

JVM general log. jvm.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

Licensing logs. license-
services.log

<Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

Properties table logs. properties.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

General GlassFish
log.

server .log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

Settings
management logs

settings.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs
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Description Log Filename Location

Logs authentication
details related to IDM
and LW SSO.

sso.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

User Interfacemash-
up logs.

uim.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

UserManagement
actions log, including
problems with
communication to
SAP
BusinessObjects.

userMng.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

MQBroker service
log.

log.txt <Installationdirectory>
\agora\glassfish\glassfish\domains\domain1
\imq\instances\imqbroker_host1\log

Executive Scorecard Log Files

Description Log filename Location

Logs all the dashboard’s
server side logs.

dashboard.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

Logs general information
for Executive Scorecard
Studio, the client module
used for tailoring
Executive Scorecard.

studio.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

Logs general information
about the engine, and
KPIs.

engine.log <Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

Provides a summary of
calculation cycles, and
statistics about KPI
engine performance.

engine_
statistics.log

<Installationdirectory>
\agora\glassfish\glassfish\domains\BTOA\logs

Data Warehouse Log Files
Log files can be accessed under:

l datawarehouse\logs

l C:\<Installationdirectory>\agora\glassfish\glassfish\domains\btoa\logs\server.log

All information in the DataWarehouse log files is automatically sent to theWindows Event Viewer
Application log.
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To access Data Warehouse log information:

1. On theWindows taskbar, click Start > Administrative Tasks > Event Viewer.

2. ExpandWindows Logs, right-click Application, and then click Filter Current Log.

3. Select the relevant Event Levels, select the relevant Event Sources, and then click OK.

All the DataWarehouse Event Sources begin with the DWH string.
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Web Server
IT Executive Scorecard uses the Apache web server for securing the application and caching static
content in order to improve client performance. The web server is installed and configured in the
deployment procedure and does not require any changes or maintenance.

The default ports are listed in the IT Executive Scorecard Support Matrix. If you use a non default
port for the URL, youmust enter the application using http://<host>:<port number>/xs or
http://<host>:<port number>/dwh.

Note: These ports can be configured to any other ports in the deployment procedure.
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Cryptography
The encryption properties files are located in <Installationdirectory>\agora\conf. The path can be
determined by setting the crypt.conf.dir.path system property to the relevant path. The
management database credentials encrypted locally on each server. Youmust also store all the
relevant configuration for decrypting locally.

The following encryption keys are available:

l Encryption Key:Single shared key for all servers shared through the database. Stored on each
machine locally in the encryption properties files as part of the post-install procedure.

l Seed Key:Key that is generated after each post-install procedure. Themain encryption key is
stored in the seed key.
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IT Executive Scorecard Supervisor
The HP IT Executive Scorecard Supervisor monitors whether the Executive Scorecard server
processes are up and running.

The Supervisor consists of two elements:

l Themanagement element manages (starts/stops/monitors) theWeb Server, MQ Broker, and
Glassfish components that are services. The Supervisor manages them in the following order:
a. Web Server

b. MQ Broker

c. Glassfish

l The watchdog element monitors processes. If a process is down, the SupervisorWatchdog tries
to start it automatically.

The Supervisor is a service that works onWindows.

Contact HP Software Support Online web site (http://www.hp.com/go/hpsoftwaresupport) if the
monitor cannot start the Supervisor process.
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Xcelsius
You can use Xcelsius to display Flash reports or dashboards over Executive Scorecard target
schemas.

You can create Xcelsius reports based on SAP BusinessObjects EnterpriseWebi reports. For
details on the pre-definedWebi reports provided with Executive Scorecard, see Xcelsius Reports in
the IT Executive Scorecard Reports ReferenceGuide.

You can then add these reports to Dashboard page using the Xcelsius components. For details, see
Add a SWF Report Viewer Component to a Page or Add Xcelsius Reports Viewer Component to a
Page in the IT Executive Scorecard Business Analyst Guide.

The InstallationMedia for Xcelsius as well as the Xcelsius Installation Guide are provided on a
separate installation disc that you can download (TB812-15009.ISO). The disc also includes non-
core utilities and 3rd party application that enhance Executive Scorecard.
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Start Menu
During the installation, a start menu is added to the settings of themachine on which Executive
Scorecard was installed.

You can use the Start menu to perform the following tasks:

Launch Executive Scorecard Using the Start Menu 35

Start the Post-Install Wizard Using the Start Menu 35

Renew your License Using the Start Menu 35

Enable or Disable the GlassfishWeb Server using the Start Menu 36

Uninstall HP IT Executive Scorecard Using the Start Menu 37

Access the Documentation Library and the Installation and Configuration documents using
the Start Menu 38
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Launch Executive Scorecard Using the Start
Menu

During the installation, a start menu is added to the settings of themachine on which Executive
Scorecard was installed. You can lainch Executive Scorecard using the Start menu.

Tasks
Launch Executive Scorecard

1. To access the IT Executive Scorecard start menu that is added to eachmachine, select Start
> Programs > HP Executive Scorecard.

2. Select HP Executive Scorecard.

This launches IT Executive Scorecard.

Start the Post-Install Wizard Using the Start
Menu

During the installation, a start menu is added to the settings of themachine on which Executive
Scorecard was installed. You can start the post-install wizard using the Start menu.

Tasks
Start the Post-Install wizard

1. To access the IT Executive Scorecard start menu that is added to eachmachine, select Start
> Programs > HP Executive Scorecard.

2. Select Configuration Wizard.

Follow the steps in the ConfigurationWizard that opens.

Renew your License Using the Start Menu
During the installation, a start menu is added to the settings of themachine on which Executive
Scorecard was installed. You can renew your license using the Start menu. For details, see
"Licenses" on page 39.
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Enable or Disable the Glassfish Web Server
using the Start Menu

During the installation, a start menu is added to the settings of themachine on which Executive
Scorecard was installed. You can enable or disable the GlassfishWeb Server using the Start menu.

Tasks
"Enable the GlassfishWeb Server Using the Start Menu " below

"Disable the GlassfishWeb Server Using the Start Menu " below

Enable the Glassfish Web Server Using the Start Menu

1. To access the IT Executive Scorecard start menu that is added to eachmachine, select Start
> Programs > HP Executive Scorecard.

2. Select Enable HP Executive Scorecard.

This enables the GlassfishWeb Server. Users can access IT Executive Scorecard.

Disable the Glassfish Web Server Using the Start Menu

1. To access the IT Executive Scorecard start menu that is added to eachmachine, select Start
> Programs > HP Executive Scorecard.

2. Select Disable HP Executive Scorecard.

This disables the GlassfishWeb Server. Users cannot access IT Executive Scorecard.
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Uninstall HP IT Executive Scorecard Using the
Start Menu

During the installation, a start menu is added to the settings of themachine on which Executive
Scorecard was installed. You can use the Start menu to uninstall IT Executive Scorecard.

Tasks
Uninstall HP IT Executive Scorecard Using the Start Menu

1. To access the IT Executive Scorecard start menu that is added to eachmachine, select Start
> Programs > HP Executive Scorecard.

2. Select Uninstall HP Executive Scorecard.

This uninstalls the IT Executive Scorecard on the server.

IT Executive Scorecard is first uninstalled in silent mode and then the uninstall wizard appears.
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Access the Documentation Library and the
Installation and Configuration documents using
the Start Menu

During the installation, a start menu is added to the settings of themachine on which Executive
Scorecard was installed. You can use the Start menu to access the IT Executive Scorecard
Installation and Configuration Guide and theOnline Documentation Library Help Center.

Tasks
Access the HP Executive Scorecard Deployment Guide Using the Start
Menu

1. To access the IT Executive Scorecard start menu that is added to eachmachine, select Start
> Programs > HP Executive Scorecard.

2. Select HP Executive Scorecard Deployment Guide.

This opens the IT Executive Scorecard Installation and Configuration Guide.

Access the Online Documentation Library Using the Start Menu

1. To access the IT Executive Scorecard start menu that is added to eachmachine, select Start
> Programs > HP Executive Scorecard.

2. Select HP Executive Scorecard Documentation Library.

This opens the HP Executive Scorecard Documentation Library Help Center in yourWeb
browser.
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Licenses
This section explains how to renew a license using the Start menu and how to check if all your user
licenses are valid.

To access:
Click Help > About in the upper right corner of the application.

Section navigation: l "LearnMore" belowl"Tasks" below

Learn More
Two types of licenses are available:

l Power Named User License. This license is for every type of user with no limitation on the
permissions.

l Casual Named User/Viewer License. This license is for users with a very limited set of
permissions.

You cannot purchase a standaloneCasual Named User/Viewer License. With theCasual
Named User/Viewer License youmust also purchase at least onePower Named User License
(youmust apply 2 License Keys).

Example

l If you want 50 Viewer users, youmust purchase at least 1Power Named User License
(Advanced user) and 50Casual Named User/Viewer Licenses (for the Viewer users).

l If you want 10 Advanced users and 15 Viewer users, youmust purchase 10Power Named
User Licenses (for the Advanced users)and 15Casual Named User/Viewer Licenses
(for the Viewer users).

Tasks
This section includes:

"Renew your license using the Start menu" below

"Check users licenses" on page 43

Renew your license using the Start menu

1. To access the IT Executive Scorecard start menu that is added to eachmachine, select Start
> Programs > HP Executive Scorecard.

2. In the Administration folder, select License Renewal.
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The Introduction page opens.

3. Click Next. The License Management - Load a Power Named User License page opens. If
a valid Power NamedUser License was found, themessageA valid Power Named User
License was found is issued.
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4. Click Next. The License Management - Load a Viewer License page opens.
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a. If you have a Casual NamedUser/Viewer License, click Load to load it. When the
operation performs successfully, themessageA valid Casual Named User/Viewer
License was found is issued. Click Next to complete the renewal.
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b. If you do not want a Casual NamedUser/Viewer License, click Next to complete the
renewal.

Check users licenses
You can check if all the users of the application have valid licenses.

1. Prerequisites:

If you are working with LDAP users, make sure you have performed the appropriate
procedures. For details, see "User Management" on page 78.

2. Get the user license information:

a. Use an authorized HP user to log on to the customer’s Executive Scorecard installation.

b. Click Help > About in the top right-hand corner of the application display.

The type of license (temporary or permanent), the number of registered users and the
number of licensed seats (the number of purchased licenses) are displayed.
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c. Click the number of users to view the details of the users. A list of the users is displayed.

When users do not have a valid license, a red icon is added to the right of the Registered
users indication:

Note: An error image to the left of Registered Users and a tooltip indicate if there has
been a breach of contract. User that are not part of the Viewer Users Group are
considered Advanced Users and are counted accordingly.
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Chrome and BOE Reports
If you are using the Chrome browser and your Dashboard pages include SAP BusinessObjects
Enterprise (BOE) reports, you are presented with a shield icon in the browser address bar each time
you start the application. This creates an extra step to tell the browser to run the content.

Tasks
You can decide to allow the running of insecure content per session or by default.

This section includes:

"Allow the running of insecure content per session" below

"Allow the running of insecure content by default" below

Allow the running of insecure content per session
When you open Executive Scorecard in Chrome and the shield icon appears in the top right corner
of your application:

1. Click the shield.

2. In the dialog box that opens, click Load unsafe script:

You can now view BOE reports in Dashboard pages.

Allow the running of insecure content by default
To run BOE reports in Dashboard pages in Chrome, youmust set Chrome to allow the running of
insecure content by default by adding the --allow-running-insecure-content parameter to the start
up of the shortcut.

1. Create a Chrome shortcut on the desktop by right-clicking and dragging the Chrome browser
from theWindows> Startmenu to the desktop, and select Create shortcuts here.
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You now have a Chrome shortcut on the desktop.

2. Right-click the shortcut and select Properties.

3. In the Target field, add --allow-running-insecure-content at the very end of the string that is
already there.
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4. Click Change Icon.

5. In the Change Icon dialog box, in the Look for Icons in this file field, replace the current
directory string with:%SystemDrive%\HPXS\installation\misc\launcher.ico. Click OK.
Click OK again to change the icon to the XS launcher icon. Then click Apply to apply all of the
changes.
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6. In the your desktop, double-click the shortcut icon to start the Chrome browser. Then click
and select Settings.
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7. In theOn Startup section, select Open a specific page or set of pages and click Set
pages.

8. In the URL box enter the URL for Executive Scorecard, for example: https://systemFQDN/xs.
Then click OK to save the changes.
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9. Close the Browser and then restart it to test the changes. You should be presented with an
Executive Scorecard logon screen.

10. Log in and test to make sure that the BOE reports are displayed without the security icon.
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Users, Roles, Resources, and Permissions
You use users, roles, resources, and permissions to configure who can do what and who can see
what data in XS.

Learn More
Resources
A resource is a logical group of one or more XS application data items (for example Dashboard
pages, Scorecards, Budgets, or Budget Cost Centers). Once you define resources, you can attach
the resource to a permission.

Roles and Permissions
Each role is a set of permissions. Permissions define which actions the user can perform and on
which resources. For example, you can create a role that enables its users to create Dashboard
pages.

Users and Groups
Each user has a list of roles that define their permissions. When you assign a role, that user only
has access to specific portions of the application and specific resources that are relevant to their
role. You can also define groups of users with the same roles or access rights. When you attach a
user or group to a group, the user or group inherits all of the group’s roles.

Typical users are:

Term Description

Viewer Users Users that have limited permissions and inmost cases can only view content in
the Dashboard and Explorer without any option tomodify it. They will not have
access to the Studio, Finance and Admin tabs. In some cases we refer to them
as Viewer users

Advanced
Users

All users that are not Viewer users (including users under the Administrator
group, Scorecard Administrator Group and users that are not under any group).

Scorecard
Administrator

Type of Advanced user with permissions to create Scorecards and Dashboard
pages

Super-Admin Super user, a subset of the Advanced User – normally this user deals with the
installation, foundation and permission issues. This user is the Admin user that
was created during installation.

Diagram
The following diagram illustrates the relationship between users, groups, roles, permissions, and
resources in the Admin tab.
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Tasks
The Administrator uses the Admin tab to define users that have roles, which contain a set of
permissions that may contain resources. It is recommended to create resources and attach them to
permissions first in the user management process.

1. "ResourceManagement" on the next page

2. "RoleManagement" on page 60

3. "User Management" on page 78
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Resource Management
The ResourceManagement page enables you to view resource and resource types, as well as
create a resource. You can also select instances or application data or components that comprise a
resource.

To access:
Select Admin > Users and Roles > Resource Management.

Section navigation: l "LearnMore" below l "Tasks" below l "UI Description" on the
next page

Learn More
Actions users can perform depend on their roles and permissions. Resources are the basis for user
and role management. For each user or group, you assign a set of permissions called 'Role' that
allow to perform specific actions on specific resources.

l Resources. A resource is a logical group of one or more application data sets or components.
Once you define resources, you attach the resource to a permission.

l Instances. An instance is an application data or components that can bemanaged by a user
according to the user's permissions.

Instances are the available application data or components defined in the system.

Note: Users that are created in the Admin tab and require permissions to view reports
pages must be assigned those permissions in SAP BusinessObjects Enterprise.

l Scorecard Resources. XS enables you assign specific Scorecard resources to a user.
Additionally, you can restrict user permissions and only allow then to view Scorecards,
Dashboard pages and data that they have been assigned by the Administrator.

Tasks
This section includes:

"Create a resource:" below

"Manage instances:" on the next page

Create a resource:

1. Select Admin > Users and Roles > Resource Management.

2. In theResources area, select the type of resource (Budget Cost Centers, Budgets, Pages,
orScorecards) in the tree, and click Create resource to create a new resource.
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3. Enter the name of the resource inResource and a description inDetails.

4. Click OK to save your new resource.

Manage instances:

1. Select Admin > Users and Roles > Resource Management.

2. Select a resource in theResources area.

3. In the Instances area of theResource Details pane click Add instances to open the
Manage Instances dialog box. Instances are the available application data or components
defined in the system that are attached to resources.

4. Select the instance from theAvailable Instances list and use the arrows tomove the instance
to theSelected Instances list.

5. Click OK to save your changes.

UI Description
Resource Management Page
Click to refresh the page.
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Resources Pane
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Select a resource and click Create resource to open theCreate new resource
dialog box and create a new resource of that type.

After you create the new resource, the Resource Details pane opens. For details,
see "Resource Details Pane" below.

Delete Resource. Deletes the selected resource.

If the resource is the only resource attached to a permission and that permission
is attached to any roles, deleting the resource detaches the corresponding
permissions from these roles.

Refresh. Refreshes the displayed information.

<Resources
Tree>

Contains the resource types and the resources defined for each type.

By default, the tree includes the following resource types:

l Budget Cost Centers

l Budgets

l Scorecards

l Pages

Resource Details Pane
When you select a resource in theResources pane, the details appear in this pane.
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User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Resource
type name

The name of the selected resource type. This information is displayed when you
set the cursor on one of the resource types in the Resources pane.

Resource
type
description

The description of the selected resource type. This information is displayed when
you set the cursor on one of the resource types in the Resources pane.

Add Instances. Adds instances to the selected resource. Opens theManage
Instances dialog box.

Each resource can have one or more assigned application data or component
instances.

In theManage Instances dialog box, select a page from theAvailable Instances
list and use the arrows tomove the instance to theSelected Instances list. For
details, see "Manage Instances Dialog Box" on the next page.

These instances are the available pages defined in the system.

Remove Instances. Removes the selected instance from the resource.

Description The description of the selected resource.

Resource The name of the selected resource.
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UI Element Description

Edit Details Edits the selected resource name and description.

Resource
Description

The description of the selected resource.

Resource
Name

The name of the selected resource.

Instances List of page instances for the selected resource.

Manage Instances Dialog Box
This dialog box enables you to attach pages to a resource.

Select the resource and click the button.
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User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Select an instance from theAvailable Instances list and use the arrows
tomove the instance to theSelected Instances list.

Available and
Selected Instances

Each resource can have one or more assigned instances.
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Role Management
You can define user roles and application permissions in the Admin tab. You can also assign
resources to specific permissions.

To access:
Select Admin > Users and Roles > Role Management.

Section navigation: l "LearnMore" below l "Tasks" on page 71 l "UI Description" on
page 72

Learn More
Roles and Permissions
Each role contains set of permissions. Permissions define which actions can be performed by the
user. For example, you can create a role that enables its users to create pages or view specific
ones. In some cases, actions can be performed according to the resource attached to a permission.

Note: Users that are created in the Admin tab and require permissions to view reports pages,
must be assigned those permissions in SAP BusinessObjects Enterprise.

Resources
A resource is a logical group of one or more XS application data items (for example pages or
budgets). Once you define resources, you attach the resources to a permission. For example, you
can specify that the CIO has View permissions for CIO resources, while the Administrator has
View permissions for all resources.

Tip: It is recommended to define resources prior to defining roles. For details, see"Resource
Management" on page 54.

Pre-Defined Roles

Note: Every out-of-the-box Scorecard has its own dedicated resource and role.

Executive Scorecard and IT Financial Management roles can be assigned any permissions.
Executive Scorecard and IT Financial Management roles are available with the following out-of-the-
box permissions:
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Pre-Defined Role
(from A-Z) Description Permissions Module

Administrator The application
administrator.

When a user with the
Administrator role
activates a CAP,
everyone get
permissions to view,
edit, delete all the
Scorecards in the CAP.

All Permissions IT Executive
Scorecard
and IT
Financial
Management

BUDGET_
COORDINATOR

Defines the budget
configuration. Notifies
the cost center
managers to populate
the budget line items,
follow up with cost
center managers for
timely update of
budgets, and review the
input from all included
cost centers. Publishes
the budget to use in
allocation scenarios.
This role is related to IT
Financial Management.

l Finance

l Budget

l View consolidated
budget

l Manage cost center
budget

l Manage consolidated
budget

IT Financial
Management

DWH administrator N/A

FINANCIAL
ANALYST

Uses published
budgets in allocation
scenarios. This role is
related to IT Financial
Management.
A FINANCIAL_
ANALYST has the
following permissions:

l Budget

l Finance

l Manage Allocation
Scenarios

l Manage Consolidated
Budget

l Manage Cost Center
Budget

l View Consolidated
Budget

IT Financial
Management
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Pre-Defined Role
(from A-Z) Description Permissions Module

Scorecard
Administrator

Creates andmanages
specific Scorecards
and Pages. Only a user
with the Scorecard
Administrator role can
view the created
Scorecard. Once a
Scorecard is created,
the system
automatically generates
a resource for the
Scorecard and a role
called GEN_
<Scorecard name>.
This Scorecard can
then only bemanaged
by the Scorecard
creator and users with
the relevant GEN_
<Scorecard name>
role.

In Dashboard, a user
can only see a
Scorecard when he has
the relevant permission.
If a component is
configured with a
specific Scorecard,
Perspective, Objective,
KPI, or KPI Breakdown,
the user cannot see it,
and the following
message appears:
Data is not displayed
because you do not
have the correct
viewing permissions.
Contact your
administrator.

When a user with the
Scorecard
Administrator role
activates a CAP, only

Studio

Manage Page

Administer Pages

Select KPI

Explorer Access

IT Executive
Scorecard
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Pre-Defined Role
(from A-Z) Description Permissions Module

the user gets
permissions to view,
edit, delete all the
Scorecards in the CAP.

When a user with the
Scorecard
Administrator role
drags a KPI from the
Public Metrics and
KPIs folder into a
Scorecard in the Studio,
a clone of the KPI is
added to the Scorecard
and the original
KPI remains in the
Public Metrics and
KPIs folder to be
available for other
Scorecard
Administrators. If a user
with theAdministrator
role drags a KPI from
thePublic Metrics and
KPIs folder into a
Scorecard in the Studio,
the KPI is added to the
Scorecard and is
removed from the
Public Metrics and
KPIs folder.
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Pre-Defined Role
(from A-Z) Description Permissions Module

Viewer User
Note: The Viewer
user list of
permissions
cannot bemodified
(by any user).

Permission

Viewer user
allowed
access

Users and
roles

N

Administer
pages

N

Edit settings N

Data Source
management

N

Admin
access

N

Select KPI N

Manage
Allocation
scenarios

N

View
Settings

N

Manage
page

N

View
Scorecard

Y

The Super
Administrator
can assign
the specific
Scorecards
the Viewer
user can
view.
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Pre-Defined Role
(from A-Z) Description Permissions Module

Permission

Viewer user
allowed
access

View Page Y

The Super
Administrator
can assign
the specific
Dashboard
pages the
Viewer user
can view.

View
Consolidated
budget

N

Manage
annotations

Y

Manage
consolidated
budget

N

context
management

N

Cascade
Scorecard

Y

ABC
Management

N

Explorer
access

Y

Budget N

Studio N

Content
acceleration
packs

N
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Pre-Defined Role
(from A-Z) Description Permissions Module

Permission

Viewer user
allowed
access

Manage cost
center
budget

N

Finance N

Pre-Defined Permissions

XS Application
Elements Create and Edit View

Studio l To enter the Studio tab you
need theStudio permission

l To create Scorecards in the
Studio, you need theStudio
permission.

Note: TheView
Scorecard permission
enables customer with
different departments to
use XS. Each department
can have its own
Scorecards that cannot be
viewed or used by other
departments. This
removes the need for each
department to install its
own XS instance.

l To edit relevant Scorecards,
you need theView Scorecard
permission for the relevant
Scorecard.

l To view the Studio tab you
need theStudio permission.

l To view specific Scorecards
(their Perspectives,
Objectives, and KPIs) you
need theView Scorecard
permission for the relevant
Scorecard.

l To view all the standalone
KPIs in the Studio, you need
theSelect KPI permission.
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XS Application
Elements Create and Edit View

Explorer N/A l To view the Explorer tab you
need theExplorer Access
permission

l To view the relevant
Scorecards (their
Perspectives, Objectives, and
KPIs) in Explorer, you need the
View Scorecard permission.

l To view all the standalone
KPIs in the Studio, you need
theSelect KPI permission.

Finance l To view the Finance tab you
need the Finance permission.

l To view the Finance tab you
need the Finance permission.

l Budget l To view the Finance tab you
need the Finance permission.

l To create and edit the life cycle
of consolidated budgets, you
need the Manage
Consolidated Budget
permission.

l To create and edit a specific
cost center budget, you need
theManage Cost Center
Budget permission for the
specific cost center instance.

l To view the Finance tab you
need the Finance permission.

l To view budgets, you need the
Budget permission.

l To view existing consolidated
budgets you need the View
Consolidated Budget
permission.

l Allocation l To view the Finance tab you need the Finance permission.

l To create, edit, and view allocation scenarios you need theManage
Allocation Scenarios permission.

l To view allocation scenarios using Cost Explorer, you need the
Manage Allocation Scenarios permission.

l Cost N/A l To view the Finance tab you
need the Finance permission.

l To view Cost Explorer, you nee
theManage Allocation
Scenarios permission.
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XS Application
Elements Create and Edit View

Admin l To access the Admin tab but
not the tabs in the Admin tab,
you need theAdmin Access
permission.

l To access the Admin tab but
not the tabs in the Admin tab,
you need theAdmin Access
permission.

l Users and Roles

n User
Management

n Role
Management

n Resource
Management

l To view the Admin tab you
need theAdmin Access
permission.

l Tomodify the contents of the
Users and Roles accordion tab
you need theEdit Settings
permission.

l To view the Admin tab you
need theAdmin Access
permission.

l To view the Users and Roles
accordion tab you need the
Users and Roles permission.

l Data Source
Management

l To view the Admin tab you need theAdmin Access permission.

l To access the Data SourceManagement page and to activate the
content packs you need theData Source Management permission.

l ETL Management l To view the Admin tab you need theAdmin Access permission.

l Tomonitor andmanage the ETL process for DataWarehouse you
need theABC Management permission.
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XS Application
Elements Create and Edit View

l Foundation

n Foundation

n Single Sign-On

n Pages

n Website

l To view the Admin tab you
need theAdmin Access
permission.

l To edit the contents of the
Scorecard settings, Foundation
settings, and Data
Warehouse settings accordion
tabs you need the
Edit Settings permission.

l To view the Admin tab you
need theAdmin Access
permission.

l To view the Scorecard
settings, Foundation settings,
and DataWarehouse settings
accordion tabs you need the
View Settings permission.

l DataWarehouse

l Scorecard

n Dashboard
Settings

n Engine Settings

n Score
Thresholds

n XS Settings

l ITFM l To view the ITFM tab in the
Admin tab , you need the
Admin Access permission.

l To view the ITFM tab in the
Admin tab , you need the
Admin Access permission.

l Semantic Layer l To view the Admin tab you
need theAdmin Access
permission.

l To view the Admin tab you
need theAdmin Access
permission.

l To use the Context Designer
feature you need the Context
Management permission.

l Content
Acceleration Pack

l To view the Admin tab you need theAdmin Access permission.

l To view, edit, delete Content Acceleration Packs, you need the
Content Acceleration Pack permissions.
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XS Application
Elements Create and Edit View

Dashboard l To add pages, view andmodify
all the pages in the Dashboard
(add components, delete
components, and even delete
components) you need the
Administer Pages
permission.

l To add pages, view andmodify
all the pages in the Dashboard
(add components, delete
components, and even delete
components) you need the
Administer Pages
permission.

l To configure components on
the page you need theSelect
KPI permission

l Specific page in
Dashboard

l To view andmodify (add
components, delete
components, and even delete)
the relevant page in the
Dashboard you need the
Manage Page permission.

l To create a new page in
Dashboard you need the
Administer Pages
permission. Once the page is
created and assigned to a user,
a user with theManage Page
permission can add
components to the page, and
modify it.

l To view a specific page in
Dashboard you need theView
Page permission for that page.
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XS Application
Elements Create and Edit View

l Components on a
page

l To view Scorecards you need
theView Scorecard
permission.

l To view the contents of the
Active KPIs area in all the
components filters and to be
able tomove KPIs from the
Active KPIs area to the
Selected KPIs area in the filter
you need theSelect KPI
permission.

l If you do not have this
permission, you can, in all the
component filters, view the
contents of the Selected KPIs
area, you cannot modify the
selection, and cannot view the
contents of the Active KPIs
area as the contents are grayed
out.

l To view the small black arrow
(near the Scorecard title) that
indicates that the Scorecard
has Cascading Scorecards and
to be able to click the arrow to
display the Cascading
Scorecards for which you has
permission you need the
Cascade Scorecard
permission.

l If you do not have this
permission, the small arrow is
not displayed and you do not
know that Cascading
Scorecards are available.

l To view specific Scorecards
and data you need the View
Scorecard permission.

Annotations (in
Dashboard and
Explorer)

l To edit or delete an existing
annotation you need the
Manage Annotation
permission.

l If you do not have this
permission, you can only view
the annotation and theEdit and
Delete buttons of the
annotation are hidden.

Tasks
This section includes:

"Create a role" below

"Edit role details" on the next page

"Attach permissions" on the next page

"Add a resource to a permission" on the next page

Create a role

1. Select Admin > Users and Roles > Role Management.

2. In the Roles area, click to create a new role.
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3. Enter the name and description for the role.

4. Click OK to save your role.

After creating a role, follow the procedure for attaching permissions and resources.

Edit role details

1. Select Admin > Users and Roles > Role Management.

2. In the Roles area, select a role.

3. In the Role Details area, click Edit Details.

4. Edit the role as required and click OK.

Attach permissions

1. Select Admin > Users and Roles > Role Management.

2. In the Roles area, select a role.

3. In the Role Details area, click . The Assign Permission to Role wizard opens.

4. Select a permission from the list.

5. Attach a resource to the selected permission, if required.

6. Complete the wizard procedure to save your assignments.

7. Log off from Executive Scorecard and log on again to complete the permission assignments.

Add a resource to a permission

1. Select Admin > Users and Roles > Role Management.

2. In the Roles area, select a role.

3. In the Permissions list select a permission.

4. Click to open the Assign Resources to Permissions page in the Assign Permission to Role
wizard.

5. Select a permission and use the arrows tomove the required resources from the Available
Resources list to the Selected Resources list.

UI Description
Role Management Page
Click to refresh the page.
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Roles Area
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI
Element Description

Create Role. Creates a new role.

Enter theRole Name andRole Description and click OK.

Delete Role. Deletes the selected role.

Click Refresh to refresh the display.

When in Executive Scorecard, when you navigate to another tab and then return to
Admin > Users and Roles, the display is not automatically refreshed. To refresh the
display, click in the toolbar.

<Role
List>

A list of roles currently defined in theAdmin tab. When you select a role, the details
appear in theRole Details area andPermissions list.

For a list of pre-defined roles, see "RoleManagement" on page 60.
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Role Details Area
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Role Name The name of the selected role.

Role
Description

The description of the selected role.

Edit Details Edits the selected role name and description.

Attach permission. Assigns selected permissions to roles. You select
permissions using the Assign Permission to Role wizard. For user interface
details, see "Assign Permission to RoleWizard" below.

Manage permission.Modifies the selected permission. Opens the Assign
Resources to Permissions page in the Assign Permission to Role wizard. For
user interface details, see "Assign resources to permissions page" on page 76.

Detach permission. Removes the selected permission from the role.

Permissions
List

The list of permissions and resources for the selected role.

Permission The permission sets and permissions attached to the selected role.

Resources The list of resources for each permission.

Not Applicable. None of the available resources apply to this permission. For
details, see "ResourceManagement" on page 54.

<Resource Name>. The permission is attached to a specific resource.

All. The permission is applicable to all resources.

Assign Permission to Role Wizard
This wizard enables you to assign permissions to the selected role, as well as assign resources to
the permissions. Click to access the wizard.
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Wizard
Map

The Assign Permission to Role wizard contains:

Select Permission Page > Assign Resources to Permissions Page >
Confirmation Page.

Select Permission Page

This pagemay lead directly to the Confirmation page depending on whether the selected
permission has resources attached.

User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

<Permissions
tree>

Select a permission from the tree.

Displays the pre-defined permissions. For details, see "RoleManagement"
on page 60.
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Assign resources to permissions page
This page only appears if the permissions are applicable for a resource.

Note: Click to access this page directly.

User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Permission A tree containing the permissions.

Select a permission and use the arrows tomove the required resources
from theAvailable Resources list to theSelected Resources list.

Available and
Selected
Resources

Each permission can be applicable for specific resources, for all resources,
or not applicable to a resource.
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Confirmation Page

User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Permission The permissions assigned to this role.

Resource The list of resources associated with the each permission.

Add
another

Click to commit the current permission and continue in the wizard to add another
permission. The "Select Permission Page" on page 75 opens.

Finish Click to commit the assigned permissions and finish wizard functions.

Cancel Click to cancel the current assignment. All previous actions in the wizard are still
valid.
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User Management
The User Management page enables you to add and edit users and groups, as well as add and edit
their details.

To access:

l Select Admin > Users and Roles > User Management to access the User Management
page.

Section navigation: l "LearnMore" below l "Tasks" below l "UI Description" on page
81

Learn More
Resources, Roles, Permissions, Users, and Groups

l Resources. A resource is a logical group of one or more XS application data items (for example
application data or components or budgets). Once you define resources, you attach the resource
to a permission.

l Roles and Permissions. Each role is a set of permissions. Permissions define which actions
the user can perform and on which resources. For example, you can create a role that enables
its users to create Dashboard pages.

l Users and Groups. Each user has a list of roles that define their permissions. When you assign
a role, that user only has access to specific portions of the program and specific resources that
are relevant to their role. You can also define groups of users with the same roles or access
rights. When you attach a user or group to a group, the user or group inherits all of the group’s
roles.

Managing Users
Users can bemanaged using either of the following, but not both:

l Enterprise Users:Users are created andmanaged in Executive Scorecard.

l LDAP Users: Users are created andmanaged on your LDAP server which is connected to
Executive Scorecard. For details, see "LDAP" on page 89.

The Administrator uses the Admin tab to define users that have roles, roles that contain a set of
permissions that may contain resources. It is recommended to create resources and attach them to
permissions first in the user management process. For details, see "RoleManagement" on page
60.

Tasks
This section includes:

" Search for a user" on the next page
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"Add a user" below

"Add a new group under the root" below

"View permissions and resources for specific users" below

"Assign roles to users or groups" on the next page

"Unassign a role from a group" on the next page

"Add Additional Pages to Dashboard andGrant Permissions" on page 81

"Configure User Permissions in Dashboard" on page 81

Search for a user

1. Select Admin > Users and Roles > User Management.

2. In theSearch Users tab, enter the search criteria.

3. Click Search. The relevant users are displayed.

Add a user
When using LDAP for user management, you cannot add LDAP users in Executive Scorecard
directly. Youmust first create them in the LDAP server and then populate them into Executive
Scorecardmanually. You can remove LDAP users from Executive Scorecard, but they will still
exist in the LDAP server.

1. Select Admin > Users and Roles > User Management.

2. In theUsers & Groups tab, select the group under which you want to add a user and click
Add User . The Add user dialog box opens.

3. Enter the relevant details.

Add a new group under the root

1. Select Admin > Users and Roles > User Management.

2. In theUsers & Groups tab, click Add group under the root .

3. Enter theGroup Name andGroup Description and click OK. The group is added under the
root.

View permissions and resources for specific users

1. Select Admin > Users and Roles > User Management.

2. Select a user from theUsers & Groups tab.

3. In theRoles and Permissions area, select a role to view the permissions and resources
associated with the role.
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Assign roles to users or groups

1. Select Admin > Users and Roles > User Management.

2. Select a user or group from theUsers & Groups tab.

3. In theRoles and Permissions area, click Assign role . The Assign Roles dialog box
opens.

4. Select a role from theAvailable Roles list and use the arrows tomove the role to theSelected
Roles list.

5. Click OK to save your selections.

Unassign a role from a group

1. Select Admin > Users and Roles > User Management.

2. Select and expand theEveryone group.

3. Delete the role related to your specific Scorecard from theEveryone group. This Scorecard
can now only be viewed by the Admin.

4. Assign theManage Scorecards role to the specific users you want to view andmanage the
Scorecard.

Connect XS Executive Scorecard to an LDAP server:

Note: The format of the LDAP directory must be either Microsoft Active Directory or SunONE
Directory. It cannot be an arbitrary directory structure.

1. In theManagement database, in the SETTINGS_MANAGEMENT table, create a new record
with the following information:

n context: foundation

n name: fnd.uum.type

n value: ldap

2. Configure the LDAP connection properties and the structure of the LDAP directory using the
properties file located at <installation
directory>agora\glassfish\glassfish\domains\BTOA\config\conf\external-ldap.properties.

Note: Only connection properties (such as host, port, LDAP version, user, and password)
and user/group base dn can bemodified.

3. If SSL is used to access LDAP, certificates must be imported.
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Add Additional Pages to Dashboard and Grant Permissions
Users can be granted permissions to perform the following operations on user-defined pages and
components: View page,Manage Page (change and delete specific page) andAdministrate
pages (add pages and full control on all pages in the system).

To create a new page in the Dashboard , contact your administrator. The administrator should:

1. Create the relevant page in HP IT Executive Scorecard.

2. Define the page Instance and Resource. For details, see "ResourceManagement" on page 54.

3. Give you (the Business Analyst - Dashboard Designer) the needed permissions to update the
page. For details, see "RoleManagement" on page 60.

4. Give the relevant user (executive) the needed permissions to view the page. For details,
see"RoleManagement" on page 60.

Configure User Permissions in Dashboard
Permissions to work with Dashboard components and pages are defined inAdmin > Users and
Roles > User Management.

The operations that can be defined for a user are dependent on the area within Dashboard, as
follows:

l Predefined Pages. These pages are defined out-of-the-box. They have a pre-defined layout but
entities are not selected. Users with the relevant permissions can select the relevant entities
using the component filters. Depending on their permissions, users can change the component
layout in the page and the selections in the component filters. Note that out-of-the-box pages
cannot be deleted. More information about the permissions is available in "RoleManagement"
on page 60.

l User Pages and User Components. Users can be granted permissions to perform the
following operations on user-defined pages and components: View page,Manage Page
(change and delete specific page) andAdministrate pages ( add pages and full control on all
pages in the system).

UI Description
User Management Page
Click to refresh the page.
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Users & Groups Tab
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Users and
Groups tree

A tree containing all of the existing groups and users attached to those
groups.

To find users that are not attached to a specific group, but are under the
groupEveryone, use theSearch Users tab. For details, see "Search
Users Tab" on page 86.

When a user is added to LDAP, it is displayed in the Users andGroups tree
after you log on to HP IT Executive Scorecard."Search Users Tab" on page
86
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UI Element Description

Create User. Adds a new user under the selected group. The user inherits
the group’s roles.

Enter the user's Login Name, Display Name, Email, andNew Password
and click OK.

When using LDAP for user management, you cannot add LDAP users in
Executive Scorecard directly. Youmust first create them in the
LDAP server and then populate them into Executive Scorecardmanually.
You can remove LDAP users from Executive Scorecard, but they will still
exist in the LDAP server.
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UI Element Description

Create group. Creates a new group under a selected existing group. The
group inherits the existing group’s hierarchy.

Enter theGroup Name andGroup Description and click OK.

Available Groups

l Administrators. Users who can administer the system.

l Scorecard Administrators. Users who canmanage specific
Scorecards and Pages according to the assigned roles and permissions.

l Everyone. All users of the system.

Note: The following groups are the default groups available in SAP
BusinessObjects Enterprise and exported to the Admin tab. They are
not applicable to the Executive Scorecard application.

l QaaWS Group Designer

l Report Conversion Group Users

l Test Root

l Translators

l Universe Design Users
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UI Element Description

Add group under the root. Creates a new group under the root.

Enter theGroup Name andGroup Description and click OK.

Attach to group. Attaches the selected user or group to a group. The users
or groups inherit all of the group’s roles.

Select the group and click OK.
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UI Element Description

Detach from group. Detaches the selected user or group from a group.
When you detach a user/group from a group, they no longer have the roles
that they inherited from the group.

When you detach a group from a group, it moves to the "root" of the groups
and users tree.

Delete. Deletes the selected user or group. When a group is deleted, its
users still exist under a system group called Everyone.

Refresh. Refreshes the displayed information.

Search Users Tab
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Search
Users

The search criteria.

To search for users, enter some or all of the user details: Login Name, Display
Name, Email.

Search Search. Click to search for users that match the criteria entered in theSearch
Users tab.

User Name A list of all users that match the search criteria.

User Details Pane
Select a user and click User Details.
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User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Login Name/
Group Name

The name of the selected user or group.

Display Name/
Group
Description

The description of the selected user or group.

Edit Details Edits the selected user or group details. Enables you to change a user
password.

Roles and
Permissions

The assigned roles and corresponding permissions and resources for the
selected user or group.

Assign role. Opens the Assign Roles dialog box that enables you to assign
a role to the selected user or group.

Remove role. Removes the selected role from the user or group.

Role name The role assigned to the selected user or group.

Permission List of permission names contained in the selected role.

Resource The resource attached to the permission of the selected role.

N/A. Not Applicable. None of the available resources apply to this
permission.

<Resource Name>. The permission is attached to a specific resource.

All. The permission is applicable to all resources.

For details, see "ResourceManagement" on page 54.
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Assign Roles Dialog Box
Select a role in Roles and Permissions, and click .

User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Select a role from theAvailable Roles list and use the arrows tomove
the role to theSelected Roles list.

Available and
Selected Roles

Each user or group can have one or more assigned roles.

Permission details The read-only details about the permissions and corresponding resources
for the selected role.
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UI Element Description

Resource The list of resources for each permission:

l Not Applicable. Used for permissions that do not require a specific
resource setting.

l <Resource Name>. The permission refers to a specific resource.

l All. The permission is applicable to all resources.

LDAP
The User Management page enables you to add and edit users and groups, as well as add and edit
their details.

Users can bemanaged using either of the following, but not both:

l Enterprise Users:Users are created andmanaged in Executive Scorecard.

l LDAP Users: Users are created andmanaged on your LDAP server which is connected to
Executive Scorecard. For details, see "LDAP" above.

The Administrator uses the Admin tab to define users that have roles, roles that contain a set of
permissions that may contain resources. It is recommended to create resources and attach them to
permissions first in the user management process. For details, see "RoleManagement" on page
60.

To access:

l Select Admin > Users and Roles > User Management to access the User Management
page.

Section navigation:  l "LearnMore" below l "Tasks" on page 91 l "UI Description"
on page 94

Learn More
The users and authentication when working with or without SAP BusinessObjects and LDAP is as
follows:
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Operation

Working
without
SAP BusinessObjects
and without LDAP

Working
with
SAP BusinessObjects
and
without LDAP

Working
with
SAP BusinessObjects
and
with LDAP

Manage
users
(create,
remove,
update)

In Executive Scorecard, in
Admin > Users and
Roles.

Users are created in
Executive Scorecard, in
Admin > Users and
Roles

Users created in
Executive Scorecard are
automatically transferred
to SAP BusinessObjects.

If a user is created in SAP
BusinessObjects, it does
not appear in the list of
users in Executive
Scorecard.

Users are created in
LDAP.

Users created in
LDAP must be
manually populated to
Executive Scorecard
and to SAP
BusinessObjects
separately.

Passwords Passwords can be
changed in theUser
Details pane of the User
Management page in
Executive Scorecard.
Click Edit Details to
change a user's
password.

Passwords can be
changed in theUser
Details pane of the User
Management page in
Executive Scorecard.
Click Edit Details to
change a user's
password.

A password created in
Executive Scorecard is
automatically transferred
to SAP BusinessObjects
for the relevant user.

Passwords are created
and stored in LDAP.

Roles,
permissions,
and groups

In Executive Scorecard, in
Admin > Users and
Roles.

In Executive Scorecard, in
Admin > Users and
Roles.

In Executive
Scorecard, inAdmin
> Users and Roles.

Note:

l The format of the LDAP directory must be either Microsoft Active Directory or SunONE
Directory. It cannot be an arbitrary directory structure.

l When a user is added to LDAP, it is displayed in the Users andGroups tree after you log on
to HP IT Executive Scorecard.
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l Whenworking with LDAP, youmust make sure that LDAP is connected to Executive
Scorecard and to SAP BusinessObjects. For details, see "LDAP" on page 89.

l Executive Scorecard only supports the LDAP tab with Active Directory as a server type on
that tab. Active Directory authentication via the active directory tab is not supported. For
details, see "LDAP" on page 89.

l We recommend to use LDAP for secure passwords and better password validation.

Tasks
This section includes:

"Configure XS toWork with LDAP" below

"Configure BOE toWork with LDAP" on the next page

"Manage Users Using LDAP" on page 93

Configure XS to Work with LDAP
To configure XS to work with LDAP:

1. Database changes. In theManagement database, in the SETTINGS_MANAGEMENT table
create a new record with:

n context=foundation

n name=fnd.uum.type

n value=ldap

2. external-ldap.properties. Define groups and users in LDAP. In the
<HPXS>\agora\glassfish\glassfish\domains\BTOA\config\conf\external-ldap.properties
file, enter the following values:

n host address=ldapHost

n host port=ldapPort

n SSL=enableSSL

n login name to access the LDAP server=ldapAdministrator

n password=ldapAdministratorPassword

n user search DN=usersBase

n group search DN=groupsBase
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3. bsf.properties.In the <installation directory>\
agora\glassfish\glassfish\domains\BTOA\config\conf\bsf.properties file, change:

personalization.provider=EXTERNAL

users.provider=EXTERNAL

groups.provider=EXTERNAL

to:

personalization.provider=SHARED

users.provider=SHARED

groups.provider=SHARED

4. User synchronization. To improve the synchronization of users, perform the following:

a. The synchronization of LDAP users, and Executive Scorecard and SAP BusinessObjects
users is performed by default every 60 minutes (this is the recommended value).
To change the periodicity, click Admin > Scorecard > XS Settings, and enter a new
value in theUsers Info Reload Rate (minutes) in the Studio update area. Because each
synchronization lasts a few minutes, it is recommended to set the default synchronization
period so there is no overlap with the synchronization itself. For details, see "XS Settings"
on page 160.

b. Tomake sure that the synchronization is only performed on the relevant users (for
performance purposes). Make sure to add to the external-ldap.properties file located at
<HPXS>\agora\glassfish\glassfish\domains\BTOA\config\conf, the (groupfilter=(&
(objectClass=group)(cn=g-s-rbap-t-hpxs*)) so that only the users needed for Executive
Scorecard are synchronized.

Configure BOE to Work with LDAP
Make sure you use the LDAP Authentication option:

1. From theWindows Start menu, click Programs > BusinessObjects XI 3.1 >
BusinessObject Enterprise > BusinessObjects Enterprise Central Management
Console.

2. Log on to the Central Management Console as an administrator.

3. Click Authentication, then click the LDAP tab.

4. 4. Click Start LDAP Configuration Wizard.

5. In theAdd LDAP Host (hostname: port) field, type your host and port information.

6. Click Add.
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7. Click Next.

8. In the LDAP Server Type drop-down list, select your LDAP server, and click Next. This is
where you select the type of server you are using: SunOne or Active Directory.

9. In the Base LDAP Distinguished Name field, type the distinguished name, and click Next.

10. Type the LDAP host credentials:

a. LDAP Server Administration Credentials:Enter the name and password for a user
account that has rights to administer your LDAP server.

b. LDAP Referral Credentials:Enter the same name and password you entered for LDAP
Server Administration Credentials.

11. In theMaximum Referral Hops field, type the number of referral hops to limit forwarding the
credential request. If you set this field to zero, no referral hops are allowed.

12. Click Next.

13. From the Type of SSL authentication drop-down list, select Basic (no SSL) and click Next.

14. From theAuthentication drop-down list, select Basic (no SSO) and click Next.

15. Select the following LDAP options:

a. Create a new account for every added LDAP alias

b. Create new aliases only when the user logs on

c. New users are created as named users

16. Click Next.

17. Click Finish.

Manage Users Using LDAP

1. To assign roles and permissions to LDAP users:

a. To add users with the ADMIN role, run the following script (it adds the ADMIN role
“manually”):

<HPXS
ROOT>\agora\glassfish\glassfish\domains\BTOA\config\population\populate-
admin-detail.bat <user_ID><password> <firstname> <lastname> <e-mail>

b. To add users with the EVERYONE role, run the following script (it adds the EVERYONE
role “manually”):
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<HPXS
ROOT>\agora\glassfish\glassfish\domains\BTOA\config\population\populate-user-
detail.bat <user_ID><password> <firstname> <lastname> <e-mail>

c. To add users as ADMIN role without password, run the following script (it adds the ADMIN
role “manually”):

<HPXS
ROOT>\agora\glassfish\glassfish\domains\BTOA\config\population\populate-
admin-detail-noPwd.bat <user_ID <firstname> <lastname> <e-mail>

d. To add users as EVERYONE role without password, run the following script (it adds the
EVERYONE role “manually”):

<HPXS
ROOT>\agora\glassfish\glassfish\domains\BTOA\config\population\populate-user-
detail-noPwd.bat <user_ID><firstname> <lastname> <e-mail>

Where:

o <user_ID> and <password> are the LDAP user name and password.

o <firstname>, <lastname> are the user names displayed in XS. You can assign
permissions, or delete the users in theAdmin > Users and Roles > Role
Management. For details, see "RoleManagement" on page 60.

o <email> is the email of the user.

Tip:

n It is recommended to create the users without password as such users can only log on
under LDAP mode. Users defined with passwords can log on using the password even
when LDAP is off.

n At least one administrator user should be created to be used to perform the
administration work.

2. If SSL is used to access LDAP, youmust import the relevant certificates.

UI Description
For details see "UI Description" on page 81.
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Data Source Management
The DataWarehouse can connect to other products (data sources) and gather data about these
products. An integration is available for each product (data source). The connection from the data
source to the DWH is called a content pack. FBI extracts the data from the specific data source.
Content packs contain all the artifacts needed to connect to the relevant data source and gather
data from that data source.

Data SourceManagement enables you tomanage the integration of data into the data warehouse
through the activation of data sources. The available data source content packs are registered in
the deployment process and can then be activated in the Data SourceManagement page.

To access:Select Admin > Data Source Management then click Add data source.

Note: For details on activating Content Packs created in the IDE, see Activate New Content in
the IT Executive Scorecard Content Extension Guide.

Section navigation:  l"LearnMore" below l"Tasks" on page 99 l"UI Description" on
page 106

Learn More
Content Packs
The DataWarehouse can connect to other products (data sources) and gather data about these
products. An integration is available for each product (data source). A Content Pack is a set a files
which defines the execution of an ETL along with all its parameters.

The connection from the data source to the DWH is called an integration content pack (i-CP). Each
content pack uses an extractor in order to extract the data from the specific data source and
contains all the artifacts needed to connect to the relevant data source and to gather data from that
data source. Content packs include:

l The definition of the datamodel used for the connection.

l The type of data gathered from the data source.

l The ETL definitions.

l The definition files.

l The configuration files.

l The scripts that help build and define the DataWarehouse.

Themapping between the raw data from the data source and the target database in the Data
Warehouse is included in the ETL. The Executive Scorecard runs the KPI engine that reads the
data from the target database, creates the relevant KPIs from that data, calculates the value, and
status of the KPI and displays the relevant information in the Dashboard.
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Youmust run the Data SourceManagement wizard to configure and activate the content packs,
depending on the products you want to integrate with.

The out-of-the-box content packs are:

l CORE content pack. This is the central content pack that is automatically installed during the
post-installation process. It takes consolidated data to the target schema. It includes all the
dimensions, and entities of the DataWarehouse. It also provides the organization of definitions
and hierarchies. All the other integrations depend on the CORE content pack.

l ALM

l AM

l AWS

l AWSCW

l BSM

l CSA

l DP

l FPA

l HPV

l IC

l NA

l NNM

l OO

l PPM

l SA

l SE

l SM

l UCMDB

l VCM

Context

A context is the result of a semantic layer of metadata that creates a business oriented view of the
data. The context contains a schema of the tables that make up the dimension andmeasurement
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objects. The context is an interface between the data warehouse and the analytics that display the
data. It then corresponds to the business contexts used in HP IT Executive Scorecard.

Learn About Multiple Integration Content Pack Instances
Multiple Integration Content Packs (M-iCP) providemultiple instances of the same data source or
product type. This allows for data source configuration per instance, as opposed to a single
activation for the data source. Each instance has its own version and product type. TheM-iCP
source extraction is based on the FBI extractor technology, and consolidation is enabled between
instances.

You can add an instance using the Data SourceManagement page or using the Automation tool.
For back-end tool details, see "The Automation Tool" on page 390.

Learn About File Based Integration
File Based Integration (FBI) enables you to extract data from a specific data source according to a
set of instructions. It consists of a plug-able extractor framework for each data source. The
extractor gathers data according to the specific instructions it receives, placing it into a relevant txt
file. Each supported data source has a corresponding extractor (or multiple extractors) capable of
extracting data out of it according to specified instructions. All available Content Packs use FBI.

Extraction Mechanism

The extraction is based on a set of parameters kept in the dwabc.INSTRUCTION table in the
staging database. The instruction parameters are set by the BODS workflow during the Source
Extract.

Extraction Methodology

The extraction is done using Enterprise JavaBeans (EJBs) running on the application container of
the DataWarehouse. The EJBs use various technologies (for example, JDBC, Web Services,
Remote EJB objects, data files, and other kinds of http requests) to extract the data from the data
source.

ETL Source Extract

The first stage of the ETL is the Source Extract. In this phase, the BODS workflow inserts an
instruction to the INSTRUCTION table and then invokes a batch file with the instruction ID as a
parameter. The batch file calls a JAVA program which performs an http request that activates the
relevant extractor. Using the instruction ID, the extractor fetches the relevant parameters from the
INSTRUCTION table.

The FBI extractor extracts the data from the data source into BODS data stores. All Content Packs
integrate using FBI, where data is extracted from the data source into txt files with well defined
standard structure.

The following extractors are available for each source product:

Product Extractor

ALM ALM
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Product Extractor

AM MSSQL, Oracle

AWS aws_s3

AWSCW AWSCW

BSM BSM, GDE, UCMDB

CSA CSA

DP DP

FPA FPA

IC MSSQL, Oracle, PostgreSQL

NA MSSQL, Oracle, MySQL

NNM NNM

OO MSSQL, Oracle, MySQL

PPM Oracle

SA SA

SE Oracle

SM MSSQL, Oracle

UCMDB UCMDB

VCM script(groovy)

Troubleshooting Logs

l <agora>\glassfish\glassfish\domains\BTOA\logs\fbi.log: This log describes all of the
current activity of the file based framework as well as the activity of the extractors themselves.

l <installation directory>\agora\DataWarehouse\log\dw_fbi_client.log: This log describes
the activity of calling the FBI url from a batch file (which is invoked by a BODS workflow during
the ETL source extract).

Learn more about each data source integration
Formore detailed information about each data source's integration, see Integrate the Data Sources
in the relevant IT Executive Scorecard Content ReferenceGuides.

ALM Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration of HP
Application Lifecycle Management.

AM Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration of
HP Asset Manager.
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AWS Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration of
AmazonWeb Services.

AWSCW Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration
of AmazonWeb Service CloudWatch.

BSM Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration of
HP Business ServiceManagement.

CSA Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration of HP
Cloud Service Automation.

DP Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration of HP
Data Protector.

Hyper-V Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration of
Hyper-V.

IC Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration of HP
Insight Control.

NA Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration of HP
Network Automation.

NNM Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration of
HP Network Automation.

OOData Source in the IT Executive Scorecard Content ReferenceGuidefor the Integration of HP
Operation Orchestration.

PPM Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration of HP
Project and Portfolio Management.

SA Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration of HP
Server Automation.

SE Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration of HP
Storage Essentials.

SM Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration of
HP ServiceManager.

UCMDB Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration of
HP Universal ConfigurationManagement Database.

VCM Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration of
vCenter Chargeback Manager.

Tasks
This section includes:

"Add and activate a new data source instance:" on the next page

"Reactivate an existing data source instance:" on the next page

"Deactivate a data source instance:" on page 101
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"View data source configuration settings" on the next page

"Edit data source settings and test the connection:" on the next page

"Add a new data source to the integrationmechanism" on the next page

"Configure admin tasks using the command line" on the next page

"Use the FBI Verification Extractor" on the next page

"Configure FBI Properties" on page 102

"Sample Integration Activation Using the UI" on page 102

"Sample Integration Activation Using the Automation Tool" on page 104

Add and activate a new data source instance:
The process of integrating a data source into the DataWarehouse is done through activation of the
source instance.

1. Select Admin > Data Source Management.

2. Click theAdd data source to open the Data source wizard. The Add Data Source page
opens.

3. Select the data source type and click Next.

The relevant data source page opens.

4. Enter and select the configuration parameters.

5. Complete the wizard.

The data source instance is activated.

Note: If the first time activation of a data source instance fails, the instance is displayed in
the source list with anError status. You can then activate the data source by clickingEdit
Settings and completing the configuration and activation.

Reactivate an existing data source instance:

1. Select Admin > Data Source Management.

2. Click next to the specific source and the source is activated.

Note: Before reactivating the BSM data source, click Edit Settings and enter theRTSM
Username andRTSM Password.
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Before reactivating the UCMDB data source, click Edit Settings and enter theUsername
andPassword.

Deactivate a data source instance:
You can deactivate the source and stop the integration process, in order to change configuration
details.

1. Select Admin > Data Source Management.

2. Click and the deactivation warning opens.

3. Click OK.

View data source configuration settings

1. Select Admin > Data Source Management.

2. Click View Settings and the relevant data source page opens.

Edit data source settings and test the connection:

1. Select Admin > Data Source Management.

2. If necessary, deactivate the data source by clicking .

3. Click Edit Settings and edit the configuration parameters.

4. Click Next to validate your changes and test the connection to the data source.

Add a new data source to the integration mechanism
For details, see "Add Additional Data Sources" on page 361.

Configure admin tasks using the command line
For details, see "DataWarehouse CommandReference" on page 372

Use the FBI Verification Extractor
FBI also supplies an extractor within the FBI framework that can verify and validate the flat file
output you have.

To utilize the extractor:

1. Place the Flat File (FF) in a specific folder with a specific name in the RESULT_FILE_NAME
column in the Instruction table. The name and folder are defined by the ETL developer.

2. The delimiters in FF should be the same as the ones defined in the delimiters columns (FIELD_
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DELIMITER and ROW_DELIMITER).The FF must contain the list of fields in the first line with
all the relevant delimiters.

3. Make sure the order and the name of the fields in the FF are the same as the ones defined in
the SourceModelMetadata.

To activate the extractor:

1. Define the productType attribute in the datasource.xml as file (productType="file").

2. You can also override the defined extractor by adding a new entry into the connection detail (in
the datasource.xml), as follows: <dw:GenericProperty propertyName="overrideextractor"
propertyValue="file" propertyType="string"/>

Configure FBI Properties
In data source activation, each source that is extracted with FBI must have the following properties
configured.

Navigate to: <installation directory>\DataWarehouse\conf\fbi.properties

If multiple extractors are running simultaneously, youmay need to configure the following:

fbi.max.number.of.threads =5

If you experience problems with languages that do not work with UTF 16 you can change the
following:

fbi.flat.file.encoding =UTF-16

Example

l Sample Integration Activation Using the UI

Activate the Integration (Sample)
a. Prerequisites: Make sure all of the required prerequisites have beenmet.

b. Select Admin > Data Source Management then click Add data source.

c. Select the data source type.

d. Select or enter the configuration parameters.

e. Click Next to proceed to the validation page.
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UI Description (Sample-AM Oracle server)

User interface elements are described below:

UI Element Description

Instance name Enter a name for the data source instance you are activating.

AM Version Select the relevant AM version. For details, see the IT Executive
Scorecard Support Matrix.

Time Zone Select the time zone for the data source.

Data Source Type AM should be configured to run on anOracle server.

Server Enter the Oracle server.

Username Enter your username used to log on to the AM database.
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UI Element Description

Password Enter your password used to log on to the AM database.

Hostname/IP
Address

Enter the Oracle server hostname or IP address.

Port Enter the port for database connections.

SID Enter the unique name of the database.

Service Name Enter the alias used when connecting.

Initial Load Period
(months)

Select the number of months from which you want the initial data
loaded.

l Sample Integration Activation Using the Automation Tool

If you experience errors or problems with the Data SourceManagement UI, you can
activate the sources using DWH back-end tools.

Activate the Integration (Sample-AM Oracle server)
a. Prerequisites: Make sure all of the required prerequisites have beenmet.

b. Enter the product name, product version, time zone, and product type of the data
source, and the configuration parameters in the datasource.xml file as follows:

o server. The data source server.

o user. The user required for authenticating to the data source server.

o password. The password required for authenticating to the data source server.

o host. The remote server on which the data source server resides.

o port. The port in the data server. By default, the port number is 1521 for Oracle
database and 1433 for SQL Server database.

o sid. The unique name of the database.

o servicename. The alias used when connecting.

o initial load period. The number of months from which you want the data loaded.

Note: Each Content Pack contains a sample xml file for
<Installation Directory>\agora\ContentPacks\SA\conf\dataSources.xml.
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Sample xml configuration (Advanced configuration)

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<dw:DataSourceConnections version="1.0"

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="http://schemas.hp.com/bto/dwh/v1/dw_d

ataSources ..\xmlSchemas\dw_dataSources.xsd"
xmlns:dw="http://schemas.hp.com/bto/dwh/v1/dw_dataSource

s">
<dw:DataSourceConnection productName="AM" productVersion="5.2" t
imeZone="Asia/Shanghai" productType="oracle">

<dw:GenericProperty propertyName="server" propertyValue
="" propertyType="string"/>

<dw:GenericProperty propertyName="user" propertyValue=""
propertyType="string"/>

<dw:GenericProperty propertyName="password" propertyValue
="" propertyType="password"/>

<dw:GenericProperty propertyName="port" propertyValue="15
21" propertyType="string"/>

<dw:GenericProperty propertyName="sid" propertyValue="" p
ropertyType="string"/>

<dw:GenericProperty propertyName="servicename" propertyVa
lue="" propertyType="string"/>

<dw:GenericProperty propertyName="dwh.etl.initialloadmont
hs" propertyValue="6" propertyType="string"/>
</dw:DataSourceConnection>
</dw:DataSourceConnections>

Note: In order to verify that the connection details added in the datasources.xml
file are correct, it is recommended to test the connection to the data source
before running the configuration. For details, see "The Automation Tool" on
page 390.

c. Register Instance:

To add an additional data source instance enter: dw_cp_register.bat -addInstance –
name <CP_NAME>

The DataWarehouse then looks for the CP in the Content Packs Folder. The instance
ID is displayed in the output.“Instance ID: XX has been added to Content Pack: <CP_
NAME>”

It is also added to the CONTENT_PACK table.

d. Configuration:
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For first time activation, enter the following: dw_ds_automation.bat -task
ConfigureInitial -cp <content pack name> -instance <INSTANCE_ID> -
xmlFilePath [Path to datasources.xml file].

For all subsequent activations, enter the following: dw_ds_automation.bat -task
Configure -cp <content pack name>-instance <INSTANCE_ID> -xmlFilePath
[Path to datasources.xml file].

Note: After you have configured dw_ds_automation.bat -task ConfigureInitial or
dw_ds_automation.bat -task Configure, delete the value in the propertyValue field
of the password from the dataSources.xml file, as follows:
<dw:GenericProperty propertyName="password" propertyValue=""
propertyType="password" />

For details, see "The Automation Tool" on page 390.

e. Deployment:

Enter the following: dw_ds_automation.bat -task Deploy -cp <content pack name>-
instance <INSTANCE_ID>.The content pack is initialized.

f. Activate the data source:

Enter the following: dw_ds_automation.bat -task Activate -cp <content pack
name> -instance <INSTANCE_ID>.

UI Description
Data Source Management Page
The Data SourceManagement page enables you to select from a list of Integration Content Packs
recognized by the data warehouse. Additionally, it enables you to activate the integration of the data
sources, as well as deactivate andmake configuration changes.
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User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI
Element Description

Add data
source

Click to open the Data Source wizard. For details, see "Data SourceWizard" on the
next page.

<Data
Sources>

A list of sources, by Name (instance name) andProduct (data source product), that
have been added to the data warehouse. The current status of the data source is
displayed next to the instance name:

l Activated

l Deactivated

l Error

l Initializing: Data source is currently being activated. Relevant only for first time
activation.
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UI
Element Description

View
Settings

Available when the data source has been activated. Displays the read-only
configuration of all connection parameters.

Note: All connection settings are run-time related. Youmust deactivate the
connection to the data source in order to change the settings.

Edit
Settings

Available when the data source has been deactivated. Displays the configuration of
all connection parameters and enables you to test the connection to the data source.
The parameters can be edited.

If the first time activation of a data source instance fails, the instance is displayed in
the source list with anError status. You can then activate the data source by
clickingEdit Settings and completing the configuration and activation.

Activates the relevant data source.

l Once the content pack is activated, the ETL is ready to run. For details on how to
monitor andmanage the ETL, see " ETLManagement " on page 112.

l Do not activate a content pack while the ETL is running.

Deactivates the relevant data source.

Do not deactivate a content pack while ETL is running.

Data Source Wizard
The Data Source wizard enables you to add and activate a selected data source instance.

To access Select Admin > Data Source Management and then click Add data source.

Select the data source type to activate the integration processes.
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Important
Information

The UI elements of the wizard differ according to the selected data source.

You can also add additional data sources. For details see "Add Additional Data
Sources" on page 361.

For configuration parameter details, see Integrate the Data Sources in the IT
Executive Scorecard Content ReferenceGuide.

For each source, enter the relevant information and click Next to proceed to the
validation page.

Note: If the activation process is takingmore than one hour, you can change
the status of the CP in the CONTENT_PACK table to “ERROR” and then
activate the CP again.

Wizard
Map

The Data Source wizard contains:

Add Data Source Page > Configuration Parameters Page > Validation Page

Add Data Source Page

Click Next to move to the next page of the wizard..
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User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Data source type Select the data source type you want to activate.

Validation Page
This validation page displays activation status information pertaining to the selected data source.
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A message displays the data source status information.

Click Finish to complete the wizard activation process.
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ETL Management
The ETLManagement tab displays the DW ABC Streams Management UI which enables you to
perform the essential tasks related to ETL and stream functionality. It displays the state of active
streams, and enables you to schedule and control stream activity. It also allows you to view the
historical data and the archived stream definitions. All ETLmanagement and functionality is
accessed and performed through this UI.

To access:
Select Admin > ETL Management.

Section navigation:  l "LearnMore" below l "Tasks" on the next page l "UI
Description" on page 117

Learn More
ETL
The Extract, Transform, and Load (ETL) process is an end-to-end transfer of external source data
through several staging layers and into the target layer of the data warehouse. The source data can
reside in a single database or multiple databases. The data warehouse uses the ETL process to
extract, consolidate, and transform the source data into ameaningful target model that populates
relevant business analytics.

The ETL process comprises eight primary stages. The stages of this process depend onmetadata
and the nature of the sources.

The ETL is monitored andmanaged through the DW ABC Streams Management User Interface.
For details, see ETLManagement andMonitoring

ETL Stream Management and Monitoring
The Audit Balance and Control Management user interface performs all of the back-end
configuration and supports full ABC functionality in the ETL. The UI enables you to view the active
stream and all of the nodes containing the stream steps. This allows you to pinpoint exactly which
steps have failed when the stream has been stopped. You can also view the history of the stream
as well as inactive streams.

l Stream. A stream represents the definition of what should run in the ETL, for example,
Upstream. It is a set of a flow of ETL steps. The DW ABC Streams Management UI displays
any stream that is defined, along with the historical data and archived stream information for that
stream.

l Batch. A batch is a particular run-time instance of the stream. There is a new batch ID for each
run of the batch. Each time you load a batch, you are creating a run-time instance of the current
stream definition.

l Step. Any type of execution that you want to run in the ETL. The step is defined in a stream.
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l Node. A group of steps that run in parallel and are independent of each other. A node is meant to
simplify the display of the stream and to indicate whether a stream is blocked. The node
indicates whether the batch can progress to the next node. If one step has failed, even if all other
steps in the node are successful, the execution of the ETL will not progress to the next node.

The DW ABC Streams Management UI provides visibility andmanagement of:

n Multiple streams

n Stream progress

n Stream execution history

n Archiving

n Batch scheduling

Audit, Balance, and Control
Audit, Balance, and Control (ABC) is a set of functions based on data warehousing best practices.
Although SAP BusinessObjects Data Services manages the ETLworkflow, ABC ensures work
flow integrity. It controls the overall ETL execution, provides error handling, and collects job
progress statistics. ABC's ETL streams and functions can be viewed andmanaged through the
DW ABC Streams Management User Interface, as well as the CLI. Other ABC features are:

l Job streammanagement

l Command line administration tools

l Generated ABC operational system reports

l Generated ABC historical system reports

For report details, see ABC Operational Reports and DataModel Reports.

Tasks
This section includes:

"View active streams" on the next page

"Display hidden streams" on the next page

"Verify or schedule the run_steps command" on the next page

"View stream attributes" on page 115

"Schedule a batch job" on page 115

"Load or resume a batch job" on page 115

"Suspend a stream" on page 115

"Abort a stream" on page 115

Administrator Guide
ETLManagement

Page 113 of 413HP IT Executive Scorecard (9.41)



"View node information" on the next page

"View step attributes" on page 116

"Refresh stream data" on page 116

"View historical data" on page 116

"View archived data" on page 116

"Automatically retry steps" on page 116

"Manually retry steps" on page 116

View active streams

1. Select Admin > ETL Management.

2. In the DW ABC Streams Management UI page the stream information is displayed.

Display hidden streams
The DW ABC Streams Management UI enables you to view streams that are hidden and used only
for back-endmaintenance.

1. Select Admin > ETL Management and select Show Hidden Streams.

2. The hidden ETL streams are displayed.

3. You can then schedule the run-steps command and load the batches, as needed.

4. Click to load and run the batch.

5. Click to refresh and check the running status of the ETL.

For details, see "Enterprise Readiness (ER) Tools" on page 284.

Verify or schedule the run_steps command
Run_steps is automatically scheduled after deployment in the post-install. It schedules steps for
each defined stream. The run_steps Scheduler dialog box enables you to verify or change the
settings. The ABC Web Services server automatically creates a schedule for each active stream
(Upstream). Run_steps executes every fiveminutes, or whatever interval you have set in the DWH
settings for the value run_steps scheduler interval. For details see "DataWarehouse Settings" on
page 140. The stream will only run once you have loaded a batch.

Note: If you add a new stream definition, youmust manually define a run_steps schedule.

1. Select Admin > ETL Management and click in the Stream Information area.

2. The Stream Scheduler dialog box opens.

3. Select theRun-Steps Scheduler tab.
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4. Click Add New to create a new schedule for a specific stream.

5. Click Save.

6. Click Delete to delete a displayed schedule. You can then add a new one to replace it.

View stream attributes

1. Select Admin > ETL Management and click More Info in the Stream Information area.

2. The Stream Attributes dialog box opens, displaying the various read-only stream details.

Schedule a batch job

1. Select Admin > ETL Management and click in the Stream Information area.

2. The Stream Scheduler dialog box opens.

3. Select the Load -Batch Scheduler tab.

4. Select the relevant Schedule Type and times and click Save.

Load or resume a batch job

1. Select Admin > ETL Management .

2. When there is no running batch (stream state is None) or the running batch is in a suspended
state (stream state is Suspended), click to load or resume a batch.

Suspend a stream
When the stream is running and the state is Active, you can suspend the stream to allow no action
to happen.

l Select Admin > ETL Management and click in the Stream Information area.

Abort a stream
When you abort, the batch cannot be run again, when you load, it will start a new batch.

l Select Admin > ETL Management and click in the Stream Information area.

View node information

1. Select Admin > ETL Management and click a node in the Stream Information area.

2. The Node Step list opens with the step information displayed.
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View step attributes

1. Select Admin > ETL Management and click More Info in a specific node.

2. The Step Attributes dialog box opens, displaying the various read-only step details.

Refresh stream data

l Select Admin > ETL Management and click in the Stream Information area.

View historical data
Themost recent batch history of the stream is displayed first. You can navigate through the pages
of the various batches. You can view up to five batches at a time.

1. Select Admin > ETL Management and click Historical Data in the Stream Information area.

2. The Historical Data page opens.

3. Select Next to view the other batches in the stream's history. All fields are read only.

View archived data
You can view previous stream definitions and the historical data for each. The historical data is the
batch history for that particular definition. When you add a data source it changes the stream
definition. The new definition has no historical data, you can only view the archived stream and see
the historical data of the previous definitions. All fields are read only.

1. Select Admin > ETL Management and click Archived Streams in the Stream Information
area.

2. The Archived Stream Definition page opens.

Automatically retry steps
There is an automatic retry for attempting to fix step errors. A step that has an error it will not
necessarily remain and can resolve itself.

There is a configurable automatic retry mechanism which is set by default to four times. For details
on changing the amount of automatic retries, see "Change the Number of Retries for a Failed ETL
Step" on page 396.

Manually retry steps
The retry image appears when there has been a failure on a step.

1. Select Admin > ETL Management and click an error node in the Stream Information area.

2. The Node Step list opens with the step information displayed.

3. If all of the retries have been exhausted, and the Retry icon appears.

4. Click in the Stream Information area to suspend the stream.
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5. Fix the problem, andmanually retry by clicking .

6. Once the error is resolved, click to resume the stream.

UI Description
DW ABC Streams Management Page
You can view andmanage ETL stream functions and run-time information through the DW ABC
Streams Management UI. The active stream and details are displayed as well as the node and step
details.

<Stream Display>
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

<Stream
Information>

Displays the following stream details:

l Stream Name

l Status: Active or Suspended or None

l Duration

l Date
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UI Element Description

Show Hidden
Streams

Click to display the hidden ETL streams.

Refreshes the stream information. There is an automatic refresh of the
stream information every twominutes.

More Info Opens the Stream Attributes dialog box. For details, see "Stream Attributes
Dialog Box" on page 120

Load Batch/Resume. Starts or resumes the running of the specific batch
of ETL stream.

Opens the Stream Scheduler dialog box. Enables you to schedule the load
batch and run_steps commands. For details, see "Stream Scheduler Dialog
Box" on page 123.

Suspend Stream. Temporarily suspends the stream.

Abort Stream. Stops the stream that is running.
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UI Element Description

<Node Display> Displays the nodes representing the groups of steps within one level of
execution of an ETL run, the steps that can run in parallel. A node is a
collection of steps that all run in parallel. The icon for each node represents
the worst status of all of the steps in the node.

Indicates that the particular step or all steps in the node have finished
successfully in the execution.

Indicates that a step or a step in the node is currently running

Indicates an error in one of the steps. The step is automatically retried
four times by default. Click the Error node to display the Node Step List in
order to retry steps. Click to retry the step.

Indicates a warning in one of the steps.

Click a node to open the Node Step list.

If a step is in error and its maximum number of automatic retries has been
exhausted, then the stream is blocked and will not advance to the next
node. All of the steps contained in the node will run to completion or
maximum retries. The errors must be resolved before the stream will
advance to the next node.

Click More Info to display the Step Details dialog box pertaining to the
particular step. For details, see "Step Attributes Dialog Box" on page 121.

Historical Data Opens the Historical Data page where you can view stream history,
including the active stream.

For details, see "Historical Data Page" on page 126

Archived
Streams

Opens the Archive Data page where you can view streams that were
previously active with a different definition. for details, see "Archived
Streams Page" on page 127.
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Stream Attributes Dialog Box
This dialog box enables you to view the attributes of the displayed stream.

User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

All fields are read-only.

UI Element Description

Name Stream name.

Batch ID The ID of the specific batch job of the stream.

Status
Information

Provides details about the status of the stream.

Status Displays the status of the batch:

l OK

l Warning

l Error
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UI Element Description

State Displays the state of the batch:

l Active

l Suspended

l Finished

l Aborted

Start Time The date and time of the start of the batch job.

End Time The date and time of the end of the stream batch job.

Recovery
Action

Displays any information about recovery actions if the stream was
suspended or stopped.

Last
Suspended

The date and time the stream was suspended.

Last Resumed The date and time the stream was resumed.

Aborted The date and time the stream was aborted.

Step Attributes Dialog Box
This dialog box enables you to view the attributes of the displayed step.
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User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

All fields are read-only.

UI Element Description

Name Step name.

Process ID The ID of the specific run of the step.

Batch ID The ID of the specific batch job of the stream.

Status
Information

Provides details about the status of the step.
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UI Element Description

Status Displays the status of the step:

l NA

l SUCCESS

l WARNING

l ERROR

l MAX_EXECUTION_TIME_EXCEEDED

State Displays the state of the step:

l WAITING

l RUNNING

l STARTING

l FINISHED

Start Time The date and time of the start of the run.

End Time The date and time of the end of the run.

Job Name The BODS job name.

Retry
Sequence

The number of automatic retries.

Recovery
Action

Displays any information about recovery actions if the step failed.

Schedule
Time

The date and time the batch was loaded.

WS Call Time The date and time that ABC makes the call to execute. Indicates if there is a
problem in the execution.

Step Details BODS Jobs: The workflows for the BODS jobs associated with each step.

Other executables: Sub-processes of the step.

Stream Scheduler Dialog Box
This dialog box enables you to schedule a specific batch job and schedule a run_steps command.
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Load Batch Scheduler Tab

User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI
Element Description

Schedule
Type

Select either:

l Interval: Timeframe inminutes.

l Time of day: Time according to 24 hour clock.

Enter the required schedule time in the relevant row.

Delete. Deletes the adjacent schedule time.

Add New Creates a new schedule. The new schedule is displayed in blue. When the schedule
is saved to the server, the schedule is displayed in black.
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UI
Element Description

Save Saves all changes to the server.

Discard Discards all changes without saving them to the server.

Close Closes the Load Batch Scheduler dialog box.

Run_Steps Scheduler Tab
This sets the frequency that the ETLManagement runs all of the executables for the stream.This
includes steps that are loaded as well as the batches created.

User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI
Element Description

Interval
(mins)

Enter the interval at which you want to schedule the run_steps command.

The default run_steps interval is initially set at 5minutes in the DataWarehouse page
of the Admin tab, but it is recommended to only make changes to the run_steps
interval in this scheduler.

Add
New

Enables you to add a new schedule for the run_steps command.

Save Saves all changes to the server.

Discard Discards all changes without saving them to the server.

Close Closes the run-steps Scheduler dialog box.
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Historical Data Page
You can view a stream's job history on the Historical Data page..

<Stream Display>
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Back to Active
Streams

Opens the DW ABC Streams Management UI main page.

<Stream
Information>

Displays the following stream details:

l Batch ID Number

l Status: Active, Suspended or Aborted

l Duration

l Date
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UI Element Description

More Info Opens the Stream Details dialog box. For details, see "Stream Attributes
Dialog Box" on page 120.

<Node Display> Displays the nodes representing the groups of steps within the execution of
an ETL run. A node is a collection of steps that all run in parallel.

Indicates that all steps have finished successfully.

Indicates an error in at least one of the steps.

Indicates that the worst status of all contained steps is a warning.

Click a node to open the Node Step list.

Previous Navigates to the previous job history data for the stream.

Next Navigates to the next job history data for the stream.

<< Navigates to the earliest job history data for the stream.

Archived Streams Page
This page enables you to view stream definitions that have been changed and archived..
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User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

All fields are read-only.

UI Element Description

Back to
Active
Streams

Opens the DW ABC Streams Management UI main page.
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UI Element Description

<Stream
Information>

Displays the following stream details:

l Stream Name

l Status: Active or Suspended

l Duration

l Date

More Info Opens the Stream Details dialog box. For details, see "Stream Attributes Dialog
Box" on page 120.

Historical
Data

Opens the Historical Data Page where you can view the archived stream
history. For details, see "Historical Data Page" on page 126.

Back to
Active
Streams

Opens the DW ABC Streams Management UI main page.

<Node
Display>

Displays the nodes representing the groups of steps within the execution of an
ETL run. A node is a collection of steps that all run in parallel.
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Perform Administration Tasks for
Foundation

Foundation settings enables you to define various system settings for the administration of the
product. The Foundations Settings includes the following:

l "Foundation" on the next page. Enables you to configure virtual server settings.

l "Pages Settings" on page 136. Enables you to configure page settings.

l "Single Sign-On Settings" on page 133. Enables you to define SSO parameters.

l "Website Settings" on page 138. Enables you to set the ping time interval.
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Foundation
Enables you to configure foundation settings in Executive Scorecard.

To access:
Select Admin > Foundation > Foundation.

Section navigation: l "Tasks" below l"UI Description" below

Tasks
Configure the Foundation settings

1. Select Admin > Foundation > Foundation.

2. Click the relevant row and enter the required setting.

3. Click Save to save your settings.

UI Description
Foundation
This page enables you to configure the Pages settings.

Click to refresh the page.

User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Automatic
update of
anti virus
database

Set to true to periodically update the anti virus database. The update occurs
every Sunday at 12:00 am (midnight).

Default: false
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UI Element Description

Query
Engine
Expired
Execution
Time

If the SQL executing time exceeds the value of the setting, the allocation of ITFM
returns an error. Youmay need to increase the value if your allocations have
many stages or if your database includes many cost data. The unit is seconds.

Default: 600.

Virtual
Server URL

The URL of the virtual server.
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Single Sign-On Settings
HP Lightweight Single Sign-On is amethod of access control that enables you to navigate to other
HP products that implement LW-SSOwithout supplying credentials again. A user can log on once
and gain access to the resources of HP software systems without being prompted to log on again.
The applications inside the configured group of software systems trust the authentication, and there
is no need for further authentication whenmoving from one application to another.

The Single Sign-On page enables you to configure Single Sign-On (SSO) requirements.

To access:
Select Admin > Foundation > Single Sign-On.

Section navigation: l "LearnMore" below l "Tasks" below l "UI Description" below

Learn More
HP Lightweight Single Sign-On is amethod of access control that enables you to navigate to other
HP products that implement LW-SSOwithout supplying credentials again. A user can log on once
and gain access to the resources of HP software systems without being prompted to log on again.
The applications inside the configured group of software systems trust the authentication, and there
is no need for further authentication whenmoving from one application to another.

Important Information
For details on SSO and Identity Management, see "Use the Identity Management Single Sign-On".

Tasks
Add or change SSO values

1. Select Admin > Foundation > Single Sign-On.

2. Click the relevant field in theValue column and enter the value.

3. Click Save to save your settings.

UI Description
Single Sign-On Page
This page enables you to configure the SSO settings to log on of all HP products.

Click to refresh the page.
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Identity Management Single Sign-On Table

UI Element Description

Identity
Management
Enabled

Select the check box and enter the name of the IDM header (the header that
contains the user logon name) in theValue field of the Identity Management
Header setting.

For details, see "Use the Identity Management Single Sign-On" .

Identity
Management
Header

The name of the IDM header (the header that contains the user logon name).

Lightweight Single Sign-On Parameters
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

LW-SSO Server Domain The domain used for token creation. This value is required in cases
of multi domains.

LW-SSO Token Creation
Key (initString)

The string used as the encryption key for token creation and
validation.

LW-SSO Trusted Hosts -
DNS Domains

The list of trusted DNS domains that allow multi-domain support
(must be separated by commas).

LW-SSO Trusted Hosts -
FQDN

The list of trusted hosts' FQDN that allow multi-domain support
(must be separated by commas).
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UI Element Description

LW-SSO Trusted Hosts -
IPs

The list of trusted hosts' IPs (including IPv6) that allow multi-
domain support (must be separated by commas).

LW-SSO Trusted Hosts -
Net Bios Names

The list of trusted hosts' net bios names that allow multi-domain
support (must be separated by commas).
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Pages Settings
Enables you to configure the Dashboard page settings in Executive Scorecard.

To access:
Select Admin > Foundation > Pages.

Section navigation: l "LearnMore" below l "Tasks" below l "UI Description" on the
next page

Learn More
Formore information about Executive Scorecard pages, see Page Layout and Components in the
IT Executive Scorecard Business Analyst Guide.

Tasks
This section includes:

"Configure the page settings" below

"Modify themaximum number of open pages" below

"Modify themaximum number of active pages" on the next page

Configure the page settings

1. Select Admin > Foundation > Pages.

2. Click the relevant row and enter the required setting.

3. Click Save to save your settings.

Modify the maximum number of open pages
By default, an unlimited number of pages can be open at the same time. If you havemultiple pages
open, up to 5 of themost popular pages are immediately available for display when you switch to
them. The other pages are least viewed pages, meaning that are silently deactivated in the
background. When you select them, it might take a few seconds until they load and display their
content.

Note that if you increase these limits, performancemay be impaired.

Tomodify themaximum number of open pages:

1. Select Admin > Foundation > Pages.

2. Modify theMaximum number of open pages entry as needed.

For details, see "Perform Administration Tasks for Foundation" on page 130.
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Note that if you increase themaximum number of pages, performancemay be impaired.

Modify the maximum number of active pages
By default, an unlimited number of pages can be open at the same time. If you havemultiple pages
open, up to 5 of themost popular pages are immediately available for display when you switch to
them. The other pages are least viewed pages, meaning that are silently deactivated in the
background. When you select them, it might take a few seconds until they load and display their
content.

Note that if you increase these limits, performancemay be impaired.

Tomodify themaximum number of active pages:

1. Select Admin > Foundation > Pages.

2. Modify theMaximum number of loaded pages entry as needed.

For details, see "Perform Administration Tasks for Foundation" on page 130.

UI Description
Pages Settings
This page enables you to configure the Pages settings.

Click to refresh the page.

User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI
Element Description

Max
loaded
Pages

Themaximum number of open pages that are currently loaded in Executive
Scorecard. The options are any valid number or 0 for unlimited.

Max open
pages

Themaximum number of open pages in Executive Scorecard. The options are any
valid number or 0 for unlimited.
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Website Settings
TheWebsite page enables you to configure ping time intervals for refreshing the browser
automatically

To access:
Select Admin > Foundation > Website.

Section navigation:  l "Tasks" below l "UI Description" below

Tasks
Set the ping interval

1. Select Admin > Foundation > Website.

2. Select the check box to enable the ping feature. De-select the check box to disable the ping
feature. The browser will then time out.

3. Click thePing time interval row and enter the required time in seconds.

4. Click Save to save your settings.

UI Description
Website Page
This page enables you to configure theWebsite settings.

Click to refresh the page.

User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Enable Session
Keepalive

Select to enable the ping feature.
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UI Element Description

Ping time interval The amount of time (in seconds) between browser refresh. This ensures
that the application does not time out.

Note: Changes will only take effect in the next logon.
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Data Warehouse Settings
DataWarehouse Settings enables you to define settings for various parts of the data warehouse
structure.

To access:
Select Admin > Data Warehouse.

Section navigation:  l "LearnMore" below l "Tasks" on page 145 l "UI
Description" on page 145 l

Learn More
Model
The data warehousemodel is an end-to-end solution for extracting source data and consolidating
disparate source datamodels into a consolidated datamodel. The data organized to reflect this
model resides in target tables that become the source for Executive Scorecard.

The data warehouse relies on an external RDBMS to provide daily maintenance and backup
support, SAP BusinessObjects Data Services to assist with ETL, an ABC infrastructure of utilities
and processes to govern regularly scheduled ETL jobs, and internal data warehouse utilities to
create the data warehouse andmaintain data integrity.

The figure below shows the principal data warehouse components and how they interact. Read the
following sections for more information about each component, its role, and responsibilities.
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Source Data Models
Source data originates in external application repositories. Data generated by an external
application can be rich in business information, but unless you can integrate it with equally
important business information generated by other applications, it is difficult to get a complete view
of operational information.

The source datamodels describe the source and extraction format so that the data warehouse can
consume this data and integrate it into a common view that you can use to populate comprehensive
business intelligence reports and dashboards.
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Data Integration Interface
The data integration interface (DII) is the access layer that stands between the source database
models and the extractionmodels in the staging database. The DII uses amappingmodel that
transforms the source data to fit into extraction work tables. The DII can accommodateminor
variations in the sourcemodel schemas from one version to another.

Note: This interface requires access to the source systems.

SAP BusinessObjects Data Services
SAP BusinessObjects Data Services is the access mechanism that performs the physical data
extraction from the source repository to the staging database. Each stage of the ETL is embodied in
a Data Services job, from the extraction of source data to the target database.

Audit, Balance, and Control
Audit, Balance, and Control (ABC) processes ensure that source data is not corrupted in the
extraction process, and that the integrity of the extracted data is maintained as it progresses from
the initial source extraction through the logical and physical transformation into target tables. SAP
BusinessObjects Data Services canmove the data but does not evaluate whether the final result is
correct. ABC establishes checkpoints and provides feedback on each step to guarantee that each
step is valid before the next step begins.

The Audit component ensures consistency during ETL processing. It measures the number of
records in and the number of records out for each step and displays these runtime statistics in a
collection of audit reports.

Balance verifies that data in the data warehousematches data in the source system.

Example If the data warehouse stores project dollar amounts then the balance process verifies
that the aggregate project dollars in the data warehousematches the aggregate project dollars
in the source application data.

Control governs the order of execution of ETL processes. Control makes sure that there is a proper
restart and recovery when a system error occurs. Control alsomanages job dependencies at
runtime.

ABC utilities are applications that you can invoke automatically or manually to run ETL, solve
problems, and perform ETL-related tasks.

Staging Database
The staging database contains tables and snapshots that are critical to the ETL process. Metadata
describes these tables. Executive Scorecard processes data in the staging database before loading
it into the final target tables in the target database.

l Extraction (EXT) tables contain the initial version of source data. EXT tables are used during the
stage of ETL when Executive Scorecard loads data from the extract flat files into the staging
database.

l Validation failure (VALF) tables are used during the data validation process that ensures all of
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the data is usable. VALF tables store source data that is rejected by the ETL process due to
validation failure. Data validation is part of the process to load the EXT tables.

l Identification (SSI andMSI) tables restructure the diverse source system data into a conformed
structure. Executive Scorecard uses SSI andMSI tables to standardize the data and add an
enterprise key.

l Consolidation (MSC) tables integrate disparate source data into a consolidated entity. TheMSC
tables contain the uniform structure that Executive Scorecard uses to load the data into the
target tables.

l Transformation (XFR) tables are load-ready tables that match the internal structure of the target
tables. Executive Scorecard uses XFR tables while preparing the data to be loaded into the
target tables in the target database.

l Lookup (LOOKUP) tables store durable keys and surrogate keys. Executive Scorecard uses
these tables to establish dimension-to-dimension references in dimension tables and foreign key
references in fact tables.

l Snapshot (TSNP, SSNP, and CSNP) tables are the persistent storage for ETL staging data.
These snapshot tables capture the changed data and support the data warehouse recovery
process. The data warehouse uses TSNP tables for source extraction staging, SSNP tables for
single source integration staging, and CSNP tables for multiple source consolidation staging.
The final ETL stage captures the snapshot data.

l Cross Reference (XREF) tables support the data integration processes that combine records
frommultiple sources into a single record in the consolidationmodel.

l Cross ReferenceGenerator (XREFGEN) tables support datamatching and cross reference
inputs for the consolidationmodels.

l Metadata tables contain a logical model and describe how to translate that model into the
physical implementation of tables and views.

ABC tables support the ETL workflow and enable job control and sequencing. They also host audit
information to ensure data quality.

Target Database
The target datamodels describe the format of the data that produces business intelligence
analytics. The instantiated datamodels are dimension, fact, and hierarchy tables populated with
data obtained through ETL processes.

Dimension tables contain the datamodel to be queried and presented by Executive Scorecard in a
variety of reports and analytics.

Fact tables contain data that describes events, transactions, or other granular information.

Fact snapshots tables are fact tables that describe the state of things in a particular instance of
time, and usually includes more semi-additive and non-additive facts.
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l Semi-Additive:Semi-additive facts are facts that can be summed up for some of the
dimensions in the fact table, but not the others.

l Non-Additive:Non-additive facts are facts that cannot be summed up for any of the dimensions
present in the fact table.

Hierarchy tables capture hierarchical relationships among levels of data.

Queries
You can use structured query language (SQL) to create a primary abstraction layer of data from the
target tables and use that data to populate reports, dashboards, or resolve business questions. The
SAP BusinessObjects Enterprise XI 3.1 suite of business tools simplify accessing this information
and storing it in business-oriented views.

Presentation
SAP BusinessObjects Enterprise XI 3.1 uses a universe abstraction layer to organize data for
presentation in out-of-box or user-designed analytics. The universe provides a business oriented
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view of the data that resides in the data warehouse target tables.

Tasks
To Define the Data Warehouse Settings

1. Select Admin > Data Warehouse.

2. Click the relevant field in theValue column and enter the value.

3. Click Save to save your settings.

UI Description
Data Warehouse Page
This page enables you to configure the DataWarehouse settings.

Data Warehouse Table

Name The name of the DataWarehouse field.

Description The description of the DataWarehouse field.

Value The current DataWarehouse field value.

Click the relevant row and enter a value.

General Table
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UI Element Description

BODS
Cleanup
Days of
Week

The days of the week when you want to perform the cleanup of the BODS dump.
Select: 0 or 7 for Sunday is, 1 for Monday, 2 for Tuesday, 3 forWednesday, 4 for
Thursday, 5 for Friday, and 6 for Saturday, or use the first three letters of the day
name.

SAP BusinessObjects Data Services creates dump files whenever it runs into a
problem. These dumps are usually large and are not removed automatically ,
causing the file system to eventually run out of disk space.

When the scheduled cleanup of the dump files is executed, it first cleans up the
dump files, and then it examines the schedule settings and update its schedule if
needed. So, if you’ve scheduled the cleanup for once a day Sunday – Thursday,
and you want to change it to once a week, simply change the days of week value
and the next time the cleanup is triggered, the new schedule will go into effect.

Example

If you want to schedule the cleanup every Sunday, you can enter any of the
following in the BODS Cleanup Days of Week setting value:

l “Sun”

l 0

l 7

If you want to schedule the cleanup every Monday – Friday, you can enter any
of the following in the BODS Cleanup Days of Week setting value:

l “Mon” – “Fri”

l 1-5

l 1,2,3,4,5

l “Mon”, “Tues”, Wed”, “Thurs”, “Fri”

The value is simply used to set the dayOfWeek field in the
javax.ejb.ScheduleExpression and the ScheduleExpression performs the
validation of the value.

BODS
Cleanup
Time of
Day

The time (hours andminutes) when you want to perform the cleanup of the BODS
dump. The format is: HH:MM for a 24 hour clock (for example: 16:00). The hour is
according to the server time zone, not to the client time zone.
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UI Element Description

Data
Warehouse
Port

The DataWarehouse web server port. This field is read-only.

Data
Warehouse
Server
Name

The DataWarehouse server machine hostname or IP address. This field is read-
only.

External
Source
File
Location

The directory where the external source files used by the DataWarehouse are
stored.

First year
handled by
DWH dates

The first available year for DataWarehouse dates. This includes period, time
zones or DST.

Fiscal
month of
year

The first month of the fiscal year. This field is read-only.

Last year
handled by
DWH dates

The last available year for DataWarehouse dates. This includes period, time
zones or DST.

Scheduler
Run-steps
Interval

The interval value in minutes that you want the run_steps command to
automatically execute. This is the default value for initial execution. All changes in
interval should bemade in the DW ABC Streams Management UI. For details, see
" ETLManagement " on page 112.

A run-steps schedule configured in DataWarehouse Settings does not affect the
existing running batch schedule. It is recommended to only change the run-steps
interval schedule in the ETLManagement tab DW ABC Streams Management UI.

To enable a new run-steps schedule configured in DataWarehouse Settings on
existing defined streams you can:

l Restart the XS server.

l Reload the dw-abc-services application: Glassfish Admin Console >
Applications, and click Reload for the dw-abc-services application.

l Redeploy the application

In these cases you would now have two scheduled intervals. Delete one in the
DW ABC Streams Management UI.
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SAP BusinessObjects Data Services for HP XS Table

UI Element (in
alphabetical
order) Description

BODS
Database
Administrator
Username

The username to access the SAP BusinessObjects Data Services database.
Must have write permissions.

BODS
Database
Administrator
Password

The user's password to access the SAP BusinessObjects Data Services
database.

BODS database
type/product

The database type: Oracle, SQL Server, DB2, MS SQL, or Sybase ASE.
This field is read-only.

Note: Currently only MS SQL is supported.

BODS
Repository
Server Name

The SAP BusinessObjects Data Services repository server machine's host
name or IP address.

Installation
Directory

The absolute path to the SAP BusinessObjects Data Services and HP XS
installation directory. This field is read-only.

Management
Console
Password

The SAP BusinessObjects Data Services management console password.
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UI Element (in
alphabetical
order) Description

Management
Console URL

The SAP BusinessObjects Data Services management console URL. This
field is read-only.

Management
Console
Username

The SAP BusinessObjects Data Services management console username.

Repository
Database-
Server's Port

The SAP BusinessObjects Data Services repository database server's port.
This field is
read-only.

Repository
Name

The SAP BusinessObjects Data Services repository name. This field is read-
only.

Repository
Password

The SAP BusinessObjects Data Services repository password.

Repository
Username

The SAP BusinessObjects Data Services repository username. This field is
read-only.

Web Services
Timeout

The amount of time, in seconds, that DataWarehouse waits for a SAP
BusinessObjects Data Services to respond to a web services request before
a timeout.

Staging Database Table
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UI Element (in
alphabetical order) Description

ABC Database
Password

The ABC database password.

ABC Database
Username

The ABC database username. This field is read-only.

ABC DB login name ABC logon name used to access the database.

ABC DB login
password

ABC logon password used to access the database.

Database Password The staging database password.

Database Server Name The staging database server machine hostname or IP address.

Database Server Port The staging database server port.

Database Username The staging database username. This field is read-only.

Metadata Database
Password

Themetadata database password.

Metadata Database
Username

Themetadata database username. This field is read-only.

Metadata DB login
name

Metadata logon name used to access the database.

Metadata DB login
password

Metadata logon password used to access the database.

Password The staging database administrator password.

Staging Database Name The name of the staging database on theMS SQL server. This field
is read-only.

Staging DB login name Staging database logon name used to access the database.

Staging DB login
password

Staging database logon password used to access the database.
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UI Element (in
alphabetical order) Description

Staging Target DB
Database Password

The staging target database password.

Staging Target DB
Database Username

The staging target database username. This field is read-only.

Staging Target DB
login name

Staging Target database logon name used to access the database.

Staging Target DB
login password

Staging Target database logon password used to access the
database.

Time Dimension
Granularity

The granularity of time, in minutes, of the time dimension. This field
is read-only.

Username The staging database administrator username. This user must have
write permissions. This field is read-only.

Target Database Table

UI Element (in
alphabetical order) Description

Administrator
Password

The target database administrator password.

Administrator
Username

The username used to access the target database. This user must
have write privileges. This field is read-only.

Database Password The target database password.

Database Server Port The target database server port. This field is read-only.
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UI Element (in
alphabetical order) Description

Database Username The target database username. This user must have write permissions.
This field is read-only.

MS SQL Server
Database Name

The target databaseMS SQL server name. This field is read-only.

Server Name The target database server name. This field is read-only.

Target DB login
name

The logon name for the target database. May be different than the fixed
user and schema name.

Target DB login
password

The target database logon password used to access target database
metadata.
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Scorecard
The Scorecard settings enables you to define various HP IT Executive Scorecard settings and
includes the following pages:

l "Dashboard Settings" on the next page. Enables you to set the settings for the Dashboard,
where an executive can view the progress of the required objectives.

l "Score Thresholds" on page 158. Enables you to set the score thresholds for the KPIs in the
HP IT Executive Scorecard.

l "XS Settings" on page 160. Enables you to set various scorecard settings. The HP IT
Executive Scorecard is a way tomap and translate complex business information into
something that is understandable to everyone.

l "Engine Settings" on page 156. Enables you to configure settings for the HP IT Executive
Scorecard KPI engine, which performs discovery on data coming from Contexts (data sources).
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Dashboard Settings
Enables you to set the settings for the Dashboard, where an executive can view the progress of the
required objectives.

To access:
Select Admin > Scorecard > Dashboard Settings.

Section navigation:  l "LearnMore" below l "Tasks" below l "UI Description" below

Learn More
Formore Executive Scorecard dashboard information, see "Prepare the Dashboard Display".

Tasks
Set Dashboard Settings

1. Select Admin > Scorecard > Dashboard Settings.

2. Click the row of the relevant setting and enter the value.

3. Click Save to save your settings.

UI Description
Dashboard Settings Page
This page enables you to configure specific dashboard settings.

Click to refresh the page.
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Dashboard Settings Parameters
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Max search results in the filter Themaximum number of search results allowed in the
filter. The default value is 1000.

Number of days annotations are
considered new

The number of days annotations are considered new. The
default value is 7.
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Engine Settings
Enables you to configure settings for the HP IT Executive Scorecard KPI engine, which performs
discovery on data coming from contexts (data sources).

To access:
Select Admin > Scorecard > Engine Settings.

Section navigation:  l "Tasks" below l "UI Description" below

Tasks
Set Engine Values

1. Select Admin > Scorecard > Engine Settings.

2. Click the row of the relevant engine function and enter the value inmilliseconds.

3. Click Save to save your settings.

UI Description
Engine Settings Page
This page enables you to configure the engine settings for HP IT Executive Scorecard.

Click to refresh the page.

Engine Settings
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI
Element Description

Engine
Health
Timer

The amount of time inmilliseconds, after which, if the calculation result is not
received for the KPI, a new calculation attempt is started. The default value is
600,000, which equals 10minutes.
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Recalculate Settings
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Max number of days to
recalculate for Daily KPIs

Themaximum number of days used in recalculations for KPIs and
Metrics with a Calculation Period set toDaily. Default: 30.

For details, see Recalculation in the IT Executive Scorecard
Business Analyst Guide.
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Score Thresholds
Enables you to set the score thresholds for the KPIs in the HP IT Executive Scorecard.

To access:
Select Admin > Scorecard > Score Thresholds.

Section navigation: l "LearnMore" below l "Tasks" below l "UI Description" below

Learn More
Formore score threshold information, see "Learn About KPI Formula and Filter, Threshold, Value,
Trend, and Score" in the IT Executive Scorecard Business Analyst Guide.

Tasks
Set Score Thresholds

1. Select Admin > Scorecard > Score Thresholds.

2. Click the row of the relevant score threshold and enter the value.

3. Click Save to save your settings.

UI Description
Score Thresholds Page
This page enables you to configure the score threshold settings for the KPIs in HP IT Executive
Scorecard.

Click to refresh the page.
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Score Thresholds Parameters
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

Note: EachScore Max Valuemust be greater than 0 and less than the next one ( Error Score
Max Value <Warning Score Max Value < Good Score Max Value)

UI Element Description

Critical
Score Max
Value

Themaximum value on the KPI scale, below which the value is scored as an
error. KPIs that score values equal to or below this value, receive an error score.

Example If themaximum error score is 3.3, then a score on the scale from 0
- 3.3 is an error. Default: 3.3

Good Score
Max Value

Themaximum value on the KPI scale, below which the value is scored as good.
KPIs that score values equal to or below this value, receive a good score.

Example If themaximum good score is 10, then a score on the scale from
6.6 - 10, is good. Default: 10

Warning
Score Max
Value

Themaximum value on the KPI scale, below which the value is scored as a
warning.
KPIs that score values equal to or below this value, receive a warning score.

Example If themaximum warning score is 6.6, then a score on the scale
from 3.3 - 6.6, is a warning. Default: 6.6

Administrator Guide
Scorecard

Page 159 of 413HP IT Executive Scorecard (9.41)



XS Settings
Enables you to set various scorecard settings.The HP IT Executive Scorecard is a way tomap and
translate complex business information into something that's understandable to everyone.

To access:

1. Select Admin > Scorecard > XS Settings.

Section navigation:  l "Tasks" below l "UI Description" below

Tasks
This section includes:

"Configure XS settings" below

"Show or Hide Debug Properties" below

Configure XS settings

1. Select Admin > Scorecard > XS Settings.

2. Click the row of the relevant setting and enter the value.

3. Click Save to save your settings.

Show or Hide Debug Properties
Themaintenance of HP IT Executive Scorecard is performed using the Admin tab.

To display or hide the debug properties (ID and Type) displayed in the Configuration details tab for
all templates or active nodes, select Admin > Scorecard > XS Settings > Debug Mode, and:

l Select theApplication Debug Mode option to display the debug information in the
Configuration details tabs.

l Clear theApplication Debug Mode option to hide the debug information in the Configuration
details tabs.

UI Description
XS Settings Page
This page enables you to configure specific XS settings.

Click to refresh the page.
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Context Designer
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Maximum size of
.CSV file (MB)

Themaximum size of a .CSV file that can be imported into the Context
Designer. The default value is 20MB.

Debug Mode
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Application Debug Mode Select to activate the debugmode.

 Studio Update
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI
Element Description

Meta
Data
reload
rate
(Days)

The number of days after which themeta data is reloaded. If you configure Executive
Scorecard to work with the SAP BusinessObjects Enterprise universes, every X
days (where X corresponds to what you specified inMeta Data reload rate (Days)),
Executive Scorecard reloads all the universes metadata from the SAP
BusinessObjects Enterprise.

The default value is 7 days.

Administrator Guide
Scorecard

Page 161 of 413HP IT Executive Scorecard (9.41)



UI
Element Description

Users
Info
reload
rate
(Minutes)

The number of minutes after which user info is reloaded. The default value is 60
minutes.
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ITFM Settings
Enables you to configure the settings for the IT Financial Management module.

To access:
Select Admin > ITFM > ITFM.

Section navigation:  l"Tasks" below l "UI Description" on the next page

Tasks
This section includes:

"Configure ITFM Settings" below

"Configure ITFM Users, Roles, and Permissions" below

"Change the Currency of the ITFM " below

Configure ITFM Settings

1. Select Admin > ITFM > ITFM.

2. Click the row of the relevant setting and enter the value or select the option.

3. Click Save to save your settings.

Configure ITFM Users, Roles, and Permissions
Roles and permissions for users is managed through the Admin tab, enabling you to specify
permissions for each role. Additionally, you can attach instances to a permission, so that the user
can only access certain budgets or allocations. This model is based on:

l The permissions of each user, instead of relying on the user’s roles. The permissions are final
and cannot bemodified or deleted, allowing the flexibility to grant users access to different ITFM
features, while assigning them to different roles.

l Budget related operations according to each user’s scope (instance level permissions).

Two out-of-the-box roles are available: BUDGET_COORDINATOR and FINANCIAL_ANALYST.
For details, see "RoleManagement" on page 60.

Change the Currency of the ITFM
The default currency for all IT Financial Management KPIs is $.

During the post-installation process, if you have changed the currency in theData Warehouse -
Currency Configuration page of the post-install wizard, youmust change the currency in each
one of the KPIs tomatch your selection, as follows:
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1. In the application, click Studio.

2. In the Active KPIs pane, for each KPI under the Financial Planning Analysis Scorecard,
and in theConfiguration details tab, select the relevant unit in theUnit drop down list.

3. Click Save.

UI Description
ITFM Page
This page enables you to configure specific IT Financial Management-related settings .

Click to refresh the page.

General area
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Interval for clearing
FPA cache

How long the system should save the objects loaded from the database
during the allocation scenario calculations.

Note: Do not modify this parameter.

Polling interval for
FPA's process new
data monitor

Specifies the execution interval of the IT Financial Management
procedure that checks whether new data was loaded using ETL, and
recalculates allocation scenarios accordingly.

Note: Do not modify this parameter.
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Contexts and Universes - Semantic Layer
Executive Scorecard semantic layer includes Contexts and universes.

The Context Designer feature enables you to create andmanage Contexts (universes). The
Contexts can be based on your target schema tables or on .CSV files that can be uploaded to the
target schema using the Data Loader.

Context Designer can be used to upload data and create contexts based on the data, when you
want to work with the Executive Scorecard and IT Financial Management applications without
using DataWarehouse and SAP BusinessObjects Enterprise. It is a direct way to upload data into
the Executive Scorecard Studio using files without performing integrations to external sources or to
other HP products. It can be used, to integrate third party data, testing, or for Proof of Concept
(POC) sessions. It can also be used as a component of Executive Scorecard to integrate third party
data.

Context Designer provides KPI results based on your real data.
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Semantic Layer - Context Management
The Context Management feature enables you to view the Contexts that have being created in your
application or the Contexts that have been loaded in your application, to delete Contexts, and to
launch Context Designer where you can create a new Context, view the design of an existing
Context, or upload a .CSV file.

To access:
In Executive Scorecard, click Admin > Semantic Layer > Semantic Layer. The Context
Management page opens.

Section navigation:  l "Tasks" below l "UI Description" on the next page

Tasks
This section includes:

"View existing out-of-the-box Contexts (universes)" below

"Export contexts using Content Acceleration Packs (CAPs)" below

"Import contexts using Content Acceleration Packs (CAPs) " on the next page

View existing out-of-the-box Contexts (universes)

1. In Executive Scorecard, click Admin > Semantic Layer > Semantic Layer. The Context
Management page opens.

2. The list of out-of-the-box Contexts is displayed.

3. You can now:

n Click Launch Context Designer to open the Context Designer. For details, see "Semantic
Layer - Context Designer" on page 170.

n Double-click the relevant Context in the list to open the Context Designer in context. For
details, see "Semantic Layer - Context Designer" on page 170.

n Click to refresh the display.

n Select the relevant context and click to delete the context.

Export contexts using Content Acceleration Packs (CAPs)
To export contexts, proceed as follows:

1. Create a CAP that only includes the contexts you want to export. For details, see "Create a
CAP with the Executive Scorecard application data" on page 246.
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2. Export the CAP you created. For details, see "Download a CAP to the user's local system" on
page 237

Note: You can also export contexts using a legacy JMX-based procedure. For details, see
"Export or Import Contexts" on page 349.

Import contexts using Content Acceleration Packs (CAPs)
To import contexts, proceed as follows:

1. Copy the CAP that includes the relevant contexts to the relevant local system.

2. Upload the CAP. For details, see "Upload a CAP to the Executive Scorecard application" on
page 234.

3. Activate the CAP inAdmin > Content Acceleration Pack. For details, see "Activate a CAP"
on page 235.

4. Verify the upload by accessing the contexts inAdmin > Semantic Layer. For details, see
"Semantic Layer - Context Designer" on page 170.

Note:

l If the context you import already exists, it is deleted and replaced by the context imported
using the CAP.

l You can also import contexts using a legacy JMX-based procedure. For details, see "Export
or Import Contexts" on page 349.

UI Description
Context Management Page
The Context Management page enables you tomanage the Contexts.
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User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Select the relevant context and click to delete the context.

You can select more than one context and click the icon to delete all the
selected contexts from the list.

Refreshes the display.
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Launch Context
Designer

Click to open the Context Designer. For details, see "Semantic Layer -
Context Designer" on the next page.

<Context name> Double-click the Context name to open its detail in the Context Designer.
For details, see "Semantic Layer - Context Designer" on the next page.
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Semantic Layer - Context Designer
The Context Designer feature enables you to create andmanage Contexts (universes). The
Contexts can be based on your target schema tables or on .CSV files that can be uploaded to the
target schema using the Data Loader.

Context Designer can be used to upload data and create contexts based on the data, when you
want to work with the Executive Scorecard and IT Financial Management applications without
using DataWarehouse and SAP BusinessObjects Enterprise. It is a direct way to upload data into
the Executive Scorecard Studio using files without performing integrations to external sources or to
other HP products. It can be used, to integrate third party data, testing, or for Proof of Concept
(POC) sessions. It can also be used as a component of Executive Scorecard to integrate third party
data.

Context Designer provides KPI results based on your real data.

To access:

1. In Executive Scorecard, click Admin > Semantic Layer > Semantic Layer. The Context
Management page opens. If not , click Data Loader. For details, see "Context Designer Page"
on page 191.

2. In the Context Designer page that opens:

n To create a new context, click Create a new context.

n To edit a context, click Open an existing context.

Section navigation: l "LearnMore" below l "Tasks" on page 184 l "UI Description"
on page 191

Learn More
This section includes:

"Semantic Layer (Context and Universe)" below

"Context or Universe Contents" on page 173

"Out-of-the-Box Contexts " on page 173

"Contexts, entities, and fields UUIDs" on page 173

"Loops in Contexts" on page 174

"Link between Contexts and KPI or Metric Formulas" on page 178

Semantic Layer (Context and Universe)
A semantic layer is a business representation of corporate data that helps end-users access data
autonomously using common business terms. It maps complex data into familiar business terms
such as product, customer, or revenue to offer a unified, consolidated view of data across the
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organization. By using common business terms, rather than data language, to access, manipulate,
and organize information, it simplifies the complexity of business data. These business terms are
stored as objects in a Business Context (or universe), accessed through business views. Business
Contexts enable business users to access and analyze data stored in a relational database and
OLAP cubes. This is claimed to be core business intelligence (BI) technology that frees users from
IT while ensuring correct results.

Business Views is amulti-tier system that is designed to enable companies to build comprehensive
and specific business objects that help report designers and end users access the information they
require. Business Views is intended to enable people to add the necessary business context to their
data islands and link them into a single organized Business View for their organization.

A Context or universe is a business representation of an organization's data that helps end-users
access data using common business terms. A Context is the result of a semantic layer of metadata
that creates a business oriented view of the data. A Context contains a schema of the tables that
make up the dimension andmeasurement objects. A Context is an interface between the data
warehouse and the analytics that display the data.

Context aremade up of objects and classes that aremapped to the source data and are accessed
through queries and reports. They correspond to the business contexts used in HP IT Executive
Scorecard.

Each Context includes classes (entities), objects with a dimension attribute, and relationships
between the entities. The entity's values are used in the calculation of values and statuses of the
Key Performance Indicators (KPIs) or Metrics that represent them. The KPIs or Metrics are the
building blocks used by the HP IT Executive Scorecard engine and the Studio.

Executive Scorecard Semantic Layer may include:

l Universes created in SAP BusinessObjects. For more details on universes, see the relevant
SAP BusinessObjects documentation.

l Out-of-the-box Contexts created using the Context Designer.

l User-defined Contexts created using Context Designer and populated with data uploaded from
.CSV files using Context Designer. For details on the Context Designer, see "Semantic Layer -
Context Designer" on the previous page.

If you want to change the formula of a KPI or Metric , youmust be aware of the relationships in the
context (universe) of the KPI or Metric. For details, see the KPI andMetric Library in Excel format or
in the relevant:

l ALM Data Source - Integration, Associated Contexts, KPIs, Metrics, Data Lineage, and Reports
in the IT Executive Scorecard Content ReferenceGuide for the Integration of HP Application
Lifecycle Management

l AM Data Source - Integration, Associated Contexts, KPIs, Metrics, Data Lineage, and Reports
in the IT Executive Scorecard Content ReferenceGuide for the Integration of HP Asset
Manager
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l AWS Data Source - Integration, Associated Context, KPIs, Metrics, and Data Lineage in the IT
Executive Scorecard Content ReferenceGuide for the Integration of AmazonWeb Services

l AWSCW Data Source - Integration, Associated Context, KPIs, Metrics, and Data Lineage in
the IT Executive Scorecard Content ReferenceGuide for the Integration of AmazonWeb
Service CloudWatch

l BSM Data Source - Integration, Associated Contexts, KPIs, Metrics, Data Lineage, and
Reports in the IT Executive Scorecard Content ReferenceGuide for the Integration of
HP Business ServiceManagement

l CSA Data Source - Integration, Associated Context, KPIs, Metrics, and Data Lineage in the IT
Executive Scorecard Content ReferenceGuide for the Integration of HP Cloud Service
Automation

l DP Data Source - Integration, Associated Context, KPIs, Metrics, and Data Lineage in the IT
Executive Scorecard Content ReferenceGuide for the Integration of HP Data Protector

l Hyper-V Data Source in the IT Executive Scorecard Content ReferenceGuide for the Integration
of Hyper-V

l IC Data Source - Integration, Associated Context, KPIs, Metrics, and Data Lineage in the IT
Executive Scorecard Content ReferenceGuide for the Integration of HP Insight Control

l NA Data Source - Associated Contexts, KPIs, Metrics, and Data Lineage in the IT Executive
Scorecard Content ReferenceGuide for the Integration of HP Network Automation

l NNM Data Source - Integration, Associated Context, KPIs, Metrics, and Data Lineage in the IT
Executive Scorecard Content ReferenceGuide for the Integration of HP Network Automation

l OO Data Source - Integration, Associated Contexts, KPIs, Metrics, and Data Lineage in the IT
Executive Scorecard Content ReferenceGuidefor the Integration of HP Operation Orchestration

l PPM Data Source - Integration, Associated Contexts, KPIs, Metrics, and Data Lineage in the IT
Executive Scorecard Content ReferenceGuide for the Integration of HP Project and Portfolio
Management

l SA Data Source - Associated Contexts, KPIs, Metrics, and Data Lineage in the IT Executive
Scorecard Content ReferenceGuide for the Integration of HP Server Automation

l SE Data Source - Integration, Associated Contexts, KPIs, Metrics and Data Lineage in the IT
Executive Scorecard Content ReferenceGuide for the Integration of HP Storage Essentials

l SMData Source - Associated Contexts, KPIs, Metrics, Data Lineage, and Reports in the IT
Executive Scorecard Content ReferenceGuide for the Integration of HP ServiceManager

l UCMDB Data Source - Integration and Associated Context in the IT Executive Scorecard
Content ReferenceGuide for the Integration of HP Universal ConfigurationManagement
Database
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l VCM Data Source - Integration, Associated Context, KPIs, Metrics, and Data Lineage in the IT
Executive Scorecard Content ReferenceGuide for the Integration of vCenter Chargeback
Manager

l Alternate Source Integration in the IT Executive Scorecard Content ReferenceGuide for the
Integration of Alternate Data Sources

The contexts, entities, and dimensions that are displayed and used in the Studio are part of the
universes that are located in theXS_Studio library.

Context or Universe Contents
A Context (or Universe) is a set of entities. Each entity is a set of fields. Each field can be a
dimension, measurement, or fact that can provide information about the business.

A formula calculates, for a specified time period, using the values of specific entities, a value that
represents a specific aspect of the business. The value is assigned to a Key Performance Indicator
(KPI) so that the KPI represents a specific aspect of the business.

Each Context includes some KPIs. The KPIs are the building blocks of the Studio and the
KPI engine.

These entities that are used in the calculation of the KPIs are provided by the relevant integrated
data source. Each data source corresponds to a specific Content Pack that provides the
connection between the data source and Executive Scorecard.

Out-of-the-Box Contexts
You can only addmore tables and entities to an out-of-the-box Context, you cannot remove or
modify the original elements.

Contexts, entities, and fields UUIDs
To uniquely identify contexts, entities, and fields, a universally unique identifier (UUID) is assigned
to them. When you save a new context, the UUID is auto-generated.

The flowchart explains the different configurations and their impact on the import of a Context in the
Context Designer:
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Loops in Contexts
Contexts can include tables that are linked together forming a loop.

To perform the calculation of a KPI or Metric, the system selects the path with the lowest number of
joins as the default path. If the formula includes both fields in A and in E, then the system will
choose A-B-E (2 joins) instead of A-C-D-E (3 joins).

If the structure has the same number of joins and the formula includes fields from the three tables,
then the system cannot select the path with the lowest number of joins (same number for each
path).
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In that case, the selection of the path used for calculation is random.

The paths could then be:

Or

Or

Tip: The problem of loops in context structure is that calculations may have different results
depending on the path selected by the system (random or lowest number of joins), therefore
loops are not recommended.

Workarounds:

l Modify the formulas: If you want the path to follow a specific path, youmust modify the
formula so it includes the path. For example, if the formula is SUM (A.duration, *) filter
E.status=’OK’ it will follow the A-B-E path because it has the smallest number of joins, but if you
want it to pass via C you canmodify the formula as follows: SUM (A.duration,*) with filter
E.status=’OK’ but then the path could go A-C-D-E or C-A-B-E. If you want it to follow A-C-D-E
you should use SUM (A.duration, C.id=C.id and D.id=D=id) with filter E.status=’OK’.
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l Duplicate the table:Duplicate the table that is linked to a large number of other tables. If you
have the following context structure:

You can create the same structure without loops by using copies (aliases) of theMember table,
give each table another name, and create the relevant joins, as follows:
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Once you have created the aliases you can drag them to the Entities area.

l Modify the view: If you have the structure below then when the tables are dragged to the
Context Designer Entities area, then each entity and its attributes appear separately .

You canmodify the views in the Target schema to correspond to the structure below, where the
attributes of the entity include both the entity original attributes and the attributes corresponding
to the person who submitted the idea. You create these views in the SQL server. This way when
the tables are dragged to the Context Designer Entities area they display the entity and its
attributes as well as the correspondingMember entity and its attributes.
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Link between Contexts and KPI or Metric Formulas
When you create a Context, you select tables, create links between the tables, and select the
relevant columns in the tables to be part of the Context. For details, see "Semantic Layer - Context
Designer" on page 170 in the IT Executive Scorecard Administrator Guide.

When you create a KPI or aMetric you assign them aContext in the Studio. The Context tables
become variables that you can use when creating KPI or Metric formulas, and the table columns
become the variable entities.

For example the% of Reopened DefectsKPI has the following formula:

RATIO_MATH(COUNT_DISTINCT( DefectHist.Defect , DefectHist.ReopenFlag =1 And
Defect.Status <> 'Closed') , COUNT(  Defect ,Defect.DefectSummary<> 'INVALID' And
Defect.DefectSummary<> 'UNKNOWN' ),0)*100
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Its definition is:

The Business Context is ALM_Defect.
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Click Admin > Semantic Layer and open the ALM_Defect Context:
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The contents of the Context including the ALM tables is displayed:

In the Entities area on the right, you can see the tables and the table columns that were selected to
be part of the ALM_Defect Context itself.
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It is recommended that the person who creates the KPI or Metric formula should be familiar with the
ALM entities that are used in the ALM_Defect context as the XS documentation does not provide
that information:

TheDefect_Hist table corresponds to one of the entities (DefectHist) that appears in the list of
Variables that can be used when creating or modifying the formula of a KPI based on theALM_
Defect context. To access the KPI or Metric formula, click Studio, highlight the relevant KPI (% of
Reopened Defects for example), click theCalculation Details tab, and then click Open
Formula builder.
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The variables you see in the formula builder correspond to the Entities in the Context Designer
(above) and correspond to the <EntityName> in the syntax of the formulas (as explained in Modify a
KPI or Metric Formula in the IT Executive Scorecard Business Analyst Guide).
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When you expand a variable, the items you see below correspond to the fields (in the Context
Designer) and correspond to the <FieldName> items in the formulas syntax (as explained in Modify
a KPI or Metric Formula in the IT Executive Scorecard Business Analyst Guide).

Tasks
This section includes:

"View existing out-of-the-box Contexts (universes)" on the next page

"Create a Context and use its contents in the Studio" on page 186

"Update a Context" on page 188
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"Add a column to a Target database table and the impact on the context" on page 189

"Remove a column from a Target database table and impact on context" on page 190

View existing out-of-the-box Contexts (universes)

1. In Executive Scorecard, click Admin > Semantic Layer > Semantic Layer. The Context
Management page opens.

2. The list of out-of-the-box Contexts is displayed.

3. Click Launch Context Designer.
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4. In the Context Designer page that opens, click Open an existing context.

5. Select the relevant Context.

The structure of the Context is displayed.

Create a Context and use its contents in the Studio

1. Create a new Context
a. In Executive Scorecard, click Admin > Semantic Layer > Semantic Layer.

b. In the Context Management page, click Launch Context Designer.

c. Click Create a New Context. The Context Designer page opens.
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d. Enter the name of the Context .

e. Click Open Repository. TheRepository area opens. You can use:
o Tables from theExternalTables list. These tables are created from external tables in

CSV format that are uploaded to Executive Scorecard. For details on how to upload a
CSV table, see "Semantic Layer - Context Designer" on page 170. After the table is
uploaded, a corresponding table named ext.<csv_table_name> is listed in the
ExternalTables list.

o Internal tables from the InternalTables list.

If you are working with Enterprise Executive Scorecard, the tables listed in the
InternalTables list are the DataWarehouse tables, the Period tables created during the
post-install procedure, and the View table.

f. Drag the relevant tables from theRepository to theScheme area.

g. Define the relationships between the tables by dragging a specific column from one table
and dropping it over the relevant column in another table. A visual link is added to the graph
to indicate the relationship.

h. Drag the relevant tables from theScheme area to theEntities pane. The tables become
variables and the columns become the variable entities that can be used to create KPI or
Metric formulas when a KPI or Metric is assigned the Context in the Studio.

i. Click to save the Context.

2. Load the Context and verify the variables and entities
a. In Executive Scorecard, click Studio.

b. Activate a KPI or aMetric or clone any active KPI or Metric that does not have a KPI
Breakdown or BreakdownMetric. For details, see Activate Scorecards, Perspectives,
Objectives, Metrics, or KPIs Using Templates or Create Active Scorecards, Perspectives,
Objectives, Metrics, or KPIs in the IT Executive Scorecard Business Analyst Guide.

c. Click theCalculation details tab, and click Select business context. For details, see
KPI or Metric Configuration and Calculation Details in the IT Executive Scorecard
Business Analyst Guide.

d. In the Business Context dialog box, change its Context to the new Context.

e. You can thenmodify the formula that is used to calculate the KPI or Metric status by
selecting the variables that correspond to the entities and fields that were defined in the
Context Designer. To do that click Open Formula Builder.

f. In the Formula Builder dialog box, verify that the variables correspond to the tables you
selected in the Entities area in the Context Designer, and that the entities of the variables
correspond to the selected columns of those tables. Click OK to save the KPI.
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Note: In the sameway, you canmodify the Filter of the KPI or Metric to use the
variables corresponding to the .CSV file-based Context (universe).

Update a Context

1. In Executive Scorecard, click Admin > Semantic Layer > Semantic Layer. In theContext
Management page, click Launch Context Designer. The Context Designer page opens. For
details, see "Context Designer Page" on page 191.

2. Select the relevant Context.

3. Make the relevant changes: delete or add entities, fields, tables, columns, or relationships.
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4. Click to save the Context.

5. Load the Context and verify.

Export contexts using Content Acceleration Packs (CAPs)
To export contexts, proceed as follows:

1. Create a CAP that only includes the contexts you want to export. For details, see "Create a
CAP with the Executive Scorecard application data" on page 246.

2. Export the CAP you created. For details, see "Download a CAP to the user's local system" on
page 237

Note: You can also export contexts using a legacy JMX-based procedure. For details, see
"Export or Import Contexts" on page 349.

Import contexts using Content Acceleration Packs (CAPs)
To import contexts, proceed as follows:

1. Upload the CAP. For details, see "Upload a CAP to the Executive Scorecard application" on
page 234.

2. Activate the CAP inAdmin > Content Acceleration Pack. For details, see "Activate a CAP"
on page 235.

3. Verify the upload by accessing the contexts inAdmin > Semantic Layer. For details, see
"Semantic Layer - Context Designer" on page 170.

Note:

l If the context you import already exists, it is deleted and replaced by the context imported
using the CAP.

l You can also import contexts using a legacy JMX-based procedure. For details, see "Export
or Import Contexts" on page 349.

Add a column to a Target database table and the impact on the context
When you restructure the Target database by adding a column to a table, the corresponding tables
in the relevant Contexts are automatically refreshed. Youmust then proceed as follows:

1. Restructure the Target database by adding a column to a specific table.

The column is automatically and immediately inserted into the corresponding table in the
Context, and the links between the Context tables aremaintained. A new index is not created if
you add a new column directly in the target DB so you have to create an entry for the new
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column accessing by the SQL Studio Manager. The index is located under the table and then
under the columns.

2. If needed, create additional links between the new column and the other tables.

3. If needed, drag the new column into theEntities area.

4. Save the context.

Note:

l If you change the type of a column from a table in the Target database, the formula that
calculates KPIs based on the Context that includes that table, may also be invalid.

l If you change the name of a column from a table in the Target database, the effect is the
same as adding a new column. Refer to the procedure above.

Remove a column from a Target database table and impact on context
When you restructure the Target database by removing a column from a table, the corresponding
tables in the Contexts are automatically refreshed. Youmust then proceed as follows:

1. Remove the index corresponding to the relevant column by accessing the SQL Studio
Manager. The index is located under the table and then under the columns.

2. Remove the relevant column from the table in the Target database.

The column is automatically and immediately removed from the corresponding table in the
Context, and the links between the Context tables aremaintained. The link from this column to
other tables are removed.

3. Remove the column from theEntities area.

4. Save the context.

Note:

l If you remove a column from a table in the Target database, the corresponding column is
automatically and immediately removed from the relevant Context.

l If the columnwas also listed in the Entities thenmake sure to remove it from the Entities as
well before saving and validating themodified context.

l If the column is removed from a table in the Target database, and the Context is not verified,
the formula that calculates KPIs based on the Context, might also be invalid. If the removed
column has a link to another column, the link is also removed
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UI Description
Context Designer Page
The Context Designer page enables you tomanage the Contexts that you create using the Context
Designer feature.

User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI
Element Description

Click to display a list of existing Contexts created in the Context Designer. Select
the relevant Context and click OK.
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Click to create a new Context. The Context Designer Wizard opens. For details, see
below.

Click to open the Import Content wizard. For details, see "Semantic Layer - Data
Loader" on page 200.

Context Designer Wizard
The Context Designer wizard enables you to create a Context with tables, entities, and
relationships. Once you have completed the Context, save it. The Context is then added to the list
of Contexts available in the Studio. The tables that compose the universe are added as variables
and the table columns as variable entities. The variables and entities can be used to calculate the
formulas for the KPIs that are assigned the Context. For details, see KPI or Metric Configuration
and Calculation Details in the IT Executive Scorecard Business Analyst Guide.

Administrator Guide
Contexts and Universes - Semantic Layer

Page 192 of 413HP IT Executive Scorecard (9.41)



This page enables you to configure a Context.

Context Designer Toolbar
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI
Element Description

New. Click to create a new Context.

Save. Click to save the currently opened Context.
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Open. Click to display a list of existing Contexts created in the Context Designer.
Select the relevant Context and click OK.

Add table. Click to add tables in CSV format to the Repository. The data loader
wizard opens. For details, see "Semantic Layer - Context Designer" on page 170.

Click to validate the Context. The validation checks if the name of the Context is
unique, if all the tables in the Context exist in the Repository, andmore.

When you click the Save button, the Context is validated. An invalid Context is
not saved.

Context Area
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI
Element Description

Context
name

The name of the Context.

Limitation: SAP BusinessObjects Enterprise Universe names should not
duplicate Context names, and all names of Universes and Contexts should be
unique.

Note: If you have assigned to a KPI a Context created with the Context
Designer, and then youmodify the Context name in the Context Designer, make
sure that you assign themodified Context to the KPI in the Studio otherwise the
KPI becomes invalid as it uses a Context that does not exist.
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Scheme Area
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Repository Click the button to open the table repository. For details, see
"Repository" on the next page.

<Drag and drop> Select the relevant table in the Repository and drag and drop it in the
Scheme area tomake the table part of the universe.
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UI Element Description

<Create relationships> Select the relevant entity in a table and drag and drop it on the
relevant entity in another table to create the relationship between
these two entities.

Note:

l Double-click a table to shrink it down to its title. Double-
click a shrunk table to expand it.

l To delete a relationship, click it and press theDelete key.

Use the slider to zoom in or out.

Repository
The Repository area enables you to select external or internal tables to add to the Context you are
building.
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User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Click to close the Repository.

External
Tables
(CSV)

Lists the CSV tables that were uploaded using the data loader wizard.

Click the relevant table to display its column details.

Click to add tables in CSV format to the Repository. The data loader wizard
opens. For details, see "Content Loader" on page 202.

Internal
Tables

Lists the tables. Click on the relevant table to display its entities in the Column
details section.

Column
Details

Lists the entities (columns) of the table selected in the Internal Tables section.
Each entity is preceded by an icon indicating the type of entity:

l - date.

l - string.

l - numeric

Entities Area
You drag tables from the Scheme area to the Entities area to add a variable corresponding to the
table to the list of variables available to create the formula for the KPI that is assigned the Context.
The table columns become the variable entities.
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User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI
Element Description

<Drag
and
drop>

Drag and drop a table from themiddle pane to the Entities pane to add the table's
entities and fields to the list of available entities and fields available to be added to a
KPI formula in the Formula Builder. For details, see KPI or Metric Formula in the IT
Executive Scorecard Business Analyst Guide.

<Table
and
columns>

The table that you dragged from the Scheme area to the Entities area is displayed
followed by its columns.

Icons indicate the format of the column.

l - date.

l - string.

l - numeric

The icons to the right of the column enable you to decide to:

l - Enables the auto-completion feature when using this field in a formula, in the
Studio. This feature is not supported for a date field. For details, see Variables in
the IT Executive Scorecard Business Analyst Guide.

l - Enable the creation of a Breakdown for the KPI using this dimension, in the
Studio. This feature is not supported for a date field. For details, see KPI
Breakdowns in the IT Executive Scorecard Business Analyst Guide.

The list of fields that are available for breakdowns is configured in the Context
Designer. By default,numeric fields are not dimensions, therefore they are not
available for breakdowns. If you want them to be available for breakdown, open
the Context Designer and in the Entities area, click to enable the creation of
Breakdowns. For details, see "Semantic Layer - Context Designer" on page 170
in the IT Executive Scorecard Administrator Guide.

Date fields are not available for breakdowns.

Remove Click to remove the selected table or entity.

Reference
For details about the out-of-the-box contexts, see the IT Executive Scorecard Content Reference
Guide relevant for the integration.
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Semantic Layer - Data Loader
The Context Designer feature enables you to create andmanage Contexts (universes). The
Contexts can be based on your target schema tables or on .CSV files that can be uploaded to the
target schema using the Data Loader.

Context Designer can be used to upload data and create contexts based on the data, when you
want to work with the Executive Scorecard and IT Financial Management applications without
using DataWarehouse and SAP BusinessObjects Enterprise. It is a direct way to upload data into
the Executive Scorecard Studio using files without performing integrations to external sources or to
other HP products. It can be used, to integrate third party data, testing, or for Proof of Concept
(POC) sessions. It can also be used as a component of Executive Scorecard to integrate third party
data.

Context Designer provides KPI results based on your real data.

To access:

l In Executive Scorecard, click Admin > Semantic Layer > Semantic Layer. The Context
Management page opens. Click Launch Context Designer and select Import Content. For
details, see "Semantic Layer - Data Loader" above.

l In the Context Designer page, click the Import Content icon in the toolbar to open the
Import wizard.

l In the Context Designer page, in the Repository area, click the Import Content icon to open
the Import wizard.

Section navigation: l "LearnMore" below l "Tasks" on the next page l "UI
Description" on page 202

Learn More
To understandmore about Contexts, see the LearnMore section in "Semantic Layer - Context
Designer" on page 170.

Difference between importing a .csv file to create a context in the Context
Designer and using .csv files as data sources in the Integrated
Development Environment (IDE)
The differences between the two techniques is as follows:

l Context Designer:When you import a .csv file usingAdmin > Context Designer, a Context
based on the structure of the file is created in Context Designer. You can then extend the
context by adding other tables and creating connections. The newly created context can then be
used as a base for KPIs.
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This process is fast and efficient and displays value very quickly. It is recommended for one-
time operations, when the data does not change very often, when you don't need historical
information, or for POCs.

l IDE:When you use a .csv file as the data source in the IDE, you create a content pack and a
basic ETL.

This process is more complex, but providemore flexibility. It is recommended for Production
environments. Because this procedure creates a content pack and uses an ETL, it enables the
use of all the other capabilities of the system. It provides the handling of historical information,
the scheduling of data import from the same .csv file when the file changes periodically, the
creation of Target database tables different from the original .csv table, the connection to other
entities, the splitting of the original .csv table into different tables in the Target database, or the
addition of the original data to other tables in the Target database. In addition, the process
identifies changes and deletions of data, and can handle large amounts of data.

Tasks
Upload Tables in .CSV Format to the Tables Repository
You can upload data into the Studio using .CSV files and without integration to external sources or
to other HP products. It can be used to integrate third party data sources, testing, or for Proof of
Concept (POC) sessions. You can, in the sameway, replace the data in an existing table, or add
data to an existing table when the table has been loaded using a .CSV file.

To upload data from the .CSV file into the Studio:

1. Create the .CSV file containing the data you want to use in the Studio (for
example: latest.CSV).

Recommended:CSV tables should have unique names across all active Content
Acceleration Packs (CAPs). For details on CAPs, see "Create Content Acceleration
Packs" on page 246.

2. In Executive Scorecard, click the Admin > Semantic Layer > Semantic Layer.

3. In the Context Management page, click Launch Context Designer .

4. Click Import Content to open the Import Wizard (data loader). Follow the steps to upload
the .CSV file. For details, see "Semantic Layer - Data Loader" on the previous page.

The file is uploaded. The upload operation saves the changes youmade to the .CSV file. The
new table appears in the External Tables area.

Note: If youmodify a .CSV table, youmust remove the table from the Context, reimport the
table, and recreate the links with the other tables. Alternatively, you can add the column
directly in the Target database.
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UI Description
Content Loader (Import) Wizard
The wizard enables you to upload content.

Content Loader
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User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):
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UI
Element Description

Select
the data
on which
you want
to base
the KPI.

You can use .CSV files as a data source. A .CSV file contains data separated by
commas. Each .CSV file that is uploaded corresponds to a universe with only one
entity. The name of the Context (universe) that is created is the name of the .CSV
file. The names of the columns in the .CSV file (first row of the file) represent the
names of the entity fields. These fields become the variables that can be used to
create the formula that is used to calculate the value of the KPIs or Metrics
associated with the Context.

File Structure
The .CSV file should have a table structure.

Example The following is an example of a .CSV file in CSV format:

MD_BUSINESS_KEY,SLA_NAME,SLA_STATE,SLA_TYPE,DATE_START,DATE_END
SLA01,SLA01,Passed,Corporate,1/1/2011 13:00:00,2/1/2011 19:00:00
SLA02,SLA02,Passed,Corporate,1/2/2011 13:00:00,2/2/2011 19:00:00
SLA03,SLA03,Passed,Corporate,1/3/2011 13:00:00,2/3/2011 19:00:00
SLA03,SLA03,Passed,Corporate,1/3/2011 13:00:00,2/3/2011 19:00:00
SLA04,SLA04,Passed,Corporate,1/4/2011 13:00:00,2/4/2011 19:00:00
SLA13,SLA13,Passed,Corporate,1/3/2011 13:00:00,2/3/2011 19:00:00
SLA14,SLA14,Passed,Corporate,1/6/2011 13:00:00,2/6/2011 19:00:00

Limitations

l Themaximum size of the .CSV file is 20MB. This is configurable using the
Maximum Size of .CSV file (MB) setting inAdmin tab > Scorecard
> XS Settings.

l Themaximum number of characters in an entity field name is 30 characters (an
entity field name is the string between commas in the first row of the .CSV file).

l The entity field names should follow the rules of column titles in the database
(include only alphanumeric characters, and underscore (_)).

l The name of the .CSV file should follow the rules of Context names (include only
alphanumeric characters, and underscores (_)).

Tip:

l The date data obtained from the data sources is automatically reformatted
internally using theYYYY.MM.dd HH:mm:ss (based on 24 hours) format.
All internal calculations are performed using this format.

l If you are using CSV files, you can select the date format in the <Data
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UI
Element Description

upload> wizard. The selected format is automatically reformatted internally
using theYYYY.MM.dd HH:mm:ss (based on 24 hours) format.

l The dates displayed in the application user interface are reformatted
according to the browser locale.

Create a
.CSV File

Hover aboveCSV file template to display an example of a .CSV file structure in
table format that can be uploaded.

Select Action

Administrator Guide
Contexts and Universes - Semantic Layer

Page 205 of 413HP IT Executive Scorecard (9.41)



User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI
Element Description

Upload
a new
table

Select this option if you want to create a new table in the Context Designer using the
information from the .CSV file.

Update
an
existing
table

Select this option if you want to update an external table that already exists in the
Context Designer. When you click this option, the following options are displayed:

l Add data to an existing table. Select this option when you want to add data to
an existing table. The data from the new .CSV file is added at the end of the
existing table. The formats of the two .CSV files must be the same.

l Override the data in an existing table with the new data. Select this option
when you want to replace the data of an existing table with the data of the .CSV
file you are loading The formats of the two .CSV files must be the same.

Select File
This page is displayed when you selected theUpload a new table option:

This page is displayed when you selected theUpdate an existing table option:
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User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI
Element Description

File
Name

Select the .CSV file you want to upload.

Table
Name

If you are loading a new .CSV file, enter the name of the corresponding table.

If you are adding data to an existing external table or if you are replacing the data in an
existing external table, select the relevant table name.

Preview
This page displays the table created from the .CSV file.
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User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

<table> The .CSV file is displayed in the box in table format. If an error message is
displayed (for example some of the values include spaces or unsupported
characters) you canmake the necessary corrections directly in the box:

Select the date
format you
used in the
.CSV file

Select the date format you used in the .CSV file.

Upload Click to upload the .CSV file into the Studio. For details, see "Semantic Layer
- Data Loader" on page 200.
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SAP BusinessObjects Enterprise Contexts
(Universes)

A KPI or Metric Context (universe) represents a global business facet related to the aspect of
business the KPI or Metric represents. For example, the% of Assets in Maintenance
KPI represents one aspect of the AssetManagement universe.

You can add a Context to the Studio and the XS engine and attach KPIs or Metrics to the new
Context in the Studio.

Section navigation:  l "Tasks" below l "Reference: Universe Creation Guidelines" on
the next page

Tasks
This section includes:

"Add a Context to Executive Studio using Context Designer" below

"Add a Context to Executive Studio using BO" below

Add a Context to Executive Studio using Context Designer
You can create new Contexts, using Context Designer. For details, see "Semantic Layer - Context
Designer" on page 170 in the IT Executive Scorecard Administrator Guide.

If you have SAP BusinessObjects Enterprise installed, you can also create Contexts (Universes)
 using BOE. Once you are done youmust add these Contexts to the Studio.

Add a Context to Executive Studio using BO

1. Make sure you havemodeled the data structure in your database.

2. Add the universe using the BO Designer according to the Universe Creation Guidelines. For
details, see "Reference: Universe Creation Guidelines" on the next page.

3. Export the universe to the XS_Studio folder in your BOCMS (Central Management Server)
using the BODesigner .

4. To load the universe to the Studio library you can do one of the following:
n Run the JMX reloadmetadata.

i. Make sure you have JDK installed.

ii. Run jconsole in theStartmenu.

iii. In the window that opens, select theRemote Process option, enter <host_
name>:<port_number> and click Connect.
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iv. After the application completes its loading, click theMBeans tab.

v. Click com.hp.btoa.studio.jmx.

vi. Click loadMetaData.

n Note that if you do not click loadMetaData, the change will be performed by an automatic
update after 24 hours or 7 days depending on your configuration. You canmodify the
configuration using theMeta Data reload rate (Days) parameter in theXS Settings section
of the Admin Tab. For details, see "XS Settings" on page 160.

5. You can now design active or template entities, create the formulas and filters for the KPIs or
Metrics, andmore.

Reference: Universe Creation Guidelines
This section explains how you can create Universes that can be used by the HP IT Executive
Scorecard Studio and the XS Engine.

Guidelines

1. Folders represent the name of the entity that is presented.

2. Classes in the folder represent the attributes of that entity.

3. Classes should be of type Date, String, or Numeric.

4. Entities (represented by folders) in the same universemust have a relationship between them.

5. Hierarchical relationships should be flattened to attributes (Level1, Level2, …). These
relationships can be defined in a joined table.

Limitations

1. No current support for folders within folders or other hierarchies.

2. Ensure that there aren’t multiple joins between entities represented in the Universe (This is a
Universe limitation). Use aliases to copy.

3. Folder names should be unique.

4. Count, in a formula, can only be performed on Numeric and String fields.

5. Conditions on objects not supported.

6. Details on objects not supported.

7. Do not put mappings in the universe – where fields are translated from the value in the
database to the value that the universe returns.
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Field Types

l Dimensions
n Fields that can be broken down per KPIs or Metrics should bemarked as Dimensions – see

the topmark in the figure below.

n If the field can only have a limited set of values, then turn on the List of Values field below –
see the secondmark in the figure below. The studio will only show the first 100 values.

n Warning - this should only be turned on for fields that have a small set of values – all the
values will be loaded intomemory in the studio.

l Measures
n Fields that are only used as measures in KPI or Metric formulas should bemarked as

Measures. Make sure to configure as in figure below.
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Contexts and KPIs-Related Reports
You can add components to a page in Dashboard to provide reports about the KPI templates
currently in the KPIs Library, Contexts currently in Executive Scorecard, the structure of Contexts,
the list of KPIs included in a Context, and a list of the fields with names include a specific string that
are part of a Context, or that are used in a specific KPI formula.

To access:

1. In the Executive Dashboard, click theNew Page button in the Dashboard toolbar.

2. If needed, configure the page that opens. For details, see Configure a Page Layout in the IT
Executive Scorecard Business Analyst Guide.

3. Click theComponents button.

4. In the Component Gallery page that opens, double-click theWeb Intelligence Static Report
Viewer component to place it in the layout area, or select the component and drag it to an area
on the page, and close the Component Gallery page.

Tasks
This section includes:

"Change the Connection to the Target DB" below

"View the List of KPI Templates Currently in the KPIs Library" on the next page

"View a list of the Contexts and to view aContext structure" on page 215

"View a list of the KPIs of a selected Context" on page 217

"Search for a field in Contexts or in KPI Formulas" on page 220

"Display the trees of KPIs in the KPIs Library" on page 221

"Setting the report so it displays data in theWeb Intelligence Dynamic or Static Report Viewer
component" on page 222

Change the Connection to the Target DB
You can change the connection of a Context to a specific Target database.

To change the connection to the Target database:

1. Access glassfish using <XS_server_name>:10001/common/index.jsf
a. In Common Tasks, select Resources > JDBC > JDBC Connections

> TargetDbConnectionPool

b. Click theAdditional Properties tab and change the URL of the Target Schema in the
URL field using the following format: jdbc:mercury:sqlserver:<XS_server_
name>:1433;databaseName=<Target_schema_name>
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c. Change the name of the Target database in the databaseName field.

d. Click Save.

2. In Microsoft SQL Server Management Studio, access XS Manage DB, and open
dbo.TENANT_SCHEMA, change theHOST_NAME andDB_NAME of the Target Database,
and click Save.

View the List of KPI Templates Currently in the KPIs Library
You can view a list of the KPI templates and their Context that are currently in the KPIs Library
pane. The Contexts can have been defined either in SAP BusinessObjects or in the Context
Designer. You can also view amore detailed list of KPIs (Context, Business Question, Formula,
Data Source, Thresholds, andmore):

Note: If you delete a KPI in the list of KPI templates, the list of KPIs displayed in the
components reflects the deletion.

1. In the Executive Dashboard, click theNew Page button in the Dashboard toolbar.

2. If needed, configure the page that opens. For details, see Configure a Page Layout in the IT
Executive Scorecard Business Analyst Guide.

3. Click theComponents button.

4. In the Component Gallery page that opens, double-click theWeb Intelligence Dynamic Report
Viewer component to place it in the layout area, or select the component and drag it to an area
on the page, and close the Component Gallery page.

5. In the component, click theConfigure Component button:
a. In theWeb Intelligence Dynamic Report Viewer Filter dialog box that opens, select:

i. TheKPI Templates report to view the list of the KPI templates that are currently in
the KPIs Library pane and basic information about the KPI template.
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ii. TheKPI Template Details report to view the list of the KPI templates that are
currently in the KPIs Library pane, and details about their Context, Data Source,
Business Question, Formula, Thresholds, andmore.

b. Click OK.

6. To view data in the component in the Dashboard page, click the Refresh button in the report
toolbar.

View a list of the Contexts and to view a Context structure
You can view a list of the Contexts currently defined in the Context Designer in Executive
Scorecard. The Contexts have been defined in the Context Designer.You can also display the
structure of the fields and tables that are included in a selected Context:

Administrator Guide
Contexts and Universes - Semantic Layer

Page 215 of 413HP IT Executive Scorecard (9.41)



Note: If you create your ownContext in the Context Designer, the Context appears in the list
of Contexts displayed by the component. For details on the Context Designer, see "Semantic
Layer - Context Designer" on page 170.

1. In the Executive Dashboard, click theNew Page button in the Dashboard toolbar.

2. If needed, configure the page that opens. For details, see Configure a Page Layout in the IT
Executive Scorecard Business Analyst Guide.

3. Click theComponents button.

4. In the Component Gallery page that opens, double-click theWeb Intelligence Dynamic Report
Viewer component to place it in the layout area, or select the component and drag it to an area
on the page, and close the Component Gallery page.
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5. In the component, click theConfigure Component button:
a. In theWeb Intelligence Dynamic Report Viewer Filter dialog box that opens, select:

i. TheContext Summary report to view the list of the Contexts currently defined in the
Context Designer in Executive Scorecard.

ii. TheContext Summary Details report to view the tables and fields that are included
in the selected Context. The user running the report is prompted to select a specific
Context. The prompt is optional.

b. Click OK.

6. To view data in the component in the Dashboard page, click the Refresh button in the report
toolbar.

View a list of the KPIs of a selected Context
You can view a list of the KPIs of a selected Context. The Contexts can have been defined either in
SAP BusinessObjects or in the Context Designer.

1. In the Executive Dashboard, click theNew Page button in the Dashboard toolbar.

2. If needed, configure the page that opens. For details, see Configure a Page Layout in the IT
Executive Scorecard Business Analyst Guide.

3. Click theComponents button.

4. In the Component Gallery page that opens, double-click theWeb Intelligence Dynamic Report
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Viewer component to place it in the layout area, or select the component and drag it to an area
on the page, and close the Component Gallery page.

5. In the component, click theConfigure Component button.

6. In theWeb Intelligence Dynamic Report Viewer Filter dialog box that opens, select theKPIs
per Context report to view the list of the KPIs of a selected Contexts currently defined in the
Context Designer in Executive Scorecard. The user running the report is prompted to select a
specific Context. The prompt is optional.

In table format:
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In graph format:

7. Click OK.

8. To view data in the component in the Dashboard page, click the Refresh button in the report
toolbar.

Search for a field in Contexts or in KPI Formulas
You can display a list of fields whose names include the specified string and the Contexts that
include these fields. The Contexts can have been defined either in SAP BusinessObjects or in the
Context Designer. You can also display a list of fields whose names include the specified string
and the KPIs whose formulas include these fields:

1. In the Executive Dashboard, click theNew Page button in the Dashboard toolbar.

2. If needed, configure the page that opens. For details, see Configure a Page Layout in the IT
Executive Scorecard Business Analyst Guide.

3. Click theComponents button.

4. In the Component Gallery page that opens, double-click theWeb Intelligence Dynamic Report
Viewer component to place it in the layout area, or select the component and drag it to an area
on the page, and close the Component Gallery page.
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5. In the component, click theConfigure Component button:
a. In theWeb Intelligence Dynamic Report Viewer Filter dialog box that opens, select:

i. The Field in Context report to display a list of fields whose names include the
specified string and the Contexts that include these fields. The user running the report
is prompted to select a specific Context. The prompt is optional.

ii. The Fields in KPI Name or Formula report to view a list of fields whose names
include the specified string and the KPIs whose formulas include these fields. The
user running the report is prompted to select a specific Context. The prompt is
optional.

b. Click OK.

6. To view data in the component in the Dashboard page, click the Refresh button in the report
toolbar.

Display the trees of KPIs in the KPIs Library
You can display the list of hierarchy trees of KPIs (templates) in the KPIs Library, with their
Scorecards, Perspectives, Objectives, and KPIs. The KPI Contexts can have been defined either
in SAP BusinessObjects or in the Context Designer.

1. In the Executive Dashboard, click theNew Page button in the Dashboard toolbar.

2. If needed, configure the page that opens. For details, see Configure a Page Layout in the IT
Executive Scorecard Business Analyst Guide.

3. Click theComponents button.

4. In the Component Gallery page that opens, double-click theWeb Intelligence Dynamic Report
Viewer component to place it in the layout area, or select the component and drag it to an area
on the page, and close the Component Gallery page.

5. In the component, click theConfigure Component button.

6. In theWeb Intelligence Dynamic Report Viewer Filter dialog box that opens, select theKPI
Tree Hierarchy report to display the list of hierarchy trees of KPIs in the KPIs Library, with
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their Scorecards, Perspectives, Objectives, and KPIs.

7. Click OK.

8. To view data in the component in the Dashboard page, click the Refresh button in the report
toolbar.

Setting the report so it displays data in the Web Intelligence Dynamic or
Static Report Viewer component

Note: Use theWeb Intelligence Dynamic Report Viewer component when you want the report
to display the report in table format and in graphic format (where the report can be displayed in
graphic format). If you want the report to display only in graphic format you can also use aWeb
Intelligence Static Report Viewer component, but in this case youmust make sure that the
report is scheduled as explained below).

To configure theWeb Intelligence Dynamic or Static Report Viewer components so they display
information when the component is part of a Dashboard page, select one of the following options:

l "Contexts and KPIs-Related Reports" on page 213

l " Press the refresh button when importing the report to the page" on page 224

l "Schedule the report" on page 224

Set the report properties to be ‘Refresh on open’
This option works with aWeb Intelligence Dynamic Report Viewer component or with aWeb
Intelligence Static Report Viewer component. When the Dashboard page where the component is
included, is displayed, the component is automatically refreshed.

1. Click the Start menu and select All Programs > BusinessObjects XI 3.1 >
BusinessObjects Enterprise > Web Intelligence Rich Client.
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2. Log on to the server, import the report from the CMS, and save it.

3. Select theRefresh on open option.
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4. Click Save and export the report to back to the CMS (public folder > Studio Analysis).

Press the refresh button when importing the report to the page
This option works with aWeb Intelligence Dynamic Report Viewer component. When the
Dashboard page where the component is included, is displayed, the component is not automatically
refreshed and does not display data. Youmust click the Refresh button in the report toolbar to
refresh the display and display data.

Schedule the report
This option works with aWeb Intelligence Dynamic Report Viewer component or with aWeb
Intelligence Static Report Viewer component. When the Dashboard page where the component is
included, is displayed, the component automatically displays the latest scheduled data.

1.  Click the Start menu and select All Programs > BusinessObjects XI 3.1 >
BusinessObjects Enterprise > Web Intelligence Rich Client.

2. Log on to the Central Management Console.
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3. Choose theRecurrence type from the list and click Schedule.

Administrator Guide
Contexts and Universes - Semantic Layer

Page 225 of 413HP IT Executive Scorecard (9.41)



Once you have a single instance of the report, you can then review the data in the report.
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Import or Export Contexts, Data, KPIs, Metrics,
Trees, Pages, or Components

You can import or export complete trees (with their Scorecards, Perspectives, Objectives, and
KPIs), Unassigned KPIs, Metrics from the Active KPIs pane, as well as user-defined pages or
components.

The import or export flows aremeant to be used whenmoving from staging to production and not as
a way to update system configuration. If you want to use the import or export flows to update the
system configuration, youmust delete all the nodes in the active KPIs pane, before performing the
import operation. . For details, see "Migrate from Development or Test Environment to Production"
on page 290.

The export and import flows are alsomeant to be used for localization purposes, when you want to
work with other languages than English. For details, see "Localization andGlobalization" on page
281.

To export or import the items listed above, you can use the Content Acceleration Pack (CAP)
feature. You can export or import:

l Contexts. For details, see "Migrate contexts " on page 296.

l Data imported using .CSV files. For details, see "Migrate Data Imported using .CSV files" on
page 297.

l Trees of their Scorecards, Perspectives, Objectives, and KPIs, Unassigned KPIs, andMetrics.
For details, see "Migrate Trees, Metrics, and Unassigned KPIs" on page 298.

l User-defined pages or components. For details, see "Migrate User-defined Pages or
Components" on page 301.

Note: You canmigrate Contexts, trees, KPIs, Metrics, user-defined pages, or components
using one CAP per type of item or one CAP for all the items you want to export/import/migrate.

Reference: Contexts (Universes)
HP IT Executive Scorecards includes out-of-the-box Context (universes) that correspond to
specific aspects of the business.The entities in these Contexts are IT DataModel-compliant. For
details about IT DataModel, see IT DataModel in the IT Executive Scorecard Business Analyst
Guide.

Section navigation:  l "LearnMore" on the next page l "Tasks" on the next page l ""
on the next page
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Learn More
IT Executive Scorecard Universe Created using SAP BusinessObjects
Enterprise
A SAP BusinessObjects Enterprise Context (universe) represents a business universe.

A Context is a set of entities. Each entity is a set of fields. Each field can be a dimension, measure,
or fact. It can bemeasured.

A formula calculates, for a specified time period, using the values of specific entities, a value that
represents a specific aspect of the business. The value is given to a Key Performance Indicator
(KPI). The KPI represents the specific aspect of the business.

Each universe includes some KPIs. The KPIs are the building blocks of the Studio and the
KPI engine.

The universe entity relationship diagrams (ERDs) are logical views of the universe datamodels.
The ERDs are interactive and contain details about the tables and classes used in the universe.

Tasks
Plan the integration of the relevant data sources and the activation of the
corresponding Content Packs
Proceed as follows:

1. Learn about KPIs andMetrics (KPIs andMetrics in the IT Executive Scorecard Business
Analyst Guide).

2. Consult the list of KPIs andMetrics ( the KPI Library in Excel format - you can sort the list
according to the business context).

This document is available in the PDFs directory in the Installation DVD, is accessible from
the Help Center page in the online Help Center (documentation library), or from the HP
Software Product Manual Site (http://h20230.www2.hp.com/selfsolve/manuals).

3. Learn about the KPIs or Metrics and their relation to Contexts ("SAP BusinessObjects
Enterprise Contexts (Universes)" on page 209 in the IT Executive Scorecard Business Analyst
Guide).

4. Understand the structure of the Contexts. "IT Executive Scorecard Universe Created using
SAP BusinessObjects Enterprise" above and the links to the Contexts in the table below.

5. Consult the list below to understand the link between the Context and the data source.

Data Sources Corresponding to Contexts
This section lists the Contexts (universes) and their data sources (Content Packs)
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l ALM_Defect Context in the IT Executive Scorecard Content ReferenceGuide for the Integration
of HP Application Lifecycle Management.

l ALM Requirement Context in the IT Executive Scorecard Content ReferenceGuide for the
Integration of HP Application Lifecycle Management.

l ALM Test Context in the IT Executive Scorecard Content ReferenceGuide for the Integration of
HP Application Lifecycle Management.

l ApplicationPerformance Context in the IT Executive Scorecard Content ReferenceGuide for the
Integration of HP Business ServiceManagement.

l ApplicationPortfolioManagement Context in the IT Executive Scorecard Content Reference
Guide for the Integration of HP Business ServiceManagement.

l Asset Management Context in the IT Executive Scorecard Content ReferenceGuide for the
Integration of HP Asset Manager.

l Availability Management Context in the IT Executive Scorecard Content ReferenceGuide for
the Integration of HP Business ServiceManagement.

l ChangeManagement Context in the IT Executive Scorecard Content ReferenceGuide for the
Integration of HP ServiceManager.

l CloudOptimization Context in the IT Executive Scorecard Content ReferenceGuide for the
Integration of HP Cloud Service Automation, IT Executive Scorecard Content ReferenceGuide
for the Integration of AmazonWeb Services, IT Executive Scorecard Content ReferenceGuide
for the Integration of vCenter Chargeback Manager, or IT Executive Scorecard Content
ReferenceGuide for the Integration of AmazonWeb Service CloudWatch.

l DataProtection Context in the IT Executive Scorecard Content ReferenceGuide for the
Integration of HP Data Protector.

l Financial Management Context in the IT Executive Scorecard Content ReferenceGuide for the
Integration of HP Project and Portfolio Management.

l Incident Management Context in the IT Executive Scorecard Content ReferenceGuide for the
Integration of HP ServiceManager.

l NetworkNodeManager Context in the IT Executive Scorecard Content ReferenceGuide for the
Integration of HP Network Automation.

l OrchestrationAutomation Context in the IT Executive Scorecard Content ReferenceGuidefor
the Integration of HP Operation Orchestration.

l PolicyCompliance Context in the IT Executive Scorecard Content ReferenceGuide for the
Integration of HP Network Automation

l PolicyRemediation Context in the IT Executive Scorecard Content ReferenceGuide for the
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Integration of HP Server Automation or IT Executive Scorecard Content ReferenceGuide for the
Integration of HP Network Automation.

l PowerManagement Context in the IT Executive Scorecard Content ReferenceGuide for the
Integration of HP Insight Control.

l Project Portfolio Management (PPM) Context in the IT Executive Scorecard Content Reference
Guide for the Integration of HP Project and Portfolio Management.

l RequestManagement (DemandManagement) Context in the IT Executive Scorecard Content
ReferenceGuide for the Integration of HP Universal ConfigurationManagement Database.

l Service Desk Management Context in the IT Executive Scorecard Content ReferenceGuide for
the Integration of HP ServiceManager.

l Service Level Management Context in the IT Executive Scorecard Content ReferenceGuide for
the Integration of HP Business ServiceManagement or IT Executive Scorecard Content
ReferenceGuide for the Integration of HP ServiceManager.

l StorageManagement Context in the IT Executive Scorecard Content ReferenceGuide for the
Integration of HP Storage Essentials and IT Executive Scorecard Content ReferenceGuide for
the Integration of HP Business ServiceManagement.

Note: The Period ( Period Context) does not have a corresponding external data source.
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Content Acceleration Pack (CAP)
Management

Content Acceleration Packs (CAPs) are ready-to-import packages that include Dashboard pages
that display Scorecards and components, KPIs, Metrics, Contexts (universes), data (.CSV files),
and documentation for the CAP.

CAPs describe typical stories that show how correct implementation of Executive Scorecard drives
Performance Improvement and Cost Reduction for the IT organization. CAPs demonstrate
Executive Scorecard capabilities, and helps you add basic elements that can be used to customize
your Dashboard.

This section includes:

Content Acceleration Pack 232

Create Content Acceleration Packs 246

CAPs Automatic Anti Virus Scans 256

Migrate a CAP to XS 257

Data Files (.CSV Tables) 258
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Content Acceleration Pack
Content Acceleration Packs (CAPs) are ready-to-import packages that include Dashboard pages
that display Scorecards and components, KPIs, Metrics, Contexts (universes), data (.CSV files),
and documentation for the CAP.

CAPs describe typical stories that show how correct implementation of Executive Scorecard drives
Performance Improvement and Cost Reduction for the IT organization. CAPs demonstrate
Executive Scorecard capabilities, and helps you add basic elements that can be used to customize
your Dashboard.

To access:
Click Admin > Content Acceleration Pack > Content Acceleration Pack

Section navigation:  l "LearnMore" below l "Tasks" on page 234 l "UI Description"
on page 238

Learn More
Content Acceleration Pack Contents
The Content Acceleration Pack ZIP file includes the following folders:

l data - contains the .CSV files. The name of the .CSV files to be uploaded provide data for the
Content Acceleration Pack KPIs andMetrics. For details, see "Semantic Layer - Context
Designer" on page 170.

l kpi - contains the .XML files that correspond to KPIs and Scorecards. The KPIs and Scorecards
are imported into the Studio Active KPIs pane. The Scorecards and relevant KPIs are also
displayed in the Dashboard pages after the calculation completes and the relevant page is
loaded. For details, see "Content Acceleration Pack" above.

l uim- contains:

n Components folder - contains the .XML files that correspond to the components that you can
add to a page.

n Pages folder - contains the .XML files that describe the pages that are included in the CAP.
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You import the components, events, and pages into the Dashboard where they are used to
build the Dashboard pages. For details, see "Content Acceleration Pack" on the previous
page.

l universe folder- contains the .XML files that correspond to the Business Contexts (universes).
The Content Acceleration Pack installation automatically installs the Business Contexts.

l <CAP_documentation> - the PDF orMicrosoft Word document that describes the CAP.

l manifest.properties file - includes information about the following items:

n UUID. A unique ID for the Content Acceleration Pack.

n Name. The name of the Content Acceleration Pack. Mandatory.

n BCs. The names of the Business Contexts to be calculated (comma separated).

n Description. The description of the Content Acceleration Pack. Optional

n recalculate.date. The start date of the recalculation. Recalculation is started automatically
when you activate the CAP.

n bo.in.use.

o false - The Content Acceleration Pack contents do not include SAP BusinessObjects
Enterprise reports.

o true - The Content Acceleration Pack contents include SAP BusinessObjects Enterprise
reports.

n version. The version of the Content Acceleration Pack.

n publisher. The name of the creator of the CAP. It can be a single user, an HP partner, or a
group in your organization.

n xs.version. The version of Executive Scorecard

Out-of-the-box Content Acceleration Packs
VP of Operations Content Acceleration Pack in theVP of Operations Content Acceleration Pack
Guide

VP of Applications Content Acceleration Pack in theVP of Applications Content Acceleration Pack
Guide

Security Enterprise Architecture Content Acceleration Pack in theSecurity Enterprise Architecture
Content Acceleration Pack Guide

CloudOptimization Content Acceleration Pack in theCloudOptimization Content Acceleration
Pack Guide
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Tasks
This section includes:

"View the available CAPs" below

"Upload a CAP to the Executive Scorecard application" below

"Upload a localized CAP" on the next page

"Activate a CAP" on the next page

"Deactivate a CAP" on page 236

"Delete a CAP from the Executive Scorecard application" on page 236

"Download a CAP to the user's local system" on page 237

"Create a CAP from the Executive Scorecard application data" on page 237

"Modify a CAP" on page 238

View the available CAPs
To view a list of all the CAPs available in the system:

1. In Executive Scorecard, click Admin > Content Acceleration Pack.

The page displays the list of available CAPs. For details, see "CAP Management Page" on
page 238.

2. You can now manage (create, upload, delete, download, activate, and deactivate) the CAPs.

Upload a CAP to the Executive Scorecard application
To upload a CAP to the Executive Scorecard application:

1. Prerequisites:

n The .ZIP file of the CAP you want to upload is copied in an accessible file system.

n A corresponding CAP (with the sameUUID) does not already exist in the Executive
Scorecard application.

2. In Executive Scorecard, click Admin > Content Acceleration Pack..

The page displays the list of available CAPs.

3. Click to open a browser dialog box where you can select the relevant .ZIP file corresponding
to CAP you want to upload .

4. Check theActivate CAP after upload checkbox if you want to activate the CAP
automatically when the upload is completed.

You can now activate the CAP. For details, see "Activate a CAP" on the next page.
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Upload a localized CAP
To upload localized CAPs:

1. Delete the pre-imported out-of-the-box CAPs in the English language.

2. Upload the localized CAPS:

n Localized out-of-the-box CAP. To upload a localized out-of-the-box CAP, proceed as
described in "Upload a CAP to the Executive Scorecard application" on the previous page
and specify the location of the out-of-the-box CAP.

Note: Localized out-of-the-box CAPs .ZIP files are placed in the relevant language
folder during installation:
..\HPXS\agora\glassfish\glassfish\domains\BTOA\config\cap\import\languages

For example, the VPOPS CAP in German is located at:
..\HPXS\agora\glassfish\glassfish\domains\btoa\config\cap\import\languages\d
e_DE\VPOPS_de_DE.zip

n Localized user-defined CAP. To upload a localized user-defined CAP proceed as
described in "Upload a CAP to the Executive Scorecard application" on the previous page
and specify the location of the localized CAP you have created.

Activate a CAP
When you activate a CAP, all the content of the CAP is added to current data (Contexts, KPIs,
Pages, etc.) and a recalculation is performed according to the CAP definitions.

To activate a CAP:

1. Prerequisites:

The CAP is in the list of available CAPs and is not activated.

2. In Executive Scorecard, click Admin > Content Acceleration Pack..

The page displays the list of available CAPs.

3. Select the relevant CAP and click Activate.

You get a notification that the CAP is being activated. Click Yes to complete the Activation. It
takes a few minutes.

If a CAP that shares the same content was already activated, an alert warns you that
activating the new CAP will override the overlapping instances.

Once the activation is complete, an indication is added to the CAP.
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4. You can now:

n View the Business Context details in Context Designer. For details, see "Semantic Layer -
Context Designer" on page 170.

n View and expand the Scorecard tree in the Active KPIs pane. For details, see Activate
Scorecards, Perspectives, Objectives, Metrics, or KPIs Using Templates in the IT
Executive Scorecard Business Analyst Guide.

n View the Scorecard, and KPIs configuration in the Configuration Details, and Calculation
Details tabs. For details, see Configure a Scorecard or Configure a KPI or aMetric in the IT
Executive Scorecard Business Analyst Guide.

n View the Content Acceleration Pack page in Dashboard. For details, seeManage Page
Categoriesin the IT Executive Scorecard Business Analyst Guide.

n View information in Explorer. For details, see View and Analyze Results in the Explorer
Pagein the IT Executive Scorecard Business Analyst Guide.

Deactivate a CAP
When you deactivate a CAP, all the content of the CAP is deleted.

To deactivate a CAP:

1. Prerequisites:

The CAP is in the list of available CAPs and is activated.

2. In Executive Scorecard, click Admin > Content Acceleration Pack..

The page displays the list of available CAPs.

3. Select the relevant CAP and click Deactivate.

If the CAP is activated amessage is issued to task you to deactivate the CAP before you can
delete it.

You get a notification that the CAP is being deactivated.

Once the deactivation is complete, an indication is added to the CAP.

Note: You are notified that the deactivation of a CAP may cause errors in pages and KPIs
using this CAP content. All the CAP entities will be deleted if you acknowledge the
warning.

Delete a CAP from the Executive Scorecard application
When you delete a CAP, the CAP is deleted from the Executive Scorecard server and is not listed
in the list of CAPs any more.
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To delete a CAP:

1. Prerequisites: The CAP is in the list of available CAPs and is not activated.

2. In Executive Scorecard, click Admin > Content Acceleration Pack.

3. Select Content Acceleration.

The page displays the list of available CAPs.

4. Select the relevant CAP and click .

Once the deletion is complete, the CAP is removed from the list of available CAPs.

Download a CAP to the user's local system
To download a CAP and save it to the local system to be used in other environments:

1. In Executive Scorecard, click Admin > Content Acceleration Pack tab.

2. Select Content Acceleration.

The page displays the list of available CAPs.

3. Click to open a browser dialog box where you can select where you want to download the
CAP.

The CAP .ZIP file is saved at that location.

Create a CAP from the Executive Scorecard application data
You can create a new CAP that includes existing Contexts, Scorecards, KPIs andMetrics, and
Dashboard pages.

1. Before creating the CAP, make sure you have already created all the relevant Scorecards,
KPIs, Metrics, Pages and Contexts that you wish to include in the CAP and that they have
been calculated with the expected results. If you find that some content is missing, go back
and create it. Once this is done, you can start creating the CAP.

2. In Executive Scorecard, click Admin > Content Acceleration Pack.

The page displays the list of available CAPs.

3. Click to open a wizard where you can create the CAP. For details, see "Create Content
Acceleration Packs" on page 246.
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Modify a CAP
Tomodify an existing CAP, it is recommended to create a new CAP with the relevant content and
then to delete the existing CAP.

1. In Executive Scorecard, click Admin > Content Acceleration Pack.

The page displays the list of available CAPs.

2. Click to open a wizard where you can create the CAP. For details, see "Create Content
Acceleration Packs" on page 246.

3. After you have created the new CAP, remove the old CAP.

UI Description
CAP Management Page

List of CAPs area
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI
Element Description

Click to create a new Content Acceleration Pack. The Create CAPs wizard opens.
For details, see "Create Content Acceleration Packs" on page 246.
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Click to upload a .ZIP file from the file system to the Executive Scorecard application.
A dialog box opens to enables you to browse to locate the .ZIP file.

Before clicking the buttonmake sure that:

l The .ZIP file of the CAP you want to upload is copied in an accessible file system.

l A corresponding CAP (with the sameUUID) does not already exist in the
Executive Scorecard application.

Select Activate CAP after upload to automatically activate the CAP after it
completes its upload.

Click to download the .ZIP file corresponding to the selected Content Acceleration
Pack to the file system.

During the creation of a CAP using the wizard, all the contents of the CAP are
automatically saved in a .ZIP file.

Click to delete the corresponding Content Acceleration Pack.

Before your click the button, make sure that:

The CAP is in the list of available CAPs and is not activated.
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View by Filter the available Content Packs by their status:

l All. All statuses.

l Activated. Displays the activated Content Packs. Activated Content Packs are
indicated by .

l Deactivated. Displays the deactivated Content Packs. Deactivated Content
Packs are indicated by .

l Activating. Displays the Content Packs that are in the process of being activated.
Activating Content Packs are indicated by .

l Deactivating. Displays the Content Packs that are in the process of being
deactivated. Deactivating Content Packs are indicated by .

<List of
CAPs>

The list of available CAPs within the Executive Scorecard server.

CAP Description area
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

<CAP name> The name of the Content Acceleration Pack.

The standard characters are supported: a-z,A-Z,and 0-9.

Description The description of the Content Acceleration Pack.

The standard characters are supported: a-z,A-Z,and 0-9.

Note: Only the beginning of the description in displayed in this field
(1000 characters). To view the complete description of the CAP,
click theOpen documentation file link.
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Click to activate or deactivate the Content Acceleration Pack.

Note: If the Content Acceleration Pack is already activated the
Deactivate button is displayed and vice-versa.

l When you click , the system scans the
CAP entities (Pages, Scorecards, KPIs, Metrics, Contexts, and
data (in .CSV table format)). If such entities already exist in the
system because they are part of an activated CAP, a warning is
issued so the user can select to continue the activation or not.
Note that when the CAP is activated, its entities override the
entities already activated in the application (not the templates).

l When you click , the system removes the
CAP entities (Pages, Scorecards, KPIs, Metrics, user-defined
Contexts, and data (in .CSV table format)) except for the
Contexts that are out-of-the-box.

Open
documentation file

Click to display a detailed description of the Content Acceleration Pack.

Recalculate date The date from when the CAP's Business Contexts are recalculated when
the CAP is activated.

BO in use Yes. The CAP comprises a page or a KPI that includes SAP
BusinessObjects Enterprise elements.

No. The CAP does not comprise a page or a KPI that includes SAP
BusinessObjects Enterprise elements.

Author The user, partner, or company that created the CAP.

XS Version The version of HP IT Executive Scorecard used when the CAP was
created.

Version The version of the CAP.

Activation date
Deactivation date

The date when the CAP was activated, deactivated, or created.

CAP Description area
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description
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Pages The list of pages included in the Content Acceleration Pack.

Scorecards The list of Scorecards included in the Content Acceleration Pack.

Select a Scorecard and click the button to display the Name and
Description of the selected Scorecard in the XS Active Configuration
tree.

Note: The name of the entity in the dialog box might be different from
the name in the CAP Management list if the entity namewas
modified in the Studio or if duplicate entity names were discovered
during the CAP activation.
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Business Contexts The list of Business Contexts included in the Content Acceleration Pack.

The area displays the following information:

l - In the recalculation status column, indicates that the
corresponding Business Context needs to be recalculated.

l Type. In this column, the icon indicates that:

n The CAP's Business Context is out-of-the-box (it is provided
with the application).

n The CAP's Business Context is user-defined.

l Name. The name of the Business Context.
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KPIs and Metrics The list of KPIs andMetrics included in the CAP.

Select a KPI or Metric and click the button to display the current
Name, and Description of the selected KPI or Metric (as specified in the
current definition in the Studio). The button is activated only for the KPIs
that are included in activated CAPs.

Note: The name of the entity in the dialog box might be different from
the name in the CAP Management list if the entity namewas
modified in the Studio or if duplicate entity names were discovered
during the CAP activation.
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Data (CSV Tables)
dat

Click to display the list of all the CSV tables that compose all the
Business Context in the Data (CSV Tables).

Reference
For details about the out-of-the-box CAPs, see one of the following:

l VP of Applications Content Acceleration Pack in theVP of Applications Content Acceleration
Pack Guide

l VP of Operations Content Acceleration Pack in theVP of Operations Content Acceleration Pack
Guide

l Security Enterprise Architecture Content Acceleration Pack in theSecurity Enterprise
Architecture Content Acceleration Pack Guide

l CloudOptimization Content Acceleration Pack in theCloudOptimization Content Acceleration
Pack Guide
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Create Content Acceleration Packs
Content Acceleration Packs (CAPs) are ready-to-import packages that include Dashboard pages
that display Scorecards and components, KPIs, Metrics, Contexts (universes), data (.CSV files),
and documentation for the CAP.

CAPs describe typical stories that show how correct implementation of Executive Scorecard drives
Performance Improvement and Cost Reduction for the IT organization. CAPs demonstrate
Executive Scorecard capabilities, and helps you add basic elements that can be used to customize
your Dashboard.

To access:
Click Admin > Content Acceleration Pack, and then click to open a wizard where you can
create the CAP.

Section navigation:  l "LearnMore" below l "Tasks" below l "UI Description" on the
next page

Learn More
For details about the Content Accelerations (CAPs) contents, see "Content Acceleration Pack
Contents" on page 232.

Tasks
Create a CAP with the Executive Scorecard application data
You can create a new CAP that includes existing Contexts, Scorecards, KPIs andMetrics, Data
(via .CSV files), and Dashboard pages.

1. Prerequisite: Before creating the CAP, make sure you have already created all the relevant
Scorecards, KPIs , Metrics, Pages and Contexts that you wish to include in the CAP and that
they have been calculated with the expected results. If you find that some content is missing,
go back and create it. Once this is done. you can start creating the CAP.

2. In Executive Scorecard, click Admin > Content Acceleration Pack.

The page displays the list of available CAPs.

3. Click theCreate a new CAP button to open the Create Content Acceleration Pack wizard
where you can create the CAP.

Click Next and specify the CAP name, author, version, description, recalculation date and link
to any relevant document.

Click Next and in theSelect Pageswizard page, select the pages you want to include in this
CAP.
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Note: Once you have selected a Page, the Scorecards, KPIs, andMetrics that are
included in that page and the Contexts that are assigned to the KPIs included in the page,
are automatically selected. If you want to add to the CAP additional elements like
Scorecards, KPIs, andmore, click theNext button andmodify your selection in the other
pages of the wizard. Otherwise you can jump directly to the Summary wizard page.

4. Click Create to create the CAP. Once the CAP is created you cannot modify it. The new
CAP is displayed in the list of CAPs in the CAP Management page. In the right pane you can
see the contents of the CAP you have just created. For details, see "Content Acceleration
Pack" on page 232.

UI Description
Create CAP Wizard - Welcome Wizard Page
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Create CAP Wizard - General Details Wizard Page

User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Name  The name you want to give to the CAP.

The name should be unique. The standard characters are supported: a-z,A-
Z,and 0-9. The size of the name is limited to 256 characters.

Author The name of the creator of the CAP. It can be a single user, an HP partner, or
a group in your organization.

Description The description of the CAP. The size of the description is limited to 1000
characters.

Recalculate
date

The date used to recalculate all the Contexts included in the CAP during the
CAP activation.

Default value is one year back from the CAP upload date.

You can delete the default value. If you do not specify a recalculation date, the
recalculation is not performed during CAP activation.
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Documentation Click Browse to access the location of the CAP documentation or enter the
path to the document. The document can be aMicrosoft Word file or a .PDF.

When the CAP .ZIP file is created, the document you selected is
automatically added to the .ZIP file at the level of themanifest.properties
file.

Create CAP Wizard - Select Pages Wizard Page
Select the pages you want to include in the CAP from theAvailable area and click the relevant
arrows tomove these pages to theSelected area. The pages listed in theAvailable area are the
pages that already exist in the application.

You can select more than one page using the Shift button.

To unselect pages, select them in theSelected area and click the relevant arrows tomove the
selected pages back to theAvailable area.

Click the relevant link in the navigation pane to access the corresponding page or click Next to open
the next page of the wizard.

Limitation:

l "Shared KPIs" are KPIs that are reused in different Scorecards. If you share KPIs between
CAPs by including pages that include these Scorecards, then after uploading these CAPs
to another XS machine, and after activating the first CAP, and while activating the second
CAP, the shared KPIs are removed from the Active KPIs hierarchies and from the
Scorecard of the CAP that is activated first.
It is recommended to add all the Scorecards with shared KPIs to each CAP to prevent the
removal of the shared KPIs during the activation of the second CAP.
The same issuemay occur during the backup of a CAP with shared KPIs.

l Pages from an activated CAP are listed in the Settings menu of the XS app installed on your
tablet or smartphone, only after they are opened in the XS Dashboard.
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Create CAP Wizard - Select Scorecards Wizard Page
Select the Scorecards you want to include in the CAP from theAvailable area and click the
relevant arrows tomove these Scorecards to theSelected area. The Scorecards listed in the
Available area are the Scorecards that already exist in the application.

You can select more than one Scorecard using the Shift button.

To unselect Scorecards, select them in theSelected area and click the relevant arrows tomove the
selected Scorecards back to theAvailable area.

Click the relevant link in the navigation pane to access the corresponding page or click Next to open
the next page of the wizard.
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User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

Available
Scorecards

The list of Scorecards that are already active in the application, that the user has
permissions to view, and that have not already beenmanually selected, or that
were not automatically selected as part of the pages that were selected in the
Create CAP Wizard - Select Pages page.

You can select more than one Scorecard using the Shift button.
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Selected
Scorecards

The list of Scorecards that you want to include in the CAP.

Note:

l SomeScorecards (that appear as dimmed) are read-only because they are
automatically included in the list of Selected Scorecards. These
Scorecards were automatically selected because in theCreate
CAP Wizard - Select Pageswizard page you selected pages that include
these Scorecards. You cannot deselect these Scorecards.

l If you add to the CAP, a Dashboard page that includes a Scorecard, and
the Dashboard page already belongs to a CAP that has just been
activated, the Scorecard is automatically added to the list of Selected only
when the Dashboard page is opened once.

You can select more than one Scorecard using the Shift button.

Select the Scorecards you want to include in the CAP from theAvailable area and
click the relevant arrows tomove these Scorecards to theSelected area. The
Scorecards listed in theAvailable area are the active Scorecards that already
exist in the application.

To unselect Scorecards, select them in theSelected area and click the relevant
arrows tomove the selected Scorecards back to theAvailable area.

You can also drag and drop Scorecards from theAvailable area to theSelected
area and vice-versa.

Search Enter a string to list all the active Scorecards with names that include the string.
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Create CAP Wizard - Select KPIs and Metrics Wizard Page

User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI
Element Description

Available The list of KPIs andMetrics that already exist in the application.

You can select more than one KPI or Metric using the Shift button.

Selected The list of KPIs andMetrics that you want to include in the CAP.

KPIs or Metrics that are included in the Scorecards selected in theCreate
CAP Wizard - Select Scorecards page appear as read-only. They are already
listed in theSelected area and you cannot deselect them.

You can select more than one KPI or Metric using the Shift button.
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Select the KPIs andMetrics you want to include in the CAP from theAvailable area
and click the relevant arrows tomove these KPIs andMetrics to theSelected area.
The KPIs andMetrics listed in theAvailable area are the active KPIs andMetrics
that already exist in the application.

To unselect KPIs andMetrics, select them in theSelected area and click the
relevant arrows tomove the selected KPIs andMetrics back to theAvailable area.

You can also drag and drop KPIs or Metrics from theAvailable area to theSelected
area and vice-versa.

Search Enter a string to list all the active KPIs or Metrics with names that include the string.

Create CAP Wizard - Select Contexts Wizard Page

User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI
Element Description
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Available The list of available user-defined Contexts that already exist in the application and
that are not already selected.

You can select more than one Context using the Shift button.

Recommended:CSV tables used in Contexts should have unique names
across all active Content Acceleration Packs (CAPs). For details on CAPs, see
"Content Acceleration Pack" on page 232.

Selected The list of Contexts that you want to include in the CAP.

User-defined contexts that are related to KPIs or Metrics selected in the Create
CAP Wizard - Select KPIs andMetrics Page are already pre-selected and cannot be
deselected.

You can select more than one Context using the Shift button.

Select the Contexts you want to include in the CAP from theAvailable area and
click the relevant arrows tomove these Contexts to theSelected area. The
Contexts listed in theAvailable area are the Contexts that already exist in the
application.

To unselect Contexts, select them in theSelected area and click the relevant
arrows tomove the selected Contexts back to theAvailable area.

You can also drag and drop Contexts from theAvailable area to theSelected area
and vice-versa.

Search Enter a string to list all the active Contexts with names that include the string.

Create CAP Wizard - Summary Wizard Page
The Summary page of the wizard displays all the details of the CAP you just configured.

Expand the areas to display the details of each area.

Click Back to change the configuration.

Click Create to create the CAP. Once the CAP is created you cannot modify it. The new CAP is
displayed in the list of CAPs in the CAP Management page. For details, see "Content Acceleration
Pack" on page 232.
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CAPs Automatic Anti Virus Scans
New custom Content Acceleration Packs (CAPs) may inadvertently include viruses.

Executive Scorecard automatically scans a CAP you are uploading using an out-of-the-box anti
virus based on ClamWin (http://ClamWin.com).

XS includes an anti virus database (also based on ClamWin) to make sure that the latest anti
viruses are used in the provided out-of-the-box anti virus feature. By default, the database is not
automatically updated.

Alternatively, you can run your own anti virus using the same XS command instead of running the
out-of-the-box anti virus.

Tasks
This section includes:

"Work with the out-of-the-box anti virus" below

"Work with your own anti virus" on the next page

"Manually Update the Virus Database" on the next page

Work with the out-of-the-box anti virus
The anti virus runs automatically every time you upload a CAP. If a virus is included in the CAP an
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error message is displayed. You can view the CAP log, located at
<HPXS>\agora\glassfish\glassfish\domains\BTOA\logs\cap.log to get more information about
the virus.

By default, the anti virus database is provided with each version and is not automatically updated.

You can decide to automatically update the anti virus database every Sunday at 12:00 am
(midnight). To do so,

1. In the Executive Scorecard application, click ADMIN > Foundation > Foundation. For
details, see "Foundation" on page 131.

2. In the page that opens, set theAutomatic update of anti virus database parameter to true.

Work with your own anti virus
If you do not want to use the out-of-the-box anti virus (based on ClamWin) and you want to use your
own anti virus:

1. Open the antiVirusScan.bat file located at
<HPXS>\agora\agora\glassfish\glassfish\domains\BTOA\config\antivirus\.

2. Replace the command line with the command line that triggers your own anti virus, and click
Save.

Every time you upload a CAP, the antiVirusScan.bat runs and triggers your anti virus
detection.

Manually Update the Virus Database
Tomanually update the virus database, download themain.cvd and daily.cvd virus database files
from the ClamAV home page at http:\\www.clamav.net and copy them to the ClamWin virus
database folder located at:
<HPXS>\agora\glassfish\glassfish\domains\BTOA\config\antiVirus\clamwin\bin\db,
replacing the existing files.

Migrate a CAP to XS
A CAP contains only demo data. To get real data youmust:

1. Activate the relevant integration (select Admin > Data Source Management, select the
relevant data source and click Activate). For details, see "Data SourceManagement" on page
95.

2. If needed, switch the context of each KPI or Metric in the CAP to the relevant context (click
Studio, select the KPI or Metric, click theCalculation Details tab, and select the relevant
context in theBusiness Context list). For details, see KPI or Metric Configuration and
Calculation Details in the IT Executive Scorecard Business Analyst Guide.

3. Perform the relevant calculation. For details, see Calculation in the IT Executive Scorecard
Business Analyst Guide.
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CAP KPI or Metric Breakdowns:When the CAP includes KPI or Metric Breakdowns, XS
does not allow you to change Contexts. You can then do one of the following:

l Delete the KPI or Metric Breakdowns, then switch the Context for the KPIs andMetrics as
explained above, and then recreate the KPI or Metric Breakdowns.

l Go to the Dashboard page of the CAP and replace the CAP KPIs/Metrics used in the
CAP page components with the out-of-the-box KPIs/Metrics from the KPI Library.

Data Files (.CSV Tables)
The data files provided for the VP of Ops, VP of Apps, CloudOptimization, and Security Enterprise
Architecture CAPs are as follows:

Data Files (.CSV Tables) VP of Ops
VP of 
Apps

Cloud
Optimization

Security
Enterprise
Architecture

ACTUAL_COST_FACT_V X X N/A X

APPLICATION_DIM_V X X X X

ASSET_FACT_V X X X X

BACKUP_POLICY_DIM_V X X X X

BACKUP_SESSION_FACT_V X X X X

BACKUP_SESSION_RTO_FACT_V X X X X

BILLING_FACT_V N/A N/A X N/A

BUDGET_DIM_V X X X X

BUDGETLINE_DIM_V X X X X

BUSINESS_APP_PERF_FACT_V X X X X

BUSINESS_APP_STATUS_FACT_
V

X X N/A X

BUSINESS_UNIT_DIM_V N/A N/A X N/A

CHANGE_FACT_V X X N/A X

COMPLIANCE_STATUS_FACT_V X X X X

CONSUMER_DIM_V N/A N/A X N/A

CONTRACT_DIM_V X X X X

COST_FACT_V X X X X
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Data Files (.CSV Tables) VP of Ops
VP of 
Apps

Cloud
Optimization

Security
Enterprise
Architecture

COSTCATEGORY_DIM_V X X X X

COSTCENTER_DIM_V X X X X

CYCLE_DIM_V X X N/A X

DEFECT_FACT_V N/A X N/A X

DEMAND_FACT_V X X N/A X

INCIDENT_FACT_V X X N/A X

INTERACTION_FACT_V X X N/A X

ITFUNCTION_DIM_V X X X X

KPINAME_DIM_V X X X X

LOCATION_DIM_V X X X X

MAXIMUM_SERVICE_PROVIDER_
OFFERING_V

N/A N/A X N/A

MODEL_DIM_V X X X X

NODE_DIM_V X X X X

NODE_METRIC_FACT_V X X X X

ORGANIZATION_DIM_V X X X X

PERIOD_DIM_V X X X X

PERSON_DIM_V X X X X

POLICY_DIM_V X X X X

POLICY_REMEDIATION_FACT_V X X X X

POLICY_RESULT_FACT_V X X X X

PRJOBJECTIVE_DIM_V X X X X

PROGRAM_DIM_V X X X X

PROJECT_FACT_V X X X X

PROJECTISSUE_FACT_V X X X X

PROJECTRISK_FACT_V X X X X

PROJECTTASK_FACT_V X X X X
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Data Files (.CSV Tables) VP of Ops
VP of 
Apps

Cloud
Optimization

Security
Enterprise
Architecture

PROPOSAL_FACT_V X X N/A X

REQUIREMENT_FACT_V X X N/A X

RESOURCE_PROVIDER_DIM_V N/A N/A X N/A

RESTORE_SESSION_FACT_V X X X X

SCOPECHANGE_FACT_V X X N/A X

SERVICE_DIM_V X X X X

SERVICE_BLUEPRINT_DIM_V N/A N/A X N/A

SERVICE_INSTANCE_DIM_V N/A N/A X N/A

SERVICE_OFFERING_DIM_V N/A N/A X N/A

SERVICE_PROVIDER_
OFFERING_DIM_V

N/A N/A X N/A

SERVICESTATUS_FACT_V X X N/A X

SLA_DIM_V X X X X

SLAOUTAGE_FACT_V X X X X

SLAOVERALLSTATUS_FACT_V X X X X

SLASTATUS_FACT_V X X X X

STATUS_DIM_V X X X X

SURVEYRESULT_FACT_V X X N/A X

TEST_FACT_V X X N/A X

TESTINSTANCE_FACT_V X X N/A X
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Distributed Configuration - Server
Connection

When you are configuring an allocation scenario and youmark it as Affect Dashboard, all the KPI
calculations based on the FinancialManagement context run on the allocated data.

Tomake sure that the data is extracted using the correct schema, when you work in a distributed
configuration, youmust make sure that the server on which XS is installed and the server on which
DataWarehouse (DWH) is installed are connected via the network using port 10002.

In addition, youmust make sure that this setting (connection using port 10002) is reestablished
every time the session is restarted.

This connection enables the Dashboard to pull data from the COST_FACT_V view:

l Using the ITAAPP schemawhen theAffect Dashboard option has been selected for an
allocation.

l Using the DWH schemas when theAffect Dashboard option has not been assigned.

For details about allocations, see AllocationManagement in the IT Executive Scorecard Financial
Analyst Guide.
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Partitioning
Partitioning provides a performance improvement for very large tables and indexes used in daily
operations performed by the allocation engine, the KPI Engine, and other queries.

Partitioning is triggered by the ETL.

Section navigation:  l "LearnMore" below l "Tasks" on the next page l "Reference"
on the next page

Learn More
Partitioning in XS
XS expect tables to grow to hundreds of GB ormore. Such tables cause performance issues are
they make it difficult to load andmanipulate data, to remove old data, and tomaintain indexes.

Partitioning tables and their indexes divides the object into smaller segments, so that maintenance
operations can be done on a single segment at-a-time, rather than on the entire table. Partitioning
the table can also automatically direct queries to the appropriate partition, which reduces the
amount of records to scan and speeds up the queries.

The tables that are partitioned by default are all the FACT tables in the Target database and the
SNAPSHOT tables in the Staging database.

Benefits
The benefits of using partitioning are:

l The SQL Server automatically manages the placement of data into the correct partition.

l The partitioning of tables and indexes is transparent to the application.

l Faster and easier loading.

l Improve the performance of the allocation engine, KPI engine, and other queries.

l Control of Locks, Compressions and Read-Only at partition level.

Limitations
The limitations are:

l Towork with partitioning youmust install the SQLServer 2008 Enterprise Edition.

l XS supports amaximum of 1000 partitions per table.

l Partition Operations like (Split, Merge and Switch) can be blocked by other DataManipulation
Language (DML) statements like SELECT, UPDATE, or INSERT that are ran on the table at the
same time.
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l Rebuilding Indexes cannot be implemented online, themain reason for that is that the whole
table will be locked during this action

l Once the partitioning column(s) is set, it is not possible to change it.

l Changing the sliding windows scenarios can be difficult

l Switch Partitionmainly for Archive purposes have to reside on the same database (not
implemented in XS 9.4).

l In a CLUSTERED table, the Column PartitionMUST be part of Primary Key or CLUSTERED
INDEX

Tasks
Deactivate Partitioning
Partitioning is activated by default.

 
To deactivate partitioning, proceed as follows:

1. In the Staging database, locate the Configuration table (for details, see "Configuration Table"
on page 265) and change theActivation Status from True to False.

2. In the Target database, locate the Configuration table (for details, see "Configuration Table" on
page 265) and change theActivation Status from True to False.

Reference
Partitioning New Objects

l Store Procedures
The XS Store procedures that are responsible for partitioning are as follows:

n CreateTBLPartition_P – This Store Procedure is responsible for converting existing
Tables/Indexes into Partition Objects. It is executed from Init DB, or from a customization
script in Upgrade. It reads the list of tables from the configuration table, and partitions the
given table and it indexes one by one.

Format:
CREATE PARTITION FUNCTION <TABLE_NAME>_PF AS RANGE RIGHT FOR
VALUES (List of Dates, or Integer Boundary)

CREATE PARTITION SCHEME <TABLE_NAME>_PS AS PARTITION TABLE_NAME>_
PF ALL TO (<FILE GROUP>)
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Example

CREATE PARTITION FUNCTION NODE_FACT AS RANGE RIGHT FOR VALUES
(…’01-feb-2012’,’01-mar-2012’….)

o Partitioning indexes:

If Primary KEY exists, the procedure will drop it and recreate new clustered unique index
using the primary key plus the new partition column.

Format:
DROP INDEX <Constraint_Name> ON <Table_Schema>.<Table_name>
WITH (Move To <PS_Name> (<Partition_Columns>))

For every existing index, it will add this partition column, and partition the index:
CREATE INDEX <Previous_Index_Name> ON <SCHEMA>.<TABLE_NAME> (List of
Columns) ON <Partition Scheme> (Partition Column)

n Check_Configuration_Partition_fnc – The function that checks and validates records in the
configuration_partition before starting the actual partitioning procedure. This function is the
first step of CreateTBLPartition_P.

n ADDPartition_P – The procedure adds a partition when needed, according to the partitioning
methods. It creates new Partitions for a givenObject that is already partitionned. It executes
as one of the last step in XS ETL run.

o Date_boundary

o Integer_Boundary

o Period_Boundry

If the SP fails it writes the errors into APPLICATION_ERROR_LOG table.

Note:

n Snapshots partitioning is done automatically. When each Staging ETLis running, the
Create Partitioning procedure is running. It searches for new Snapshots tables in
Staging: if there are new tables it will insert their names/details into the Configuration_
Partition table.

n ForSnapshot_Boundary (TSNP, SSNP staging tables) the portioning is fixed (0-9 and
A-Z), so no need to add partition.

n For Snapshot with CSNP tables the partition column isMD_BUSSINES_KEY and the
partitioningmethod is Integer_Boundary.
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l Tables
n Configuration_Partition – The configuration table that includes the list of candidates

Objects for partitioning.

n APPLICATION_ERROR_LOG – The auditing and error log table. The procedures above
write the errors into this table in case of failure.

Note:

n The tables above are created as part of the Init_DB orUpgrade processes.

n TheCreateTBLPartition_P andCheck_Configuration_Partition_fnc procedures are
executed at the last step in XS ETL run.

Table Partitioning
XS partition supporst (right now) four ways of partitioning, all RIGHT range partition:

l Date Boundary Range

l Integer Boundary Range

l Period Boundary Range

l Snapshot Boundary Range – Fixed Range (0-9 , A-Z)

Configuration Table
This table is provided out-of-the-box.

Column Name Description

Entity_Name Services, Person, Projects, SLA....

Entity_Type Target_core orSnapshot

Snapshots are located in staging DB(SSNP,TSNP)or in target
(CSNP)

Table_Name The name of the Partition Table.

Table_Schema dwt, dws, or itaapp

Partition_Method Date_Boundary, Integer_Boundary, Snapshot_Boundary,
Period_Boundary
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Column Name Description

Partition_Policy l Date_Boundary (Month)

l Integer_Boundary (NULL)

l Snapshot_Boundary (NULL)

l Period_Boundary (Month)

Partition_Columns MUST beDATETIME or Integer types

Amount_of_Records_Per_
Partition

Amount_of_Records_Per_Partition (minimum of 1,000,000)

Active only for Integer_Boundary

Retention_Policy In Days, how long to keep the data, default 36,525= 100 years

Partition_Status l Normal - For new not partitioned tables.

l Partitioned - For partitioned tables.

Activation_Status True. Continue the partitioning of the object. Default.

False. Stop the partitioning of the object.

Archive_Status This is for future use.

True. The table is to be archived.

False. The table is not to be archived. Default.

Administrator Guide
Partitioning

Page 266 of 413HP IT Executive Scorecard (9.41)



Add Dimensions to FinancialManagement
Context and Integrate with PPM

The integration with HP Project and Portfolio Management provides KPIs based on the Financial
Management context. You can use these KPIs in Dashboard page components to help youmanage
the finances of your company. For details on these KPIs, see PPMData Source in the IT Executive
Scorecard KPIs, Metrics, and Data Lineage ReferenceGuide.

In addition, the integration provides Allocations and Costs that are based on the Financial
Management context. For details, see AllocationManagement and Cost Explorer in the IT
Executive Scorecard Financial Analyst Guide.

Tasks
Add dimensions to the FinancialManagement context and use these
dimensions in Allocation stages

Note: You can use the default dimensions provided in the Finance tab to create your
allocations and costs. You can also add your dimensions to the FinancialManagement context
and base your allocations and costs on these dimensions. You can also rename the existing
dimensions to better reflect your financial environment. These new dimensions or renamed
dimensions are listed in this field. For details, see "Add Dimensions to FinancialManagement
Context and Integrate with PPM" above in the IT Executive Scorecard Administrator Guide.

You can extend content using the OOTB Actual Cost custom Target extension (ACTUAL_COST_
CSTM). You can add columns and associated dimensions to ACTUAL_COST_CSTM for use in
Allocation scenarios and stages. Allocation can be done based on an extended set of dimensions or
based on added dimensions from a new data source.

1. To add your dimensions to the FinancialManagement context, create the relevant dimensions
in the IDE, and create the relevant ETL process and run it. For details, see Extend custom
ITFM Entities: in the IT Executive Scorecard Content Extension Guide.

2. Youmust then connect the new dimensions to the existing FinancialManagement context in
the Context Designer. For details, see "Add a column to a Target database table and the
impact on the context" on page 189.

3. Once the ETL is running:

n The new dimensions, or the renamed dimensions are available in the Allocation Stage for
Planned or Actual Costs. For details, see Allocation Stages in the IT Executive Scorecard
Financial Analyst Guide.
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n The new dimensions, or the renamed dimensions are available in the Rule Criteria of an
Allocation Stage for Planned or Actual Costs. For details, see Allocation Rules in the IT
Executive Scorecard Financial Analyst Guide.

n The new dimensions, or the renamed dimensions are also available in the Group by
Dimension fields in the Cost Explorer. For details, see Cost Explorer in the IT Executive
Scorecard Financial Analyst Guide.
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KPI and Metric Data Lineage
The data lineage of a KPI or aMetric enables you to see, in graphical format, for a specific KPI or
Metric, the chain of entities, fields, views, tables, and contexts that are used to obtain data from the
data source, import it into the DataWarehouse, and calculate the value, status, and trend of the
KPI or Metric.

For details about the KPIs, Metrics, and their data lineages, see the IT Executive Scorecard
Content ReferenceGuide for the relevant data source.
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Work with Enhanced Telecom Operations
Map KPIs

The eTOM (enhanced TelecomOperations Map), published by the TM Forum, is a guidebook that
defines themost widely used and accepted standard for business processes in the
telecommunications industry. The eTOMmodel describes the full scope of business processes
required by a service provider and defines key elements and how they interact. As a not-for-profit
organization, TM Forum is driven by a Board of senior executives from across the industry.

Section navigation:  l "LearnMore" below l "Tasks" on page 273 l "Work with
Enhanced TelecomOperations Map KPIs" above

Learn More
More information about eTOM’s Business Metrics and Benchmarking
Programs
Developed by service providers, for service providers, eTOM’s Business Metrics and
Benchmarking Programs define and gather quantitativemetrics ranging from tactical to business
performance data and conduct qualitative surveys on topics of service provider interest. There are
two primary aspects to Business Metrics Automation (BMA): Inclusion of the appropriate, standard
eTOM Business Metrics in products and systems used by service providers and support for the
programmatic interface into the Forum’s secure Benchmarking Database, via controlled, secure
data transfer. Service providers can also implement these aspects directly in their internal systems
and can then work with the BMA interface.

The following figure presents the complete set of eTOM Business metrics in release 5. The 2
groups currently implemented in Executive Scorecardhave been highlighted.
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How does it work?
Formany service providers, the easier approach is simply to use products from suppliers who have
added the Business Metrics and BMA interface to their commercial off the shelf (COTS) products.
These products bear amark indicating that they have been tested for their inclusion of the
appropriate group of metrics (such as the set of revenue assurancemetrics for a revenue assurance
product) and the BMA interface functionality. Service providers can ensure consistent, accurate,
and apples-to-apples comparisons for both benchmarking studies and internal dashboards by
procuring products with TM Forum Business Metrics built in. eTOM’s Business Benchmarking
Programmanages and delivers metric-based business performance benchmarking studies on
topics including Broadband, Mobile, Business IP Services, and Self-Service.

HP IT Executive Scorecard is certified (from this version and above) in the following areas:
Customer Problem Resolution andService Problem Management.The certification provides a
secure interaction with the eTOM Business Benchmarking database, including uploading data for
the specified standardmetrics in the correct format, generating queries, and downloading the query
results.

HP IT Executive Scorecard offers the standardmetrics in the following areas: Customer Problem
Resolution andService Problem Management.

A special tool extracts the results from the eTOM-related KPIs from the Results database, the
values extracted aremapped to TM Forum business metrics and business metrics details.This
information is then structured as XML and changed into an XML file and the XML files are sent to
the eTOM Benchmarking database via the eTOM secureWeb Portal.
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eTOM-Related KPIs Location in the Studio
After they have been imported, the eTOM-related KPIs are listed in the Active KPIs pane, in the
Industry StandardsScorecard, in the eTOM Perspective, and are distributed under two
Objectives: Customer Problem Resolution andService Problem Management.

Tip: Though these KPIs also appear by default in the KPI Template pane, it is recommended not to
drag and drop these KPIs from the KPIs Template pane to the Active KPIs pane to activate them,
because in such a case, the KPI Breakdowns do not appear in the Active KPIs pane and these KPI
Breakdowns are important for TMF. It is recommended instead to import the TMF-related tree of
Scorecards, Perspectives, Objectives, KPIs, and KPI Breakdowns directly as described below into
the Active KPIs pane.

eTOM-Related KPIs
A folder of XML files is available to be imported into the Studio to provide the relevant components
needed to create the corresponding eTOM-related KPIs.

Each file corresponds to a KPI.

Data Displayed by the eTOM-Related KPIs
The data displayed by the eTOM-related KPIs is extracted from the Incident and Interaction Data in
the IT Infrastructures Library (ITIL) of HP ServiceManager related to SQM or CME.

Tasks
This section includes:

"Work with Enhanced TelecomOperations Map KPIs" on page 271

"Import Source Data using ETL tool" below

"Import the TM Forum-related KPIs into the Active KPIs pane in the Studio" below

"Calculate All Breakdown Paths" on page 275

"Work with Enhanced TelecomOperations Map KPIs" on page 271

"Check Certification Results in BMA Portal" on page 277

"View the eTOM-Related KPIs in the Dashboard" on page 277

1. Make sure that the integration with the HP Service Manager data
source has been performed
For details, see Integrate with the SM Data Source in the IT Executive Scorecard Content
ReferenceGuide for the Integration of HP ServiceManager.

2. Import Source Data using ETL tool
Import the source data into the Studio using the ETL tool. For details, see " ETLManagement "
on page 112 in the IT Executive Scorecard Administrator Guide.

3. Import the TM Forum-related KPIs into the Active KPIs pane in the
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Studio
a. Copy the files from the <install-root>\tools\TMF\ContentApp directory in the Executive

Scorecard DVD to the following directory:
C:\<installation
directory>\agora\glassfish\glassfish\domains\BTOA\config\kpiconfiguration\import
\load

b. Activate <installation directory>\agora\jdk\bin\j-Console.exe.

c. Select Remote process and enter localhost:10008 in the field below.

d. Click theMBeans tab.

e. Expand theKPILoader and click the importKPIs button. Close the j-Console.
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4. Calculate All Breakdown Paths
In the Active KPI Pane in the Studio, under the Industry Standards Scorecard, under the
TM Forum Perspective, the KPIs are distributed between the Customer Problem Resolution
Objective and the Service ProblemManagement Objective.

Click the TM Forum Perspective, and click and select the
Calculate now option, and in the Calculate now dialog box, select the ServiceDesk universe.
This operation calculates the values, statuses, and trends of all the KPIs and KPI Breakdowns
as well as the values of the related Objectives, Perspectives, and Scorecards and displays the
relevant data in the Dashboard.

For details on calculating KPIs, see Calculate Displayed Values after Configuration Change.

5. Generate XML Data and Send the Data to the BMA Portal for
Certification
a. Set the XS server information and BMA web service information in the

xmlTemplateConfig.properties file. The file is used to store information about the XS
server and the BMA web service.

#CPR --- Customer Problem Resolution
CPR = CPR-BB-Max-Data,CPR-IP-Min-Short-Data
CPR_Data = CPR-BB-Max-Data,CPR-IP-Min-Short-Data
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CPR_App = CPR-BB-Max-App,CPR-BB-Min-App
#SPM --- Service Problem Management
SPM = SPM-BB-Max-Data,SPM-IP-Min-Short-Data
SPM_Data = SPM-BB-Max-Data,SPM-IP-Min-Short-Data
SPM_App = SPM-BB-Max-App,SPM-BB-Min-App
#All metric names - the names of the separate Metric XML files that are c
reated by the import operation.
#batch file and that are sent to the BMA site.
Metric_All = CPR-BB-Max-Data,CPR-IP-Min-Short-Data,CPR-BB-Max-App,CPR-BB-
Min-App,
SPM-BB-Max-App,SPM-BB-Max-Data,SPM-BB-Min-App,SPM-IP-Min-Short-Data
#Periods (Don't change the Periods name) - The periods for which you want
to calculate the metrics.
Periods = FY2011/04(Apr),FY2011/05(May),FY2011/06(Jun)
#Logon TMF info (Don't change the key name) - the username and password a
re provided by BMA: #BMA
WS logon name:
ws_name = xyz
#BMA Web Service logon password:
ws_password = xyz
#BMA Web Service URL:
ws_url = http://
#BMA Web Service port:
ws_port =
# The host name of the XS Server:
server = xyz
# The port of the Executive Scorecard server:
port = 10004

b. For eachmetric group, generate the relevant XML file based on the templates using the
command:
java -jar BMA_16.jar <metric_group_code> <research_stream> 0

wheremetric_group_code can be:

o CPR - Customer Problem Resolution

o SPM - Service ProblemManagement

and <research_stream>. For certification, TM Forum has defined Research Streams which
corresponds to different types of industry. Current research streams are:

o BB (Broadband) - Includes xDSL, cable fiber and satellite.

o Mobile - Includes 2G, 3G and 4G. It represents network equipment used to be provide
the service.

o IP - IP Business Services.
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Example java -jar BMA_16.jar CPR BB 0

c. For eachmetric group, send the relevant XML file to the BMA web service using the
command:
java -jar BMA_16.jar <metric group code> BB 1

Example java -jar BMA_16.jar CPR BB 1, where CPR represents the Customer
Problem Resolutionmetric group and BB means Broadband.

6. Check Certification Results in BMA Portal
Access the BMA portal and check the certification results.

A typical certification results screen is as follow:

The failed tests in the above picture, are due to optional (Extended) Business Metrics not
supported by HP ServiceManager.

7. View the eTOM-Related KPIs in the Dashboard
Create a page in Dashboard to display components that include the eTOM-Related KPIs. For
details, see Configure a Page Layout.

Example
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Click the or to display the tooltip of the Objective and click the relevant KPI or KPI
Breakdown.

The Explorer tab opens and displays the KPI or KPI Breakdown details:
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For details about the Explorer tab, see View and Analyze Results in the Explorer Page

eTOM-Related KPIs
Customer Problems Resolution
TheMetric IDs are standard in eTOM.

Metric ID KPI Name Description

A-CE-2a Incident Closure
Time KPI

Incident resolution time Time for resolving incidents (customer
contact through informing customer of resolution) / total number
of incidents resolved.

1. By Problem Severity: Critical, Major, Minor (3) (Optional)

A-CE-2b Mean Time To
Resolve
Customer
Incident KPI

Mean time to resolve customer incident Time for resolving
incidents (customer contact through informing customer of
resolution) / total number of incidents resolved.

1. By Customer Segment: Consumer & SME, Large Enterprise
& Government (2) (Optional)

2. By Service Component: Voice Services, Data Services (2)
(Optional)

A-CE-4a Metric ID % of incidents that are reportedmore than once by the customer
Number of incident re-reports / total number of customer
reported incidents

1. By Customer Segment: Consumer & SME, Large Enterprise
& Government (2) (Optional)

A-CE-4c % Of Problems
Reported By
Customers KPI

% of problems reported by customers Total number of problems
reported by CUSTOMERS / Total number of problems reported

1. By Problem Severity: Critical, Major, Minor (3) (Optional)

A-OE-3b % Maintenance
TimeUsed For
Repair

% maintenance time used for repair Repair time / Total
assurance time (Maintenance + Repair)

Service Problem Management
TheMetric IDs are standard in TM Forum.
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Metric ID KPI Name Description

A-CE-2c % Of Problems
Resolved By
Due Date KPI

% of problems resolved by due date Number of problems
resolved to customer satisfaction by committed date / total
number of problems occurring during the reporting period

A-CE-4c % Of Problems
Reported By
Customers KPI

% of problems reported by customers Total number of problems
reported by CUSTOMERS / Total number of problems reported

1. By Problem Severity: Critical, Major, Minor (3) (Optional)

A-OE-2a Service Problem
Resolution Time
KPI

Service Problem Resolution Time Aggregate time to resolve SO
service problems for AssuranceMeta Process Blocks (1-4)
inclusive / number of closed problem reports

1. By Problem Severity: Critical, Major, Minor (3) (Optional)

2. By Customer Segment: Consumer & SME, Large Enterprise
& Government (2) (Optional)

A-OE-2b Mean Time To
Resolve Service
Problems KPI

Mean Time to resolve service problems Time to resolve SO
Service Problems by process block (Meta Blocks 1-4) / Number
of Service Problems closed within period

1. By META process blocks: resource data collection and
processing, service problemmanagement, resource trouble
detection/handling, customer QoS/SLA management (4)

2. By Customer Segment: Consumer & SME, Large Enterprise
& Government (2) (Optional)

3. By Problem Severity: Critical, Major, Minor (3) (Optional)

A-OE-3a % of Problems
By Cause Type
KPI

% problems by cause type Number of problem reports of type X
/ Total number of problem reports

1. By Cause Type: customer caused, technology caused,
workforce caused, datamismatch problems for internal
systems, other (5)

A-OE-3b % Maintenance
TimeUsed For
Repair

% maintenance time used for repair Repair time / Total
assurance time (Maintenance + Repair)

A-OE-3c Mean Time
Between
Failures KPI

Mean time between failures ((Revenue System Size) -
(MTTR*number of trouble tickets closed inmonth)) / number of
trouble tickets closed inmonth

A-OE-6a NOC FTE
Efficiency KPI

NOC FTE Efficiency Total Number of problem reports resolved
/ Total number of NOC FTEs working on problem resolution
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Localization and Globalization
You can localize and globalize Executive Scorecard. The user interface of HP Executive Scorecard
supports multiple languages.

Tasks
"Localize the Out-of-the-box KPI Library Pane Contents" below

"Localize the Out-of-the-box Dashboard Content (Pages and Components)" on the next page

Localize the Out-of-the-box KPI Library Pane Contents
The localized installation adds the language libraries of XML files in specific folders. You copy and
then import these files to display the out-of-the-box template Scorecards, Perspectives,
Objectives, Folders, and KPIs in the KPI Library in the selected language.

To localize the out-of-the box content of the KPI Library: Scorecards, Perspectives, Objectives,
and KPIs, proceed as follows:

1. In the Executive Scorecard server, locate the
<XS_installation_directory>\agora\glassfish\glassfish\domains\BTOA\config\
kpitemplates\import\languages\<language_code>_<country_code> folder relevant for the
language you want to use in the application. The .xml files in the folder represent both KPIs and
KPI directories.

The language code and country codes are as follows:

Language Language Code Country Code

Brazilian Portuguese pt BR

French fr FR

Spanish es ES

German de DE

Japanese ja JP

English en US

Dutch nl NL

Italian it IT

Simplified Chinese zh CN

Korean ko KR

Russian ru RU

Turkish tr TR
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2. Copy these .xml files to the <XS_
server>\agora\glassfish\glassfish\domains\BTOA\config\kpitemplates\import\load
folder.

Tip:

If the folder contains other sets of files (for different languages), it is recommended to keep
in the folder only the required set of language files and tomove the other files outside the
folder to prevent the loading of both set of language files and an unknown result.

3. Import the out-of-the-box language files using theKPILoader > importKPIs() procedure
described in "Migrate Trees, Metrics, and Unassigned KPIs" on page 298in the IT Executive
Scorecard Administrator Guide.

Localize the Out-of-the-box Dashboard Content (Pages and Components)
The localized installation adds the language libraries of XML files in specific folders. You copy and
then import these files to display the out-of-the-box template pages and components in the selected
language, in the Dashboard.

To localize the out-of-the box pages and components, proceed as follows:

1. Prerequisite

You have performed the installation and post-installation procedures or the upgrade to the
current version.

2. Copy the libraries

a. In the Executive Scorecard server, locate the
<XS server>\agora\glassfish\glassfish\domains\BTOA\config\
uimashup\import\languages\<language_code>_<country_code> folder relevant to the
language you want to install. These .uim.xml files represent the components and the pages
used in the Dashboard.

b. The language code and country codes are as follows:

o Components_<lang>_<country_code>.uim.xml

o Pages_<lang>_<country_code>.uim.xml,

where lang is the language code and country_code is the code of the country:

Language Language Code Country Code

Brazilian Portuguese pt BR

French fr FR
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Language Language Code Country Code

Spanish es ES

German de DE

Japanese ja JP

English en US

Dutch nl NL

Italian it IT

Simplified Chinese zh CN

Korean ko KR

Russian ru RU

Turkish tr TR

c. Copy these files to the
<XS_server>\agora\glassfish\glassfish\domains\BTOA\config\uimashup\
import\toload folder.

Tip:

If the folder contains several sets of files (for different languages), it is recommended
to keep in the folder only the required set of language files and tomove the other files
outside the folder to prevent the loading of both set of language files and an unknown
result.

d. Import the out-of-the-box language files (only for the pages and components - events
are not localized) using the relevant procedure described in "Migrate User-defined Pages
or Components" on page 301 in the IT Executive Scorecard Administrator Guide.
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Enterprise Readiness (ER) Tools
The ER tools provide better manageability and awareness of processes in the system, and enable
you to clean problematic entities or all data, as well as re-stream existing data with problematic
logic according to batch or specific date. The Restream and CleanData streams are hidden by
default. However, they can bemanaged, as any other stream, in the ETLManagement tab.

When you have specific KPI and data problems in Executive Scorecard, or after you run the ETL,
check the Target tables for any issues. If you find a problem with specific entities, note the specific
batch ID or the specific load date in the Target tables. Depending on the issue, you will need to
either clean or restream the data to fix the issues.

To access the CleanData and Restream streams:
Admin > ETL Management and select theShow Hidden Streams checkbox.

For ETL stream details, see " ETLManagement " on page 112.

Section navigation:  l"LearnMore" below l"Tasks" on page 287 l"UI Description" on
page 288

Learn More
CleanData

Note: The CleanData stream is an advanced ETL tool. Running the CleanData stream erases
all existing data in the Staging tables.

CleanData does not clean historical data in the Target tables.

The DW ABC Streams Management User Interface enables you to clean corrupted data by specific
criteria and then reload data from the source by running the Upstream ETL stream.

CleanData is used to enable the data in DWH to be restored to a specific version, as follows:

l CleanData by batch, entity or all entities.

l CleanData by date, entity or all entities.

Note: Running the CleanData streammay not recover all existing data.

Restream
The DW ABC Streams Management User Interface enables you tomanage re-streaming the entire
ETL loading process. This functionality allows you to re-stream the entire ETL stream from a
previous batch to the latest batch, as well as revise incorrect data in the DWH Target.

Restream is used to re-stream the entire ETL loading from a specific batch point to the latest point,
as follows:
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l Re-stream by batch, entity or all entities.

Command Line Interface Tool
To run the ER tools in ETLManagement youmust first use command line batch files to set the
stream parameters. The two batch files are found in the DWH/bin folder.

The log information is inDWH/log/dw_abc.log.

The log level can bemodified inDWH/conf/abc-log4j.xml.

Note: The arguments are populated into an ABC table called CONTROL_ARGS. If there are
unexecuted commands in CONTROL_ARGS, the batch files cannot insert new records into
the CONTROL_ARGS table.

CleanData Command

dw_abc_cleandata

[-batch <batch_id>] [-entity <entity_name>] [-inputdate <input_date_of_batch>] [-display] [-delete]
[-help]

Options:

l -batch: The batch ID of the point in DWH from which you want the data to be cleaned.

Example If the DWH system has 5 batches, and the problem is with batch 2, then it will
delete batch numbers 2, 3, 4, and 5.

l -entity: Themodel name of the entity that you want cleaned.

l -inputdate: The date of the restore point in DWH from which you want data cleaned.

l -display: Display all existing commands.

l -delete: Delete the unexecuted commands.

l -help: Print the helpmessage.

Example

dw_abc_cleandata -batch 1 -entity LOCATION
dw_abc_cleandata -batch 1 -entity LOCATION,SERVICE,ORG
dw_abc_cleandata -batch 1 -entity ALL
dw_abc_cleandata -inputdate 2012-09-30 -entity LOCATION,SERVICE,ORG
dw_abc_cleandata -inputdate 2012-09-30 -entity ALL
dw_abc_cleandata -help
dw_abc_cleandata -display
dw_abc_cleandata –delete
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Returns:

l 0 success

l 1 success with warnings

l >1 errors present

Restream Command:

dw_abc_restream

restream. bat [–batch <batch_id>] [-entity <entity_name>] [-full <full_restream>] [-display] [-delete]
[-help]

Options:

l -batch: The batch ID of the point in DWH from which you want the batch re-streamed.

Example If the DWH system has 5 batches, and the problem is with batch 2, then it will re-
stream batch numbers 2, 3, 4, and 5.

l -help: Print the helpmessage.

l -entity: Themodel name of the entity you want re-streamed.

l -full: The flag of the re-stream indicator that allows only re-streaming the error data from the
VALF table when it is equal to N, otherwise it re-streams all data.

l -display: Display all existing commands.

l -delete: Delete the unexecuted commands.

l -help: Print the helpmessage.

Example

dw_abc_restream -batch 1 -entity LOCATION -full Y
dw_abc_restream -batch 1 -entity LOCATION,SERVICE,ORG -full Y
dw_abc_restream -batch 1 -entity ALL -full Y
dw_abc_restream -batch 1 -entity LOCATION -full N
dw_abc_restream -batch 1 -entity LOCATION,SERVICE,ORG -full N
dw_abc_restream -batch 1 -entity ALL -full N
dw_abc_restream -help
dw_abc_restream -display
dw_abc_restream –delete

Returns:
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l 0 success

l 1 success with warnings

l >1 errors present

Tasks
This section includes:

"Utilize the Restream or CleanData streams" below

"Display hidden streams" below

Utilize the Restream or CleanData streams

1. Run the following command line batch files found in the DWH/bin folder to set the stream
parameters.

dw_abc_cleandata

dw_abc_restream

2. After you run the command line batch files, access the ER tools and run the Restream or
CleanData streams.

Display hidden streams

1. Select Admin > ETL Management and select Show Hidden Streams.

2. The hidden ETL streams are displayed.

3. You can then schedule the batches, as needed.

4. Click to load and run the batch.

5. Click to refresh and check the running status of the ETL.

6. Once the ETL is running successfully, re-run the Upstream stream.

For ETLManagement details, see " ETLManagement " on page 112.
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UI Description

<Stream Display>
User interface elements are described below (when relevant, unlabeled elements are shown in
angle brackets):

UI Element Description

<Stream
Information>

Displays the following stream details:

l Stream Name

l Status: Active or Suspended or None

l Duration

l Date

Show Hidden
Streams

Click to display the hidden ETL streams.

Refreshes the stream information. There is an automatic refresh of the
stream information every twominutes.

More Info Opens the Stream Details dialog box. For details, see "Enterprise
Readiness (ER) Tools" on page 284

Load Batch/Resume. Starts or resumes the running of the specific batch
of ETL stream.
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UI Element Description

Opens the Stream Scheduler dialog box. Enables you to schedule the load
batch and run_steps commands. For details, see "Enterprise Readiness
(ER) Tools" on page 284.

Suspend Stream. Temporarily suspends the stream.

Abort Stream. Stops the stream that is running.

<Node Display> Displays the nodes representing the groups of steps within one level of
execution of an ETL run, the steps that can run in parallel. A node is a
collection of steps that all run in parallel. The icon for each node represents
the worst status of all of the steps in the node.

Indicates that the particular step or all steps in the node have finished
successfully in the execution.

Indicates that a step or a step in the node is currently running

Indicates an error in one of the steps. The step is automatically retried
four times by default.

Click the Error node to display the Node Step List in order to retry steps.
Click to retry the step.

Indicates a warning in one of the steps.

Click a node to open the Node Step list.

If there is an error in any of the steps, then all steps in the execution of the
stream are stopped. In order to move to the next node, the error must be
resolved.

Click More Info to display the Step Details dialog box pertaining to the
particular step. For details, see "Enterprise Readiness (ER) Tools" on page
284.

For more details onmanaging ETL streams, see " ETLManagement " on page 112.
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Migrate from Development or Test
Environment to Production

This section lists the tasks involved inmoving from aDevelopment or Test environment to a
Production environment.

This section includes:

Change Data Sources 291

Restore from Backup 292

Migrate the Data Services 293

Activate the Data Sources 294

Run the ETLs to Pull Data from the Data Sources 295

Migrate contexts 296

Migrate Data Imported using .CSV files 297

Migrate Trees, Metrics, and Unassigned KPIs 298

Migrate User-defined Pages or Components 301

Perform the calculation 304

Migrate the SAP BusinessObjects Enterprise reports and BIAR files 306
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Change Data Sources
If you changed one or more of the data sources (for examplemoving from one version of a data
source to a higher version of the data source in the Development or Testing environment, youmust
modify the data source settings in the Data SourceManagement page in the Production
environment. Click Admin > Data Source Management andmake your changes.

For details, see "Data SourceManagement" on page 95 .
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Restore from Backup
To restore your system from backup follow the backup instructions. For details, see "Executive
Scorecard Back Up " on page 317 .
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Migrate the Data Services
SAP BusinessObjects Data Services is the access mechanism that performs the physical data
extraction from the source repository to the staging database. Each stage of the ETL is embodied in
a Data Services job, from the extraction of source data to the target database.

Tomigrate the Data Services from the Development/Testing environment to the Production
environment:

1. In the Development/Testing environment, export the Data Services files using the dw_etl_
export command. For details, see "dw_etl_export" on page 384.

2. In the Production environment, import the Data Services files you exported, using the dw_etl_
import command. For details, see "dw_etl_import" on page 385.
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Activate the Data Sources
In the Production server, activate the relevant data sources:

1. Select Admin > Data Source Management.

2. The Data Sources page opens. Click theActivate button for the relevant data source.
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Run the ETLs to Pull Data from the Data
Sources

In the Production server, run the relevant ETLs to pull data from the data sources.

For details, see " ETLManagement " on page 112.
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Migrate contexts
Tomigrate the contexts, proceed as follows:

1. Prerequisite:Make sure your schemas are the same in the Development or Testing
environment and in the Production environment.

2. Create a CAP that only includes the contexts you created or modified in the Development or
Testing environments. For details, see "Create a CAP with the Executive Scorecard
application data" on page 246.

Note: You canmigrate Contexts, trees, KPIs, Metrics, user-defined pages, or
components using one CAP per type of item or one CAP for all the items you want to
export/import/migrate.

Note: You can select to perform a recalculation during the CAP activation by specifying a
recalculation date when you create the CAP.
You can also perform the calculation after all the items aremigrated. For details, see
"Perform the calculation" on page 304.

3. Export the CAP you created. For details, see "Download a CAP to the user's local system" on
page 237.

4. Copy the CAP you downloaded from the Development or Testing environment to the
Production server or from the user's local system to the system where you want to import the
item.

5. Upload the CAP to the Production server. For details, see "Upload a CAP to the Executive
Scorecard application" on page 234.

6. Activate the CAP inAdmin > Content Acceleration Pack. For details, see "Activate a CAP"
on page 235.

7. Verify the upload by accessing the contexts inAdmin > Semantic Layer. For details, see
"Semantic Layer - Context Designer" on page 170.

Note: If the context you import already exists in the Production environment, it is deleted and
replaced by the context imported using the CAP.
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Migrate Data Imported using .CSV files
Tomigrate data imported into Executive Scorecard using .CSV files, proceed as follows:

1. Create a CAP that only includes the contexts used to import the .CSV files you created or
modified in the Development or Testing environments. For details, see "Create a CAP with the
Executive Scorecard application data" on page 246.

Note: You canmigrate Contexts, trees, KPIs, Metrics, user-defined pages, or
components using one CAP per type of item or one CAP for all the items you want to
export/import/migrate.

Note: You can select to perform a recalculation during the CAP activation by specifying a
recalculation date when you create the CAP.
You can also perform the calculation after all the items aremigrated. For details, see
"Perform the calculation" on page 304.

2. Export the CAP you created. For details, see "Download a CAP to the user's local system" on
page 237.

3. Copy the CAP you downloaded from the Development or Testing environment to the
Production server or from the user's local system to the system where you want to import the
item..

4. Upload the CAP to the Production server. For details, see "Upload a CAP to the Executive
Scorecard application" on page 234.

5. Activate the CAP inAdmin > Content Acceleration Pack. For details, see "Activate a CAP"
on page 235.

6. Verify the upload by accessing the contexts inAdmin > Semantic Layer. For details, see
"Semantic Layer - Context Designer" on page 170.

7. Reimport the data by accessing the relevant context inAdmin > Semantic Layer. For details,
see "Semantic Layer - Context Designer" on page 170.

8. Perform the calculation for the relevant contexts in the Studio. For details, see Calculate
Displayed Values after Configuration Change in the IT Executive Scorecard Business Analyst
Guide.

Note: If the context you import already exists in the Production environment, it is deleted and
replaced by the context imported using the CAP.
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Migrate Trees, Metrics, and Unassigned KPIs
You can export complete trees (with their Scorecards, Perspectives, Objectives, and KPIs) from
the Active KPIs pane.

You can import existing template trees or sub-trees, active trees, active sub-trees, Metrics, or
Unassigned KPIs into the Active KPIs pane.

The import or export flows aremeant to be used whenmoving from staging to production and not as
a way to update system configuration. If you want to use the import or export flows to update the
system configuration, youmust delete all the nodes in the active KPIs pane, before performing the
import operation.

The export and import flows are alsomeant to be used for localization purposes, when you want to
work with other languages than English.

Learn More
About Exporting or Importing Trees
You use the export or import feature when you want to import or export out-of-the-box templates,
automatically update existing templates, or import new templates, or active trees into the Executive
Studio.

The export and import feature is the process used tomove from staging environment to production.

The export feature collects the contents of the Active KPIs tree (Scorecards, Perspectives,
Objectives, KPIs, Metrics, and Unassigned KPIs). It converts the contents to a configuration.xml
file that describes the structure of the active tree or to a <Scorecard_name>.xml file for each
Scorecard. These files include the UUID, KPI name of the KPIs, andMetrics name of theMetrics
included in the trees. In addition, the process creates a <kpi_or_metric_name>.xml file per KPI or
Metric in the system; that file describes the configuration of the KPI or Metric. The XML files are
created in a specific directory on themachine.

The import feature collects the content of a specific directory on themachine. The directory can
include configuration.xml files, and <kpi_or_metric_name>.xml files according to the same
format used by the export feature or can include .xml files with other names. The import feature
uses these files to upload the information in the specific area in the Active KPIs tree.

The export and import operations work with XML files with a specific structure. Each
configuration.xml file includes information about the hierarchy from the lowest node to the tree root.
That information is used to add the new node is added to the relevant location in the relevant tree, or
the imported node overrides the relevant node. Each <KPI_or_Metric_name>.xml file includes
information about the KPI or Metric configuration. That information is used so that the relevant
configuration and calculation details are added to the relevant KPI or Metric.

The export operation uses the KPI or Metric UUID to identify the KPI or theMetric.

In addition, you can import KPIs from Excel files. You can use this capability to import KPIs without
consideration about their location in the tree. You can also create an .xml file that provides
information about a tree structure and that refers to KPIs that are imported from the Excel file. The
import feature uses these files to upload the information in the specific area in the Active KPIs tree.

HP IT Executive Scorecard (9.41) Page 298 of 413



Note:  When the server on which the Executive Studio is located starts, if the system detects
files in the
<XS_server>\agora\glassfish\glassfish\domains\Config\KPI Template\ Import
directory, it automatically uploads that information. This feature is used when you log on to the
Executive Studio for the first time, to upload the out-of-the-box templates.

Tasks
This section includes:

"Migrate Scorecards, Perspectives, Objectives, Metrics, and KPIs" below

"Export nodes using CAPs" below

"Import nodes using CAPs" on the next page

Migrate Scorecards, Perspectives, Objectives, Metrics, and KPIs
Export complete trees (with their Scorecards, Perspectives, Objectives, and KPIs), Metrics, or
Unassigned KPIs from the Active KPIs pane of the Development/Test environment. For details,
see "Export nodes using CAPs" below.

Import these template trees or sub-trees, active trees, active sub-trees, Metrics or Unassigned
KPIs into the Active KPIs pane of the Production environment. For details, see "Import nodes using
CAPs" on the next page.

Export nodes using CAPs
To export nodes and hierarchical structure (trees and their Scorecards, Perspectives, Objectives,
and KPIs, Unassigned KPIs or Metrics), proceed as follows:

1. Create a CAP that only includes the items you want to export. For details, see "Create a CAP
with the Executive Scorecard application data" on page 246.

Note: You canmigrate Contexts, trees, KPIs, Metrics, user-defined pages, or
components using one CAP per type of item or one CAP for all the items you want to
export/import/migrate.

Note: You can select to perform a recalculation during the CAP activation by specifying a
recalculation date when you create the CAP.
You can also perform the calculation after all the items aremigrated. For details, see
"Perform the calculation" on page 304.

2. Export the CAP you created to the user local system. For details, see "Download a CAP to the
user's local system" on page 237.

You can now copy the CAP to the another server (for example to the Production server) and
then import it into the application. For details, see "Import nodes using CAPs" below.
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Note: You can also export nodes using a legacy JMX-based procedure. For details, see
"Export or Import Trees and KPIs" on page 336.

Import nodes using CAPs
To import nodes, proceed as follows:

1. Copy the relevant CAP from the Development or Testing environment to the Production server
or from the user's local system to the system where you want to import the item.

2. Upload the CAP to the application. For details, see "Upload a CAP to the Executive Scorecard
application" on page 234.

3. Activate the CAP inAdmin > Semantic Layer. For details, see "Activate a CAP" on page
235.

4. Verify the upload by accessing Studio and checking that all the items you wanted to import
appear in the Active KPIs.

Note: You can also import nodes using a legacy JMX-based procedure. For details, see
"Export or Import Trees and KPIs" on page 336.
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Migrate User-defined Pages or Components
You can export or import user-defined pages and components from or into the Dashboard page.

You use the import or export flows for localization purposes (when you want to work with other
languages than English) or whenmoving from staging to production and not as a way to update
system configuration.

Note:

l Youmigrate user-defined pages and components using Content Acceleration Packs
(CAPs). For details, see "Migrate user-defined Dashboard pages and components" on the
next page.

l If you need tomigrate out-of-the-box, pages, components, and events youmust use the
legacy JMX procedures. For details, see "Export or Import Out-of-the-box Pages,
Components, and Events" on page 332.

Section navigation:  l "LearnMore" below l "Tasks" below

Learn More
About importing or exporting user-defined Pages and Components
Pages are available or created in the Dashboard. Pages can include components. Components in a
page can be wired and can interact with each other using events. For details, about the Dashboard,
see Dashboard Display in the IT Executive Scorecard Business Analyst Guide.

The export operation collects the contents of user-defined pages and components. It converts the
contents to components.uim.xml, and pages.uim.xml files that describes the structure and
content of the pages and components . These files include the universally unique identifier (UUID)
of the pages and components.

The export operation uses the page and component UUID to identify the page or component .

The import operation collects the contents of a specific directory on themachine. The directory can
include components.uim.xmland pages.uim.xml files according to the same format used by the
export feature. The import feature uses these files to upload the information into the database. After
the import operation, the file is moved to the Loaded directory if the import operation succeeds, or
to theErrors directory if the import operation fails.

Note:  When the server on which the Dashboard is located starts and detects files in the
<XS_server>\agora\glassfish\glassfish\domains\BTOA\uimashup\import\toload
directory, it automatically uploads that information.

Tasks
This section includes:
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"Migrate user-defined Dashboard pages and components" below

"Export user-defined pages and components using CAPs" below

"Import user-defined pages and components using CAPs" below

Migrate user-defined Dashboard pages and components

1. Export user-defined pages and components from the Dashboard page of the
Development/Test environment. For details, see "Export user-defined pages and components
using CAPs" below.

2. Import these user-defined pages and components into the Dashboard page of the Production
environment. For details, see "Import user-defined pages and components using CAPs" below.

Export user-defined pages and components using CAPs
To export user-defined pages and components , proceed as follows:

1. Create a CAP that only includes the user-defined pages and components you want to export.
For details, see "Create a CAP with the Executive Scorecard application data" on page 246.

Note: You canmigrate Contexts, trees, KPIs, Metrics, user-defined pages, or
components using one CAP per type of item or one CAP for all the items you want to
export/import/migrate.

Note: You can select to perform a recalculation during the CAP activation by specifying a
recalculation date when you create the CAP.
You can also perform the calculation after all the items aremigrated. For details, see
"Perform the calculation" on page 304.

2. Export the CAP you created to the user local system or to the Production server. For details,
see "Download a CAP to the user's local system" on page 237.

You can now copy the CAP to the another server (for example to the Production server) and
then import it into the application. For details, see "Import user-defined pages and components
using CAPs" below.

Note: You can also export user-defined pages and components using a legacy JMX-based
procedure. For details, see "Export or Import Out-of-the-box Pages, Components, and Events"
on page 332.

Import user-defined pages and components using CAPs
To import user-defined pages and components , proceed as follows:

1. Copy the relevant CAP from the Development or Test server to the Production server or from
the user local system to the server where you want to import the items.
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2. Upload the CAP to the application. For details, see "Upload a CAP to the Executive Scorecard
application" on page 234.

3. Activate the CAP inAdmin > Semantic Layer. For details, see "Activate a CAP" on page
235.

4. Verify the upload by accessing the Dashboard and checking that all the user-defined pages and
components that you wanted to import appear in the Dashboard.

Note: You can also import user-defined pages and components using a legacy JMX-based
procedure. For details, see "Export or Import Out-of-the-box Pages, Components, and Events"
on page 332.
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Perform the calculation
In the Production server, perform the calculation to populate the KPIs, Objectives, Perspectives,
Scorecards, and Dashboard pages with data.

Note: You can select to perform a recalculation during the CAP activation by specifying a
recalculation date when you create the CAP.
You can also perform the calculation after all the items aremigrated. For details, see "Perform
the calculation" above.

Calculate for the current period

When you change the definition of a KPI (formula or threshold), the change impacts the KPI's value
and impacts the Objectives related to the KPI. Youmay want to perform the calculation for each
KPI in the selected business context for the period specified in the KPI configuration, so the impact
of the change is felt immediately in the results displayed in the Dashboard.

To calculate the current data:

1. In the Active KPIs pane, click theCalculation options button in the Active KPIs toolbar,

and select the option.

2. In the Calculate Now dialog box that opens:

n InUniverse/context for recalculation, select the relevant context (data source) you want
to use for the recalculation.

n Select the I understand the implications of this process and would like to proceed
with the calculation option to proceed with the calculation.

Limitations: You perform the calculation for the current period of each KPI within the
selected business context.

3. Click Calculate.

4. Select the I understand the implications of this process and would like to proceed with
the calculation option to proceed with the calculation.

The calculation is performed for all KPIs andObjectives with the selected context (universe).

Note:

l The calculation deletes the data that was available for the same period as the period
selected for the calculation.

l No backup is available.

HP IT Executive Scorecard (9.41) Page 304 of 413



For details, see Calculate Displayed Values after Configuration Change in the IT Executive
Scorecard Business Analyst Guide.
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Migrate the SAP BusinessObjects Enterprise
reports and BIAR files

You export the relevant BIAR files from the Development/Test environment, and then import it in
the Production environment.

1. Export BOE data to BIAR file

a. Open Import Wizard under BusinessObjects 3.1 of the Development/Test environment.
Click Next.

b. TheSource environment page of the Import Wizard opens. Select your BOE source and
enter the CMS Name, User Name and Password. Click Next.

c. TheDestination environment page opens. Select the relevant BIAR file option from the

Destination list. Click and select the file name and location of the BIAR file. Click
Next.
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d. TheSelect objects to import page opens. Click Clear All and select the options as
shown below:
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e. Click Next until the Folders and objects page opens and check the relevant folders and
object:
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f. Click Next until the Import options for universes and connections page opens and
select the 3rd option:
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g. Click Next until theUniverses folder and universes page opens and select the relevant
universes (universes related to objects selected before are automatically checked):
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h. Click Next until theReady to import page opens, where you can see what is included in
the BIAR file and if the content is OK, click Finish.
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i. The creation of the file begins. When it is completed, click Done orView detail log to see
the list of objects that were not transferred and the reason why, and then click Done.

2. Import data from BIAR file to BOE system

In the BusinessObjects 3.1 of the Production environment proceed as above but with the
source being the BIAR file and the destination being the existing BOE installation.
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Data Warehouse Back Up
It is critical that you backup DataWarehouse so that you can rebuild your DataWarehouse
infrastructure and content in disaster scenarios such as the following:

l In a total disaster recovery scenario.

l The RDBMS server failed but all Executive Scorecard component servers are fully functioning.

l When the DataWarehouse server failed, but the RDBMS server and its databases are intact.

l When aDataWarehouse database is corrupt.

l When an ETL is deleted.

l When an ETL job fails.

This section includes:

l "What to Back Up" below

l "General BackupGuidelines" on the next page

l "Files to Back Up" on page 315

What to Back Up
It is strongly recommended that you back up the following resources that may be used if one of the
above scenarios occurs.

1. Microsoft SQL Server 2008 enterprise SP2 databases

a. Target database

b. SAP BusinessObjects Data Services database

c. SAP BusinessObjects CMS database, and if necessary the Audit database.

d. Management database

e. Executive Scorecard database

Note: The host and database names can be found in theManagement database
configured in the Executive Scorecard Configuration wizard.

2. Staging database

3. It is highly recommended that you keep the passwords for the Staging, Target and SAP
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BusinessObjects Data Services database logon users in a safe place for usage in disaster
recovery situations.

4. External source files that can be found in the external source file location configured in the
Executive Scorecard Configuration wizard.

a. If the default external source file location was configured in the wizard, the Content Pack
flat files created during the ETL process can be found in: 
<Installation Directory>\agora\DataWarehouse\ExternalSources\<Content pack
name>

Example The BSM content pack flat file would therefore located in the following
directory:
<Installation Directory>\agora\DataWarehouse\ExternalSources\BSM

5. DataWarehouse Configuration files.

General Backup Guidelines
It is recommended that you use the following backup and restore guidelines:

l A best practice for data warehouse administrators is to back up critical data on a regular basis.

l Database backups should consist of a weekly full database backups, and daily differential
backups.

l Backups should be periodically verified by restoring a copy onto a test system.

l External source files and DataWarehouse configuration files should be backed up as required.

l Although out of scope for this document, regular backups should be taken of all source
databases.

l Start scheduled backups before running the daily ETLs.

l Use backup compression.

l Perform full backups in off-peak times.

Maintain the External Source Directory
In the <ExternalSource> directory , there are folders that contain extracted data from each data
source.

This data is infinitely accumulated and is never cleaned by the DataWarehouse. You are required
to periodically backup and remove old files from those folders in order to free disk space if available
disk space is low on the DataWarehouse platform machine.
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Reference
Files to Back Up
The contents of the following directories and their sub-directories should be included in the backup
schedules:

Directory Name
Backup
Frequency

Description
of files

<Installation
Directory>\Agora\DataWarehouse\<ExternalSourceslocation>

Daily .xls, and the
ETL flat files

<Installation Directory>\Agora\DataWarehouse\Conf When
configuration
changes are
made

Configuration
files

<Installation Directory>\Agora\DataWarehouse\etc After the
installation, and
when
configuration
changes are
made.

When you
recover from a
Data
Warehouse
server failure, it
is important
that this
directory and
it's sub-
directories are
restored.

Configuration
files

<Installation Directory>\Agora\DataWarehouse\log Daily Log files
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<Installation Directory>\Agora\ContentPacks Before
activating or
deactivating a
content pack in
the Executive
Scorecard
Admin
application, or
when changes
aremade to
content packs

Content pack
configuration
files

<Installation Directory>\Agora\DataWarehouse\etc\ABC
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Executive Scorecard Back Up
It is critical that you backup your databases, configuration files, logs and configuration settings so
that you can rebuild your IT Executive Scorecard solution and content in circumstances such as the
following:

l When you need to recover from a total disaster recovery scenario.

l The RDBMS server failed but all HP Executive Scorecard component servers are fully
functioning.

l When a database is corrupted.

l When a component server fails, but the RDBMS server and it's databases are intact.

The section includes the following topics:

l "What to Back Up" below

l "General BackupGuidelines" on the next page

What to Back Up
HP recommends that you back up the following resources that may be used when one of the above
scenarios occurs.

1. Microsoft SQL Server 2008 enterprise SP2 databases

a. Staging database

b. Target database

c. SAP BusinessObjects Data Services database

d. SAP BusinessObjects CMS database, and if necessary the Audit database.

e. Management database

f. Executive Scorecard database

Note: The host and database names can be found in theManagement database
configured in the Executive Scorecard Configuration wizard.

2. DataWarehouse Configuration files. For more information, see "DataWarehouse Back Up "
on page 313.

3. SAP BusinessObject Enterprise configuration. This can be backed up with the
BusinessObjects Enterprise XI 3.1 Import Wizard. For more information, see Chapter 7 of the
BusinessObjects Enterprise XI 3.1 Import Wizard Guide at
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http://help.sap.com/businessobject/product_guides/boexir31/en/xi3-1_bip_importwiz_en.pdf.

4. It is highly recommended that you keep the passwords for the Staging, Target and SAP
BusinessObjects Data Services databases in a safe place for usage in disaster recovery
situations.

5. Back up <agora>\dat\Version.txt (youmay need to restore it later).

General Backup Guidelines
It is recommended that you use the following backup and restore guidelines:

l Your database administrator should back up critical data and configuration settings on a regular
basis.

l Database backups should consist of a weekly full database backups, and daily differential
backups.

l Backups should be periodically verified by restoring a copy onto a test system.

l External source files and DataWarehouse configuration files should be backed up as required.

l Although out of scope for this document, regular backups should be taken of all source file
databases.

l Start scheduled backups before running the daily ETLs.

l Use backup compression.

l Perform full backups in off-peak times.
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Disaster and Recovery
The HP IT Executive Scorecard, DataWarehouse, or SAP BusinessObjects Data Services
servers have become unusable, for example the hard disk has crashed. The following procedure
describes how to recover the XS, DWH, and Database servers.

When you start the recovery process, youmust have complete backups of the relevant databases,
configuration files and settings that are readily available. It is possible that you will lose history
data. For details about the backups, see "Executive Scorecard Back Up " on page 317and "Data
Warehouse Back Up " on page 313.

The following scenarios are independent from the external data sources and entities. Recovering
from a scenario means that the component returns to a stable state.

About the recovery procedure
This section is a reference for the HP IT Executive Scorecard recovery process. The recovery
process for your environment may vary according to your business needs andmay require
customization. Verify that the following processes are consistent with your architecture and
environment before you proceed with real data.

Recovery for BOE server failure when BO was
not installed using XS and the configuration is
distributed

To recover from amajor SAP BusinessObjects Enterprise server failure where SAP
BusinessObjects Enterprisewas not installed using Executive Scorecard, follow the instructions in
the SAP BusinessObjects Enterprise Disaster Recovery documentation.

Recovery for a DWH server failure when the
configuration is distributed

The following procedure describes how to recover from aDWH server failure in a distributed
configuration.

1. Back up the external sources directory contents and the external sources archive directory
from the disaster DWH machine.

2. On a clean machine where you want to install a new DWH server in a distributed
environment:

a. Run the XS 9.40 installer.

b. When the post-install wizard pops up, restore the external sources directory contents and
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the external sources archive directory that were backed up prior to the disaster.

c. Run the following SQL statement:
USE <Mng_Db_Name>
delete dbo.SETTINGS_MANAGEMENT
where NAME = 'dwh.is.installed' or NAME =’ fnd.dbverify.done’

d. Run the following SQL statement
USE <Mng_Db_Name>
UPDATE [dbo].[SYS_VER] SET [MN] = 40
truncate table [dbo].[DB_UPGRADE]

e. Activate the post-install wizard:

i. In theManagement Database - Configure Management Database Settings page,
connect to your existing Configure Central Management (CCM) database.

ii. In theSAP BusinessObjects Enterprise Configure Central Management Server
(CMS) Databasepage, if displayed, select what you did in the original installation
procedure.

iii. In theConfigure Target DatabaseSettings page, if displayed, choose to use the
existing target database.

iv. In theData Warehouse - Define Staging Database Logins page, provide the
original logons.

v. In theData Warehouse - Define Target Database Login page, provide the original
logons.

vi. When the post-install wizard is successfully completed, click Finish.

vii. Run the XS 9.41 installer and 9.41 post-install configure wizard.

viii. Activate all CPs that were activated before the disaster

ix. For each CP activated before the disaster, execute:
dw_ds_automation.bat –task Activate -cp <Content_Pack_Name>.

3. On the old XS App server, reconfigure the URLs for the data source management
(DSM) page and ETL management page as follows:

a. Disable Executive Scorecard.

b. Open
<agora>\agora\glassfish\glassfish\domains\BTOA\config\appFW\applications.

c. Edit the dwh.xml file:
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d. For the DSM page, change:
https://[OLD DWH server: port]/dw-web/DataSourceManagement.jsp
to
https://[NEW DWH server: port]/dw-web/DataSourceManagement.jsp

e. For ETLmanagement page, change:
https://[OLD DWH server: port]/dw-abc-web/abc.jsp
to
https://[NEW DWH server: port]/dw-abc-web/abc.jsp

f. Open <agora>\glassfish\glassfish\domains\BTOA and delete the generated and osgi-
cachefolders if they exist.

g. Open <agora>\glassfish\glassfish\brokers and delete the instances folder if it exists.

h. Enable HP Executive Scorecard.

4. Continue to run your ETLs on the new DWH server.

Recovery from a XS server failure when the
configuration is distributed

The following procedure describes how to recover from an XS server failure in a distributed
configuration.

1. On a clean machine where you want to install a new XS server in a distributed
environment:

a. Run the XS 9.40 installer.

b. When the post-install wizard pops up, run the following SQL statement:
USE <Mng_Db_Name>
delete dbo.SETTINGS_MANAGEMENT
where NAME = 'xs.is.installed'.

c. Run the following SQL statement:
USE <Mng_Db_Name>
UPDATE [dbo].[SYS_VER] SET [MN] = 40
truncate table [dbo].[DB_UPGRADE]

d. Activate the post-install wizard:

i. In theManagement Database - Configure Management Database Settings page,
connect to your existingManagement database.

ii. In theSAP BusinessObjects Enterprise Configure Central Management Server
(CMS) Database page, if displayed, connect to your existing configure central
management database.
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iii. In theConfigure Target Database Settings page, if displayed, choose to use the
existing target database.

iv. In theData Warehouse - Define Staging Database Logins page, provide the
original logons.

v. In theData Warehouse - Define Target Database Login page, provide the original
logons.

vi. In theExecutive Scorecard - Configure Executive Scorecard Database page,
select to connect to an existing database.

vii. When the post-install wizard is successfully completed, click Finish.

e. After running 9.40 post-install, run the following SQL statement:
USE <Mng_Db_Name>
UPDATE [dbo].[SYS_VER] SET [MN] = ‘41’

f. Run the XS 9.41 installer and the 9.41 post-install wizard.

Recovery from the DWH, XS app, and BOE
server failure when the configuration is typical

The following procedure describes how to recover from aDWH, XS application, and BOE server
failure in a typical configuration.

1. Back up the external sources directory contents and the external sources archive directory
from the disaster server machine.

2. On the clean machine where you want to install XS in a typical environment:

a. Run the XS 9.40 installer.

b. When the post-install wizard pops up, restore the external sources directory contents and
the external sources archive directory that were backed up prior to the disaster.

c. Run the following SQL statement:
USE <Mng_Db_Name>
delete dbo.SETTINGS_MANAGEMENT
where NAME = 'dwh.is.installed' or NAME =’ fnd.dbverify.done’

d. Run the following SQL statement:
USE <Mng_Db_Name>
delete dbo.SETTINGS_MANAGEMENT
where NAME = 'xs.is.installed'.
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e. Run the following SQL statement:
USE <Mng_Db_Name>
delete dbo.SETTINGS_MANAGEMENT
where NAME = 'bo.engine.is.installed' or NAME='bo.in.use'.

f. Run the following SQL statement
USE <Mng_Db_Name>
UPDATE [dbo].[SYS_VER] SET [MN] = 40
truncate table [dbo].[DB_UPGRADE]

g. Activate the post-install wizard:

i. In theManagement Database - Configure Management Database Settings page,
connect to your existingManagement database.

ii. In the SAP Business Objects Enterprise - Configure Central Management
Server (CMS) Database page, connect to your existing Configure Central
Management (CMS) database.

iii. In theConfigure Target Database Settings page, if displayed, choose to use the
existing target database.

iv. In theData Warehouse - Define Staging Database Logins page, provide the
original logons.

v. In theData Warehouse - Define Target Database Login page, provide the original
logons.

vi. In theExecutive Scorecard - Configure Executive Scorecard Database page,
select to connect to an existing database.

vii. When the post-install wizard is successfully completed, click Finish.

viii. Run the XS 9.41 installer and 9.41 post-install configure wizard.

ix. Activate all the CPs that were activated before the disaster.

For each CP activated before the disaster, execute:
dw_ds_automation.bat –task Activate -cp <Content_Pack_Name>.

3. Continue to run your ETLs on the new DWH server.

Recovery of a database server failure when the
configuration is typical or distributed

The following procedure describes how to recover from a database server failure.
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1. Verify that XS is stopped.

2. Restore the databases from the backup (CMS, MNG, REP, RES, STG, TRG) into the new
dbServer.

3. Change the settings as follows.

Note: Passwords, including the admin password, in the new server cannot be changed.
You can change them once XS is up and running again.

UPDATE [<new_mng_database_name>].[dbo].[SETTINGS_MANAGEMENT]
SET VALUE =
CASE
WHEN NAME = 'new.tenant.db.host.name' THEN '<mng_new_db_server>'
WHEN NAME = 'new.tenant.db.port' THEN '<mng_ new_db_port>'
WHEN NAME = 'target.db.server' THEN '<target_ new_db_server>'
WHEN NAME = 'target.db.mssql.dbname' THEN '<target_ new_db_name>'
WHEN NAME = 'target.db.port' THEN '<target_ new_db_port>'
WHEN NAME = 'target.db.admin.username' THEN '<target_new_admin_logon_name>'
WHEN NAME = 'bods.db.name' THEN '<bods_new_db_name>'
WHEN NAME = 'bods.db.admin.username' THEN '<bods_new_db_admin_logon>'
WHEN NAME = 'bods.db.username' THEN '<bods_new_db_logon>'
WHEN NAME = 'bods.db.server' THEN '<bods_new_db_server>'
WHEN NAME = 'bods.db.port' THEN '<bods_db_port>'
WHEN NAME = 'staging.db.mssql.dbname' THEN '<staging_db_name>'
WHEN NAME = 'staging.db.admin.username' THEN '<staging_db_admin_logon>'
WHEN NAME = 'staging.db.server' THEN '<staging_db_admin_server>'
WHEN NAME = 'staging.db.port' THEN '<staging_db_port>'
WHEN NAME = 'result.db.host' THEN '<result_db_server>'
WHEN NAME = 'result.db.server' THEN '<result_db_server>'
WHEN NAME = 'result.db.mssql.dbname' THEN '<result_db_name>'
ELSE VALUE
END

For example:

UPDATE [dvm1319_MNG_new].[dbo].[SETTINGS_MANAGEMENT]
SET VALUE =
CASE
WHEN NAME = 'new.tenant.db.host.name' THEN 'labm3amdb38.devlab.ad'
WHEN NAME = 'new.tenant.db.port' THEN '1433'
WHEN NAME = 'target.db.server' THEN 'labm3amdb38.devlab.ad'
WHEN NAME = 'target.db.mssql.dbname' THEN 'dvm1319_TRG_new'
WHEN NAME = 'target.db.port' THEN '1433'
WHEN NAME = 'target.db.admin.username'THEN 'sa'
WHEN NAME = 'bods.db.name' THEN 'dvm1319_REP_new'
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WHEN NAME = 'bods.db.admin.username' THEN 'sa'
WHEN NAME = 'bods.db.username' THEN 'dvm1319_REP_new'
WHEN NAME = 'staging.db.mssql.dbname' THEN 'dvm1319_STG_new'
WHEN NAME = 'staging.db.admin.username' THEN 'sa'
WHEN NAME = 'staging.db.server' THEN 'labm3amdb38.devlab.ad'
WHEN NAME = 'staging.db.port' THEN '1433'
WHEN NAME = 'result.db.host' THEN 'labm3amdb38.devlab.ad'
WHEN NAME = 'result.db.server' THEN 'labm3amdb38.devlab.ad'
WHEN NAME = 'result.db.mssql.dbname' THEN 'dvm1319_RES_new'
ELSE VALUE
END

4. Mng DB Details:On each DWH and XS server you install, in
<agora>\conf\mngdb.properties, change the values of the following keys:

n central.db.name

n central.host.name

n central.user.name

n central.server

n central.port

n mng.db.name

n mng.host.name

n mng.user.name

n mng.server

n mng.port

n jdbc.url (server, port and DBName)

n db.username

5. In <agora>\glassfish\glassfish\domains\BTOA\config\domain.xml change the connection
pool properties (User, URL, databaseName) in three locations for DWH server and in four
locations for XS server, by searching for:

<property name="user"
<property name="url"
<property name="databaseName"

6. On each server where you are performing an installation, restart Glassfish
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In a distributed environment, it is recommended perform the restart on the servers in the
following order: BO, DWH, and XS servers.

7. Verify that XS is up and running, as follows:

n Execute the following URL on the server
browser:http://localhost:11021/invoke?operation=
showServiceInfoAsHTML&objectname=
Foundations%3Atype%3DSupervisorManager

n If you are prompted for authentication, enter:

Username: admin

Password: admin

n Refresh the execution until the status of XS is STARTED.

8. Recreate the logons and and regenerate logons and users for:

n DWH logons: (Run the command on the DWH server)

<HPXS>\agora\DataWarehouse\bin\dw_foundation_setup.bat -taskName initDB

n Other logons:

Note: If the logon exists use alter instead of create.

i. For BODS: Run a query on the relevant DB Server (BODS Repository
dbServer).

Use master
CREATE LOGIN <bods_new_logon_name> WITH PASSWORD=N'<the_same_passwor
d>', DEFAULT_DATABASE=<bods_logon_name >, DEFAULT_LANGUAGE=[us_englis
h], CHECK_EXPIRATION=OFF, CHECK_POLICY=OFF
GO
use <bods_database_name>

ALTER USER <bods_user_name> WITH LOGIN = <bods_new_logon_name>
GO
ALTER USER <bods_user_name> WITH DEFAULT_SCHEMA=[dbo]
GO
EXEC sp_addrolemember N'db_datareader', N'<bods_user_name>'
GO
EXEC sp_addrolemember N'db_ddladmin', N'<bods_user_name>'
GO
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EXEC sp_addrolemember N'db_owner', N'<bods_user_name>'
GO

Note: <the_same_password> is the password used for the sa logon to the target
database server.

ii. For XS: Run a query on the relevant DB Server (Target dbServer).

Use master
CREATE LOGIN XS WITH PASSWORD=N'<the_same_password>', DEFAULT_DATABASE
=<new_target_database_name>, DEFAULT_LANGUAGE=[us_english], CHECK_EXPI
RATION=OFF, CHECK_POLICY=OFF
GO
use <new_target_database_name>
ALTER USER XS WITH DEFAULT_SCHEMA=XS
GO
EXEC sp_addrolemember N'db_datareader', N'XS'
GO
EXEC sp_addrolemember N'db_ddladmin', N'XS'
GO
EXEC sp_addrolemember N'db_owner', N'XS'
GO
EXEC sp_addrolemember N'DWT_USER_ROLE', N'XS'
GO
ALTER AUTHORIZATION ON SCHEMA::XS TO XS
GO
ALTER USER XS WITH LOGIN = XS
GO

Note: <the_same_password> is the password used for the sa logon to the target
database server.

iii. For ITFM:Run a query on the relevant DB Server (Target dbServer).

Use master
CREATE LOGIN itaapp WITH PASSWORD=N'<the_same_password>', DEFAULT_DATA
BASE=<new_target_database_name>, DEFAULT_LANGUAGE=[us_english], CHECK_
EXPIRATION=OFF, CHECK_POLICY=OFF
GO
use <new_target_database_name>
ALTER USER itaapp WITH DEFAULT_SCHEMA= itaapp
GO
EXEC sp_addrolemember N'db_datareader', N'itaapp'
GO
EXEC sp_addrolemember N'db_ddladmin', N'itaapp'
GO
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EXEC sp_addrolemember N'db_owner', N'itaapp'
GO
EXEC sp_addrolemember N'DWT_USER_ROLE', N'itaapp'
GO
ALTER AUTHORIZATION ON SCHEMA:: itaapp TO itaapp
GO
ALTER USER itaapp WITH LOGIN = itaapp
GO

Use master
CREATE LOGIN itafpaqry WITH PASSWORD=N'<the_same_password>', DEFAULT_D
ATABASE=<new_target_database_name>, DEFAULT_LANGUAGE=[us_english], CHE
CK_EXPIRATION=OFF, CHECK_POLICY=OFF
GO
use <new_target_database_name>
ALTER USER itafpaqry WITH DEFAULT_SCHEMA= itafpaqry
GO
EXEC sp_addrolemember N'db_datareader', N'itafpaqry'
GO
EXEC sp_addrolemember N'db_ddladmin', N'itafpaqry'
GO
EXEC sp_addrolemember N'db_owner', N'itafpaqry'
GO
EXEC sp_addrolemember N'DWT_USER_ROLE', N'itafpaqry'
GO
ALTER AUTHORIZATION ON SCHEMA:: itafpaqry TO itafpaqry
GO
ALTER USER itafpaqry WITH LOGIN = itafpaqry
GO

9. On the DWH server:

n BODS Job Server

i. On the DWH server, locate the <BODS> \bin\DSConfig.txt file.

ii. Search for the section that includes your jobServer details (typically it should be
named: “[AL_JS_JobServer_1]”).

Change the relevant entries (User, database, server) to match the new database
details. Do not change the password.

Note: User refers to the BODS logon name, not BODS user name.

n Resync BODS
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i. On the DWH server, navigate toStart > SAP BusinessObjects XI 3.2 > Data
Services Server Manager.

ii. Click Edit Job Server Config.

iii. Double-click the JobServer.

iv. Click Resync.

v. Enter the BODS logon password and click Apply.

vi. Click OK to close the window.

vii. Click OK to finish the configuration.

viii. Restart your JobServer from the button at the bottom of themain dialog.

n Repository Manager:

i. On the DWH server, navigate toStart > SAP BusinessObjects XI 3.2 > Data
Services Management Console.

ii. Log on to the console. The default is admin/admin, if it has not been changed.

iii. Click Administrator.

iv. Navigate toManagement > Repositories.

v. Delete the old repository and create a new one according to the new database details.

vi. Click Test to verify the connection information, and click Apply.

vii. Go toAdministrator > Web Services.

viii. Click theWeb Services Configuration tab.

ix. Go to the bottom of the screen and select theSelect All check box.

x. In the combobox below it, click Enable Session Security.

xi. Click Apply.

n BODS Datastores (glassfish must be up and running):

Run the following commands on the DWH server:

o <HPXS>\agora\DataWarehouse\bin\dw_ds_gen.bat -datastore all -outputdir
"<HPXS>\agora\DataWarehouse\tmp\datastores"
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o <HPXS>\agora\DataWarehouse\bin\dw_ds_import.bat -inputdir
"<HPXS>\agora\DataWarehouse\tmp\datastores"

10. On the BOE Server:

n BOE – Update ODBC Connections

i. OpenC:\Windows\SysWOW64\odbcad32.exe.

ii. OpenSystem DSN and configure the BOE ODBC connection to connect the new
CMS database.

n BOE – Update JDBC Connections

i. Navigate toStart > BusinessObjects XI 3.1 > BusinessObjects Enterprise >
Designer.

ii. In the dialog box that opens, enter the following parameters:

o System: localhost:6400

o Username: administrator

o Password: <BOE_Password>

o Authentication:Enterprise

iii. Click Cancel in theWelcome page.

iv. Navigate to Tools > Connections.

v. Change all connection details and test the connection for the following: XS_MNG_
JDBC, ita_admin, ita_operations.

vi. After the tests are successful, click Next.

vii. In the next dialog box, enter the recommended numbers as follows:

o Connection Pool Mode:Keep the connection active for

o Pool timeout: 600

o Array fetch size: 100

o Array bind size: 500

o Login timeout: 500

viii. Click Finish.

11. On the DWH server, run the ETL.
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Legacy and Backward Compatibility
Procedures

This section includes the legacy procedures and the procedures needed for backward compatibility:

This section includes:

Export or Import Out-of-the-box Pages, Components, and Events 332

Export or Import Trees and KPIs 336

Export or Import Contexts 349
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Export or Import Out-of-the-box Pages,
Components, and Events

Note:

l This is a legacy proceduremeant to use for backward compatibility. The current procedure
uses CAPs. For details, see "Migrate User-defined Pages or Components" on page 301.

l The import and export of templates is not supported from version 9.02.

You can export out-of-the-box pages, components and events from the Dashboard page.

You can import existing out-of-the-box pages, components and events into the Dashboard page.

The import or export flows aremeant to be used for localization purposes (when you want to work
with other languages than English) or whenmoving from staging to production and not as a way to
update system configuration.

Section navigation:  l "LearnMore" below l "Tasks" on the next page

Learn More
About Importing or Exporting OOTB Pages, Components, and Events
Out-of-the-box pages are available in the Dashboard. Pages can include components. Components
in a page can be wired and can interact with each other using events. For details, about the
Dashboard, see Dashboard Display in the IT Executive Scorecard Business Analyst Guide.

The import and export feature is the process used tomove from the staging environment to
production.

The export feature collects the contents of the pages, components, and events. It converts the
contents to components.uim.xml, pages.uim.xml, and events.uim.xml files that describes the
structure and content of the pages, components, and events. These files include the universally
unique identifier (UUID) of the pages and components.

The export operation uses the page, component, or event UUID to identify the page, component, or
event.

The import feature collects the contents of a specific directory on themachine. The directory can
include components.uim.xml, pages.uim.xml, and events.uim.xml files according to the same
format used by the export feature. The import feature uses these files to upload the information into
the database.

After the import operation, the file is moved to:

l The Loaded directory if the import operation succeeds.

l TheErrors directory if the import operation fails.
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Note:  When the server on which the Dashboard is located starts, if the system detects files in
the
<XS_server>\agora\glassfish\glassfish\domains\BTOA\uimashup\import\toload
directory, it automatically uploads that information.

Tasks
This section includes:

"Migrate Dashboard pages, components, and events" below

"Export pages, components, or events using JMX" below

"Import pages, components, or events using JMX" on the next page

Migrate Dashboard pages, components, and events

1. Export out-of-the-box pages, components and events from the Dashboard page of the
Development/Test environment. For details, see "Export pages, components, or events using
JMX" below.

2. Import these out-of-the-box pages, components and events into the Dashboard page of the
Production environment. For details, see "Import pages, components, or events using JMX" on
the next page.

Export pages, components, or events using JMX
The legacy procedure detailed in this section produces the same results as "Export user-defined
pages and components using CAPs" on page 302.

1. Make sure you have JDK installed.

2. Run jconsole in theStartmenu.

3. In the window that opens, select theRemote Process option, enter <host_name>:<port_
number> and click Connect.

4. After the application completes its loading, click theMBeans tab.

5. You can now:
n Export pages. ExpandUIM and select Operations. In the Operation invocation area, click

the exportPages button and specify the pathToExportLocation. If the export operation is
successful, themessageMethod successfully invoked is returned, and the result is XML
files in the folder you specified.

n Export components and events. ExpandUIM and select Operations. In the Operation
invocation area, click the exportMetaData button and specify the pathToExportLocation.
If the export operation is successful, themessageMethod successfully invoked is
returned, and the result is XML files in the folder you specified.
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Import pages, components, or events using JMX
The legacy procedure detailed in this section produces the same results as "Import user-defined
pages and components using CAPs" on page 302.

1. Make sure you have JDK installed.

2. Run jconsole in theStartmenu.

3. In the window that opens, select theRemote Process option, enter <host_name>:<port_
number> and click Connect.

4. After the application completes its loading, click theMBeans tab.

5. To import all the pages, components, and events at once, expandUIM, select Operations and
in the Operation invocation area, click the importData button.
Or, you can also import pages, components and events separately as follows:

n Import the pages. ExpandUIM, and select Operations. In the Operation invocation area,
click the loadPagesData button.

If the import operation is successful, themessageMethod successfully invoked is
returned, and the imported entities are displayed in the PageGallery.

In addition, the XML file is moved to the
<XS_
server>\agora\glassfish\glassfish\domains\BTOA\config\uimashup\import\loaded\
folder.

If the import operation fails, an explanation of the failure is added in the relevant file in the
<XS_
server>\agora\glassfish\glassfish\domains\BTOA\config\uimashup\import\errors\
folder.

Note that themessageMethod successfully invokedmight be displayed in some cases in
case of failure of the import operation.

n Import the components. ExpandUIM and select Operations. In the Operation invocation
area, click the loadComponentsGallery button. If successful, themessageMethod
successfully invoked is returned, and the imported entities are displayed in the Component
Gallery..

In addition, the XML file is moved to the
<XS_
server>\agora\glassfish\glassfish\domains\BTOA\config\uimashup\import\loaded\
folder.

If the import operation fails, an explanation of the failure is added in the relevant file in the
<XS_
server>\agora\glassfish\glassfish\domains\BTOA\config\uimashup\import\errors\
folder.
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Note that themessageMethod successfully invokedmight be displayed in some cases in
case of failure of the import operation.

n Import the events. ExpandUIM, and select Operations. In the Operation invocation area,
click the loadEvents button.

If the import operation is successful, themessageMethod successfully invoked is
returned.

In addition, the XML file is moved to
<XS_
server>\agora\glassfish\glassfish\domains\BTOA\config\uimashup\import\loaded\
folder.

If the import operation fails, an explanation of the failure is added in the relevant file in the
<XS_
server>\agora\glassfish\glassfish\domains\BTOA\config\uimashup\import\errors\
folder.

Note that themessageMethod successfully invokedmight be displayed in some cases in
case of failure of the import operation.

Note:

l If information is missing from the Load directory, part of the import operationmight not
be performed.

l When a file is copied to the
<XS_server>\agora\glassfish\glassfish\domains\BTOA\config\uimashup\
import\loaded\ folder during the import process, a timestamp (Milliseconds since
midnight, January 1, 1970 UTC) is added to its name, for example: Components_pt_
BR_130810232011.xml. This way, you can see which file is currently assigned to the
database.
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Export or Import Trees and KPIs

Note:

l This is a legacy proceduremeant to use for backward compatibility. The current procedure
uses CAPs. For details, see "Migrate Trees, Metrics, and Unassigned KPIs" on page 298.

l The import and export of templates is not supported from version 9.02.

You can export complete trees (with their Scorecards, Perspectives, Objectives, and KPIs) from
the Active KPIs pane.

You can import existing template trees or sub-trees, active trees, active sub-trees, or Unassigned
KPIs into the Active KPIs pane.

The import or export flows aremeant to be used whenmoving from staging to production and not as
a way to update system configuration. If you want to use the import or export flows to update the
system configuration, youmust delete all the nodes in the active KPIs pane, before performing the
import operation.

The export and import flows are alsomeant to be used for localization purposes, when you want to
work with other languages than English.

Section navigation:  l "LearnMore" below l "Tasks" on the next page l "Reference"
on page 340

Learn More
About Exporting or Importing Trees
You use the export or import feature when you want to import or export out-of-the-box templates,
automatically update existing templates, or import new templates, or active trees into the Executive
Studio.

The export and import feature is the process used tomove from staging environment to production.

The export feature collects the contents of the Active KPIs tree (Scorecards, Perspectives,
Objectives, KPIs, and Unassigned KPIs). It converts the contents to a configuration.xml file that
describes the structure of the active tree. These files include the UUID and KPI name of the KPIs
included in the trees. In addition, the process creates a <kpi_name>.xml file per KPI in the system;
that file describes the configuration of the KPI. The XML files are created in a specific directory on
themachine. For details about the directory, see "Locations" on the next page

The import feature collects the content of a specific directory on themachine. The directory can
include configuration.xml files, and <kpi_name>.xml files according to the same format used by the
export feature or can include .xml files (the structure of these files should follow the XSD legal
model; for details, see "XML Files Used in Import and Export Operations" on page 340) with other
names. The import feature uses these files to upload the information in the specific area in the
Active KPIs tree. For details about the directory, see "Locations" on the next page.
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The export and import operations work with XML files with a specific structure. Each
configuration.xml file includes information about the hierarchy from the lowest node to the tree root.
That information is used to add the new node is added to the relevant location in the relevant tree, or
the imported node overrides the relevant node. Each <KPI_name>. xml file includes information
about the KPI configuration. That information is used so that the relevant configuration and
calculation details are added to the relevant KPI. For details about the XML file structure, see "XML
Files Used in Import and Export Operations" on page 340.

The export operation uses the KPI's UUID to identify the KPI.

In addition, you can import KPIs from Excel files. You can use this capability to import KPIs without
consideration about their location in the tree. You can also create an .xml file that provides
information about a tree structure and that refers to KPIs that are imported from the Excel file. The
import feature uses these files to upload the information in the specific area in the Active KPIs tree.
For details about the directory, see "Locations" below.

Note:  When the server on which the Executive Studio is located starts, if the system detects
files in the
<XS_server>\agora\glassfish\glassfish\domains\BTOA\Config\KPI Template\ Import
directory, it automatically uploads that information. This feature is used when you log on to the
Executive Studio for the first time, to upload the out-of-the-box templates.

Locations
Whenworking with XML files, the files are located in the following directory <XS_
server>\agora\glassfish\glassfish\domains\BTOA\Config\KPIConfiguration\Export or
Import for files corresponding to nodes in the Active KPI pane.

The Import directory includes theError, Load, and Loaded directories.

Before you import a tree, the relevant XML files or the KPI Excel files must be located in the Load
directory. After the import operation, the file is moved to:

l The Loaded directory if the import operation succeeds.

l TheError directory if the import operation fails. In this case, an error file explaining the problem
is added to the Error directory.

Tasks
This section includes:

"Migrate Scorecards, Perspectives, Objectives, and KPIs" below

"Export a node using JMX" on the next page

"Import a node using JMX" on the next page

Migrate Scorecards, Perspectives, Objectives, and KPIs
Export complete trees (with their Scorecards, Perspectives, Objectives, and KPIs) from the Active
KPIs pane of the Development/Test environment. For details, see "Export a node using JMX" on
the next page.
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Import these active trees, active sub-trees, or Unassigned KPIs into the Active KPIs pane of the
Production environment. For details, see "Import a node using JMX" below.

Export a node using JMX
The legacy procedure detailed in this section produces the same results as "Export nodes using
CAPs" on page 299.

1. Make sure you have JDK installed.

2. Run jconsole in <XS_server>\agora\jdk\bin.

3. In the window that opens, select theRemote Process option, enter <host_name>:<port_
number> and click Connect.

4. After the application completes its loading, click theMBeans tab.

5. Click com.hp.btoe.studio.jmx.

6. You can now export active KPIs from the Active KPIs pane. ExpandKPIExport, select the
Operations branch, and click exportKPIs. In the Operation invocation area, enter 0 in the text
field, and click the exportKPIs button. If the export operation is successful, themessage
Method successfully invoked is returned, and the result is XML files in the
<XS_server>\agora\glassfish\glassfish\domains\BTOA\config\kpiconfiguration\export\
folder.

Import a node using JMX
The legacy procedure detailed in this section produces the same results as "Import nodes using
CAPs" on page 300.

1. Before importing any entity, you can create a XML file with appropriate structure or you can
take an XML file you exported previously and that you want to import now. For details, see
"About Exporting or Importing Trees" on page 336.

2. Save the XML file to <XS_
server>\agora\glassfish\glassfish\domains\BTOA\config\kpiconfiguration\import\load\
folder for importing to the Active KPIs pane.

3. Make sure you have JDK installed.

4. Run jconsole in the <XS_server>\agora\jdk\bin.

5. In the window that opens, select theRemote Process option, enter <host_name>:<port_
number> and click Connect.

6. After the application completes its loading, click theMBeans tab.

7. Click com.hp.btoe.studio.jmx.

8. You can now import the tree structure or the Unassigned KPIs to the Active KPIs pane.
ExpandKPILoader, select theOperations branch, and click importKPIsAllTenants (to
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import all the KPIs of all the tenants) or importKPIsByTenant (to import all the KPIs of a
specific tenant).

If the import operation is successful, themessageMethod successfully invoked is returned,
and the imported entity is displayed in the Active KPIs pane in the Studio.

In addition, the XML file is moved to the
<XS_server>\agora\glassfish\glassfish\domains\BTOA\
config\kpiconfiguration\import\loaded\ folder.

If the import operation fails, an explanation of the failure is added in the relevant file in the
<XS_server>\agora\glassfish\glassfish\domains\BTOA\
config\kpitemplates\import\errors\ folder.

Note that themessageMethod successfully invokedmight be displayed in some cases in
case of failure of the import operation.

 If information is missing from the Load directory, part of the import operationmight not be
performed.

Example

n If one or more of the KPI XML files aremissing from the
<XS_
server>\agora\glassfish\glassfish\domains\BTOA\Config\KPITemplate\Import\L
oad directory, the trees that include themissing KPIs (represented by the
configuration.xml or by the <tree_name>.xml files) are not imported. In addition, the
relevant error files are entered in the
<XS_
server>\agora\glassfish\glassfish\domains\BTOA\Config\KPITemplate\Import\E
rrors directory.

n If one or more of themandatory properties of a KPI (for example, the formula) are
missing from the
<XS_
server>\agora\glassfish\glassfish\domains\BTOA\Config\KPITemplate\Import\L
oad directory, the KPI is not imported. In addition, the relevant error files are entered in
the
<XS_
server>\agora\glassfish\glassfish\domains\BTOA\Config\KPITemplate\Import\E
rrors directory.

For details about the structure of the XML files, see "XML Files Used in Import and Export
Operations" on the next page.

Administrator Guide
Legacy and Backward Compatibility Procedures

Page 339 of 413HP IT Executive Scorecard (9.41)



Reference
XML Files Used in Import and Export Operations
Import and export work with XML files. The XML files have the following structures:

Example of a KPI XML File:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<KPI tenantId="0">

<name>% Actual vs Planned Costs</name>
<description>The actual costs relative to the budgeted costs of an activ

ity.
</description>
<type>LEAF</type>
<period>MONTHLY</period>
<dimension></dimension>
<formula>PERCENTAGE_MATH(

SUM(Cost.Amount,Cost.CostType='Actual' and PERIOD_ENTITY=Period),
SUM(Cost.Amount,Cost.CostType='Planned' and PERIOD_ENTITY=Period)
)

</formula>

<thresholdType type="MINIMIZE">
<rangeFrom>0.0</rangeFrom>
<rangeTo>4.0</rangeTo>
<goodFrom>0.0</goodFrom>
<goodTo>2.0</goodTo>
<warningFrom>2.0</warningFrom>
<warningTo>3.0</warningTo>

</thresholdType>
<unit>%</unit>
<filter></filter>
<dataSource>test</dataSource>
<uuid>3c7a1c22-5c10-4703-a22b-4a1eac317a5c</uuid>

</KPI>

Where:

Tag Explanation Example
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<name> The name of the
KPI.

Limit:

l The name can
be up to 265
characters or
symbols.

l The forward
slash (/)
 symbol is not
supported.

<name>% Actual vs Planned Costs</name>

<description> The description of
the KPI

Limit:

l The name can
be up to 1000
characters or
symbols.

l The forward
slash (/)
 symbol is not
supported.

<description> The actual costs relative to the
budgeted costs of an activity.</description>

<type> This is type of the
entity. It can be:

l LEAF

l PARENT

l BREAKDOW
N

l BD_PARENT

The entry must be
in uppercase.

<type>LEAF</type>
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<period> The period of the
KPI. It can be:

l WEEKLY

l MONTHLY

l QUARTERLY

l YEARLY

The entry must
be in uppercase.

For details, see
Configure a KPI or
aMetric in the IT
Executive
Scorecard
Business Analyst
Guide.

<period>MONTHLY</period>
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<
businessQuestion
s>

The Business
motivation
displayed in the
Metadata area in
the KPI's
Configuration
details tab.

For details, see
Configure a KPI or
aMetric in the IT
Executive
Scorecard
Business Analyst
Guide.

Limit:

l The name can
be up to 1000
characters or
symbols.

l The forward
slash (/)
 symbol is not
supported.

<businessQuestions>What are the actual cost
and planned cost values?What is the percentage
of actual versus planned spending? How do the
actual versus planned costs measure against the
thresholds? Is actual versus planned spending on
target or in theminimum or
maximum</businessQuestions>

<comments> The comments
displayed in the
Comments area in
the KPI's
Calculation
details tab.

For details, see
Configure a KPI or
aMetric in the IT
Executive
Scorecard
Business Analyst
Guide.

<comments>My comments</comments>

<formula> The formula used
to calculate the
value of the KPI.

<formula>PERCENTAGE_MATH(SUM
(Cost.Amount,Cost.CostType='Actual' and
PERIOD_ENTITY=Period),100000)</formula>
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<thresholdType
type=" ">

The direction of
the Result
threshold. It can
be:

l MAXIMIZE

l CENTRALIZE

l MINIMIZE

The entry must be
in uppercase.

For details, see
Configure a KPI or
aMetric in the IT
Executive
Scorecard
Business Analyst
Guide.

<thresholdType type="MAXIMIZE">

% and 10% (green), and a bad rate is between
10% and 100% (red).

<rangeFrom> Lower value of the
error range.

<rangeFrom>0.0</rangeFrom>

<rangeTo> Higher value of
the error range.

<rangeTo>100.0</rangeTo>

<goodFrom> Lower value of the
good range.

<goodFrom>90.0</goodFrom>

<goodTo> Higher value of
the good range.

<goodTo>100.0</goodTo>

<warningFrom> Lower value of the
warning range.

<warningFrom>80.5</warningFrom>

<warningTo> Higher value of
the warning range.

<warningTo>90.0</warningTo>
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<unit> The KPI's unit. It
can be:

l %

l $US (The
entry must be
in uppercase.)

l Days (The
entry must be
init cap.)

<unit>%</unit>

<unit>$US</unit>

<unit>Days</unit>

<filter> The formula used
to calculate the
KPI's value.

<filter>Budget.Name = 1</filter>

<dataSource> The Context.

The Context's
entities are the
basis of the
calculation and
provide the
entities used in
the formula.

<dataSource>FinancialManagement</dataSourc
e>

<uuid> Set UUID to
identify the KPI.
You can set your
ownUUID for the
KPI.
For example
<uuid>This is
MY KPI</uuid>

<uuid>1c9eab96-5013-412c-a428-
17a1ae39317b</uuid>

Example of a Folder tree XML File:
<?xml version="1.0" encoding="UTF-8"?>
<tree xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xsi:noNamespaceSchemaLocation="../xsd/templates/Template_tree.xsd" nam
e="Industry Standard" tenantId="0">

<folder name="ITIL" description="ITIL">
<folder name="Asset Management" description="Asset Management">

<template name="Average Age of Hardware Assets"/>
</folder>
<folder name="Change Management" description="Change Management">
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<template name="Change Risk"/>
</folder>
<folder name="Financial Management" description="Financial Managemen

t">
<template name="% of budget deviation relative to total budget"/>
<template name="% Project Budget over or under"/>
<template name="Actual vs. budgeted costs"/>

</folder>
<folder name="Incident Management" description="Financial Managemen

t">
<template name="% of escalated incidents"/>
<template name="% incidents solved within SLA time"/>

</folder>
<folder name="Problem Management" description="Financial Management">

<template name="% of problems resolved on time"/>
</folder>

</folder>
<folder name="All working KPI's" description="just a copy of all tempalt

es">
<template name="% of Reopened Incidents"/>
<template name="% of critical and high incidents"/>

</folder>
</tree>

Example of a Scorecard tree XML File:
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<tree xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xsi:noNamespaceSchemaLocation="../xsd/templates/Template_tree.xsd" nam
e="Industry Standard" tenantId="0">

<scorecard name="CIO Scorecard" description="Business Value">
<perspective name="Customer" description="?">

<objective name="Reduce incident/problem management related cust
omer complaints by 30% in 2011"

rule="BEST_CHILD" period="MONTHLY">
<template name="% of Reopened Incidents"/>
<template name="% of escalated incidents"/>

</objective>
<objective name="Improve Service Delivery by 30%" rule="BEST_CHI

LD" period="MONTHLY">
<template name="% of Service Level Objectives for Met IT Pro

cess Activities"/>
<template name="Service request avg response time"/>
<template name="Service request backlog"/>

</objective>
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<objective name="Increase Customer Satisfaction by 20% in 2011"
rule="BEST_CHILD" period="MONTHLY">

<template name="Reported exceptions to SLA"/>
<template name="Customer Satisfaction"/>
<template name="Critical time outage"/>

</objective>
</perspective>
<perspective name="Internal Business Process" description="?">

<objective name="Improve Project Delivery by increasing throughp
ut by 15%" rule="BEST_CHILD"

period="MONTHLY">
<template name="Employee Utilization Rate"/>
<template name="% of projects on time"/>
<template name="Deviation % of Planned Work Hours"/>
<template name="TTM"/>

</objective>
</perspective>
<perspective name="Financial" description="?">

<objective name="Reduce unhealthy projects budget risk by 10% in
2011" rule="BEST_CHILD" period="MONTHLY">

<template name="Unhealthy projects"/>
<template name="% of Capital Exposure at Risk"/>
<template name="Unhealthy projects budget risk"/>

</objective>
<objective name="Increase Employee Utilization by 3% in 1st Qtr

2011" rule="BEST_CHILD" period="MONTHLY">
<template name="Employee Utilization Rate"/>
<template name="FCR"/>

</objective>
<objective name="Reduce IT budget by 20% in 2011" rule="BEST_CHI

LD" period="MONTHLY">
<template name="% FTE"/>
<template name="Service Actual to Plan"/>
<template name="% Outages/Total SLA uptime"/>
<template name="Business Service Cost Reduction"/>

</objective>
</perspective>
<perspective name="Learning and Growth" description="?">

<objective name="Increase Manager skills against the competency
model by 15% in 2011 above 2010"

rule="BEST_CHILD" period="MONTHLY">
<template name="Percentage of managers meeting or exceeding

leadership competency model"/>
</objective>
<objective name="Increase Employee Satisfaction by 10% in 2011"

rule="BEST_CHILD" period="MONTHLY">
<template name="Employee Attrition"/>
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<template name="Job Satisfaction"/>
<template name="Employee Satisfaction"/>

</objective>
<objective name="Increase employee productivity by 10%" rule="BE

ST_CHILD" period="MONTHLY">
<template name="Employee Utilization Rate"/>

</objective>
</perspective>

</scorecard>
</tree>

Example of a KPI Excel File:
The Excel table must include the following columns in the following order:

l ID

l KPI

l Description

l Business Questions

l Context

l Formula

l Unit Type

l Time Period

l Direction

l Range From

l Range To

l Good From

l Good To

l Warning From

l Warning To

For details about the above column contents, see Configure a KPI or aMetric in the IT
Executive Scorecard Business Analyst Guide.
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Export or Import Contexts

Note:  This is a legacy proceduremeant to use for backward compatibility. The current
procedure uses CAPs. For details, see "Semantic Layer - Context Designer" on page 170.

Tasks
This section includes:

"Import Contexts" on the next page

"Export Contexts" below

Export Contexts
Each <universe_name>.xml file includes the relevant Context information.

They are located in the <XS_
server>\agora\glassfish\glassfish\domains\BTOA\config\context\export_<tenant_ID> folder.
If a file with this name already exists in the folder, the name is changed to <universe_
name><n>.xml.

1. Make sure you have JDK installed.

2. Run jconsole in the <XS_server>\agora\jdk\bin.

3. In the window that opens, select theRemote Process option, enter <host_name>:<port_
number> and click Connect.

4. After the application completes its loading, click theMBeans tab.

5. Click com.hp.btoe.xs2go.jmx.

6. Click theExportForTenant button. This imports all the Context XML files that were in the load
folder. The format is ExportForTenant (p1,p2)where p1 is the universe name and p2 is the
tenant id.

n If the import operation is successful, themessageMethod successfully invoked is
returned, and the imported Contexts are displayed inAdmin> Context Designer
> Launch Context Designer.

n In addition, the XML file is moved to the
<XS_server>\agora\glassfish\glassfish\domains\BTOA\
config\export\loaded\ folder.

n If the import operation fails, an explanation of the failure is added in the relevant file in the
<XS_server>\agora\glassfish\glassfish\domains\BTOA\
config\export\errors\ folder.
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Note that themessageMethod successfully invokedmight be displayed in some cases in
case of failure of the export operation.

Note:  If information is missing from the Load directory, part of the export operationmight
not be performed.

Note: For information about the UUIDs, see "Contexts, entities, and fields UUIDs" on page
173.

Import Contexts

1. Save the Context XML files to the <XS_server>\agora\glassfish\glassfish\domains\BTOA\
config\context\import\load\ folder.

2. Make sure you have JDK installed.

3. Run jconsole in the <XS_server>\agora\jdk\bin.

4. In the window that opens, select theRemote Process option, enter <host_name>:<port_
number> and click Connect.

5. After the application completes its loading, click theMBeans tab.

6. Click com.hp.btoe.xs2go.jmx.

Click the ImportForTenant button. This imports all the Context XML files that were in the load
folder.

l If the import operation is successful, themessageMethod successfully invoked is returned,
and the imported Contexts are displayed inAdmin> Context Designer > Launch Context
Designer.

l In addition, the XML file is moved to the
<XS_server>\agora\glassfish\glassfish\domains\BTOA\
config\context\import\loaded\ folder.

l If the import operation fails, an explanation of the failure is added in the relevant file in the
<XS_server>\agora\glassfish\glassfish\domains\BTOA\
config\context\import\errors\ folder.

Note:

l ThemessageMethod successfully invokedmight be displayed in some cases in case of
failure of the import operation.
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l  If information is missing from the Load directory, part of the import operationmight not be
performed.

l For information about the UUIDs, see "Contexts, entities, and fields UUIDs" on page 173.
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Data Warehouse Back-End Maintenance
You canmonitor and the ETL and other functions of the DataWarehouse using the back-end tools.

This section includes:

Clean Up the Staging and Target Databases 353

Time Zone Configuration 354

Tracing and Logging 357

Add Additional Data Sources 361

Change the Configuration Definition 362

Change the DataWarehouse Period Dimensions 363

DataWarehouse Naming Conventions 364

Target and Staging Databases Naming Conventions 365

SAP BusinessObjects Data Services Naming Conventions 365

DataWarehouse CommandReference 372

ABC CommandReference 373

DWH CommandReference 381

The Automation Tool 390

Advanced DataWarehouse Administration 392

Advanced Utilities 393

Validate Catalog and Stream Definitions 395

Change the Number of Retries for a Failed ETL Step 396

Change DataWarehouse Passwords 398

Improve Performance 400

Check the Runtime Status of Batch Jobs 401

Resolve an ETL Error 402

Monitor and Tune the DataWarehouse 403

Purge Validation Tables 404

Upgrade Content Packs 405

Consolidate Entities using the XREFMechanism 406

SA Password Change 408
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Clean Up the Staging and Target Databases
You clean up the databases when you want to run the initial load anew.

The tables that are cleaned are: 

l All the data in the dwt tables in the target database.

l All the data in the dws, dwst, and xrefgen schemas in the staging database.

Note:

l The clean up tool cleans all data.

l The clean up tool cannot be activated during an ETL run.

l There is no possibility of rollback after the clean up.

Tasks
Clean up the staging and target databases

1. Backup the staging and target databases (so they are synchronized at the time of the backup)
using the tools of the relevant database servers.

2. Clean up the databases using the dw_cleandb tool. For details, see "DWH Command
Reference" on page 381
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Time Zone Configuration
The data warehouse contains data extracted from external sources. The original data sources can
be repositories in disparate locations. It is important that the data warehousemaintain accurate
date and time stamps that normalize the differences between the source time zones and the current
time of the data warehouse location. These differences include both Coordinated Universal Time
(UTC) offset and daylight savings time (DST) variations.

The data warehouse foundation has transparent internal functions that convert a source time zone
value to a UTC value, and convert the UTC value to the data warehouse local time zone during the
ETL process.

To access:
At aWindows command prompt, switch to the <Installation directory>\Agora\Data
Warehouse\bin directory.

Section navigation:  l "LearnMore" below l "Tasks" on the next page l "Time Zone
Configuration" above

Learn More
Data Warehouse DST Time Zone Information
The administrator must make sure that time zone information is current on the server hosting the
DataWarehouse. Although the definition of time zones and DST rules are fairly static, changes can
occur, for example, whenmoving the DST conversion date on a country-wide basis.

You can synchronize these changes to the Olson Timezone Database by obtaining and running the
Java TZUpdater Tool that is available on the Sun Developer Network (SDN). For more information,
visit the Java SE Timezone Updater Tool home page.

Change the Data Warehouse Period Dimensions
This procedure should be followed when expanding the DataWarehouse First and Last Year period
dimension range.

It is highly recommended that once you enter First and Last Year period dimensions in the
Executive Scorecard Configuration wizard, any future changes should take the following into
account:

1. The First Year period dimension should only be changed downwards, thereby including the
current First Year period dimension.

Example If the First Year dimension is currently set to 2005, any change should be a year
lower than 2005. Entering a year higher than 2005 can cause some data inconsistencies.

2. The Last Year period dimension should only be changed upwards, thereby including the current
Last Year period dimension.
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Example If the First year dimension is currently set to 2025, any change should be a year
higher than 2025. Entering a year lower than 2025 can cause some data inconsistencies.

Time Zone Update
The dw_tz_update_dst utility updates the DataWarehouse DST time zone information.

Tasks
"Update the DataWarehouse DST time zone" below

"Change DataWarehouse period dimensions" below

"Run the dw_tz_update_dst utility" on the next page

Update the Data Warehouse DST time zone

1. Download and run the TZUpdater tool.

2. To update DataWarehouse Server tables, run the dw_tz_update_dst as described in "Time
Zone Configuration" on the previous page.

To change data source Time Zone settings:

1. In the Executive Scorecard application, click Admin > Data Source Management, and for the
relevant Content Pack, click Activate to open the relevant activation page.

Note: If the content pack is already activated, youmust deactivate, and then reactivate
the content pack .

2. Change the Time Zone for the relevant data source, and click Next.

The TimeZoneInfo table which is part of the Staging database is automatically updated.

Note: There is a discrepancy in the status time display between ETL runs when BSM has
a different time zone than the BSM server.

Change Data Warehouse period dimensions

1. In the Executive Scorecard application, click Admin > Data Warehouse, underGeneral,
make the required changes in the First year handled by DWH dates and Last Year handled
by DWH dates settings, and click Save.

2. From a command prompt, navigate to
<Installation Directory\Agora\DataWarehouse\Bin
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Run dw_period_dim_generator.

Run the dw_tz_update_dst utility

1. At aWindows command prompt, switch to the <Installation directory>\Agora\Data
Warehouse\bin directory.

2. Run this command:
dw_tz_update_dst

a. Load or update the time zone information for a data source and the data warehouse.

b. Run this utility whenever you deploy new source data or when youmanually change the
time zone.

c. Time zone is expressed in GMT format: GMT +\-nn:nn.

Syntax
dw_tz_update_dst.bat

[-help]
[-verbose]

Options

Option Required? Description

-help N Display command syntax.

-verbose N Producemore detailed output.

Return codes:
0 – Success

1 – Success with warnings

>1 – Errors

Example
dw_tz_update_dst -verbose
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Tracing and Logging
This section describes the DataWarehouse logging and tracingmechanism. Data warehouse
scripts have different types of output log files:

One log file for each data warehouse batch utility, using the Java application Log4J.

One log file for each SQL command.

Section navigation:  l "LearnMore" below l "Tasks" on the next page l
"Reference" on page 359

Learn More
The Java Logging Mechanism
The data warehouse generates one log file for each batch utility, and stores it in the following
directories:
<installation directory>\agora\DataWarehouse\logs and
<installation directory>\agora\glassfish\glassfish\domains\BTOA\logs

Example

l dw_initdb.log

l dw_generateschemas.log

The loggingmechanism allows each new block of log information to be appended to the existing log
until it reaches themaximum size of 1MB. At that point, new logging information is stored in a
backup file. There can be amaximum of five log files for a single script. You can change the log file
name, size, andmaximum number of backup files.

SQLCommand LoggingMechanism

All the SQL commands that are executed at the direction of the data warehouse software are
redirected to simple log file. You can view the log file to trace the execution of all SQL commands.
All log files are in the following directory:
<installation directory>\agora\Datawarehouse\conf

l mssql_TablesAndSeqsResult.log

l mssql_create_dw_schema_LastRun.log

The prefix of the log file name is the RDBMS type: mssql. The suffix of the log file name is _
LastRun. This suffix indicates that the file contains the last run output of the SQL command.

To simplify interpreting SQL errors, the data warehouse applications parse the SQL server log files
to report themost critical SQL error to the user. For more information, you can review the entire log
file. Because the data warehouse appends log information in a history format in certain log files, you
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can review prior errors. Other log files retain only the history of themost recent execution. These
files always have the _LastRun suffix. For example:

l mssql_check_db_options_LastRun.log

l mssql_create_dw_schema_date_time_dim_LastRun.log

These history log files contain the date and time the SQL command runs, the date and time it
completes, and the returned status of the SQL command. For example:

----------------------------------------------------------------------
Start of command: sqlcmd -S localhost -d BTODW -U dwmetadata -P **** -i
"C:\...\\foundation\etc\sql\mssql\create_dw_staging_resources.sql" -o
"C:\...\\foundation\log\mssql_create_dw_staging_resources_LastRun.log"
At: Wed Jul 02 13:35:59 PDT 2009
----------------------------------------------------------------------
1:
2: ********** Creating staging resources **********
----------------------------------------------------------------------
End of command: sqlcmd -S localhost -d BTODW -U dwmetadata -P **** -i
"C:\...\\foundation\etc\sql\mssql\create_dw_staging_resources.sql" -o
"C:\...\\foundation\log\mssql_create_dw_staging_resources_LastRun.log"
At: Wed Jul 02 13:35:59 PDT 2009
Returned code is: 0

SAP BusinessObjects Enterprise Logs
SAP BusinessObjects Data Services produces many run-time logs. You can locate these logs in
the relevant directory
structure:
C:\<installation directory>\BO\bods\BusinessObjects Data Services\log

The \log folder has sub-directories to further organize the SAP BusinessObjects Data Services
logs.

Data Warehouse Log Files
You can access the DataWarehouse Log files in:

l datawarehouse\logs

l C:\<Installationdirectory>\agora\glassfish\glassfish\domains\btoa\logs\server.log

All information in the DataWarehouse log files is automatically sent to theWindows Event Viewer
Application log.

Tasks
"Configure the Logs" on the next page

"Access DataWarehouse log information" on the next page
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Configure the Logs
For data warehouse utilities, you can customize logging behavior by editing a related log
configuration file with this naming convention: xxx-log4j.xml. For example, importdefs-log4j.xml.
The log configuration files are in this directory:
<installation directory>\agora\DataWarehouse\conf

Open the related xxx-log4j.xml file with a text editor to choose the trace levels and to change other
parameter values. If youmake changes, save the file before you close it.

For ABC utilities, (abc-xxxx) there is a single log configuration file: abc-log4j.xml. The values that
you specify in this file apply to all log files generated by any ABC utility.

Trace Levels

You can choose one of the following trace levels to control the amount of information stored in the
logs:

l trace

l debug

l info

l warn

l error

l fatal

The default value is info. You can experiment with different levels to see how much information that
you want to display or suppress.

Access Data Warehouse log information

1. On theWindows taskbar, click Start > Administrative Tools > Event Viewer.

2. ExpandWindows Logs, right-click Application, and then click Filter Current Log.

3. Select the relevant Event Levels, select the relevant Event Sources, and then click OK.

Note:  All the DataWarehouse Event Sources begin with DWH.

Reference
Sample Log Information
The following examples show the type of information you can find in these log files. The first
example shows that a fatal error has occurred.

2008-07-02 13:33:10,652 INFO [com.hp.bto.dw.sqlbatch.SqlBatch] -
Checking database options...
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2008-07-02 13:33:10,949 FATAL
[com.hp.bto.dw.dbcreate.DbCreateCommandLine] - Problem during DB
options check:
An error that can be corrected by the user has been found. Check the
log file to correct the problem.
Check the error log file
'C:\...\\foundation\log\mssql_check_db_options_LastRun.log', line
number 2
008-07-02 13:33:10,949 FATAL
[com.hp.bto.dw.dbcreate.DbCreateCommandLine] - Exit code: 6

The second example shows successful execution.

2008-07-02 13:36:27,136 INFO
[com.hp.bto.dw.dbmetadatatool.DbMetadatatool]
Creating Date and Time stored procedures and populating the dimension
tables...
2008-07-02 13:36:30,511 INFO
[com.hp.bto.dw.commons.dblogparser.LogParserStatus] - Command
successfully executed.

It is possible to change the format of the reported information by changing the corresponding
configuration files.
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Add Additional Data Sources
You can add additional Content Packs to the data warehouse that can then be activated or
deactivated.

Add additional data sources

1. Copy the Content Pack file into the CP directory: <Installation Directory>\agora\Content
Packs.

2. Run the following batch file: dw_cp_register.bat -name <new CP>. The name enteredmust
match the Content Pack file name.

3. Activate the data source using the Data SourceManagement page. For details, see "Data
SourceManagement" on page 95.
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Change the Configuration Definition
You can change data source configuration information only after you deactivate and then re-activate
the specific data source.

Change the data source configuration

1. Select Admin > Data Source Management.

2. If necessary, deactivate the data source by clicking .

3. Click Edit Settings and edit the configuration parameters.

4. Click Next to validate your changes.

5. Click next to the specific source and the source is activated.

For details, see "Data SourceManagement" on page 95.
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Change the Data Warehouse Period
Dimensions 

This procedure should be followed when expanding the DataWarehouse First and Last Year period
dimension range.

It is highly recommended that once you enter First and Last Year period dimensions in the
Executive Scorecard Configuration wizard, any future changes should take the following into
account:

1. The First Year period dimension should only be changed downwards, thereby including the
current First Year period dimension.

Example If the First Year dimension is currently set to 2005, any change should be a year
lower than 2005. Entering a year higher than 2005 can cause some data inconsistencies.

2. The Last Year period dimension should only be changed upwards, thereby including the current
Last Year period dimension.

Example If the First year dimension is currently set to 2025, any change should be a year
higher than 2025. Entering a year lower than 2025 can cause some data inconsistencies.

Change Data Warehouse period dimensions

1. In the Executive Scorecard application, click Admin > Data Warehouse, underGeneral,
make the required changes in the First year handled by DWH dates and Last Year handled
by DWH dates settings, and click Save.

2. From a command prompt, navigate to
<Installation Directory>\agora\DataWarehouse\Bin

Run dw_period_dim_generator.
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Data Warehouse Naming Conventions
The following describes table and field naming conventions.

Type _Value Description

Table
Name
Suffixes

_DIM Dimension or bridge table.

_FACT Fact table.

_MS Monthly snapshot table that shows the last known value for the data
at the end of amonth.

_HIER Hierarchy table.

_ AGG Aggregate roll up table.

Field
Name
Prefixes

MD_ Metadata.

SRC_ Used for all fields that exist just for data warehouse internal
processes. Source. Used for all field drawn from the source for ETL
purposes only (not pushed to the target).

PK_ Primary key.

FLAG_ A binary field: Y/N.

DATE_ A date type.

DURATION_ A measure representing a length of time.

COUNT_ A measure representing a raw count.

AVG_ A measure representing an average roll up.

MAX_ A measure representing amaximum roll up.

MIN_ A measure representing aminimum roll up.

PCT_ A measure representing a percentage.

Field
Name
Suffixes

_ID A surrogate key field that is primary or foreign.

_BASE A financial amount, currency, or exchange rate in the default currency
of the data warehouse.

_ UTC A date expressed in the UTC time zone. For dates: a date expressed
in the default display time zone for the data warehouse. For money: a
financial amount, currency, or exchange rate in the original currency of
the source data.

_LOC A date expressed in the local time zone.
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Target and Staging Databases Naming Conventions
The first character of the Target and Staging databases namemust begin with an alpha character.
The init_db utility fails if you use database names that begin with numbers.

SAP BusinessObjects Data Services Naming
Conventions

This section describes the naming conventions used by tables that are part of the SAP
BusinessObjects Data Services ETL process.

This section includes:

l "Datastore " below

l "Datastore Alias " on the next page

l "Project" on the next page

l "Job Names" on page 367

l "Workflows" on page 367

l "Dataflows" on page 368

l "Variables - Global - Local Variables - Parameters" on page 368

l "Custom Functions" on page 368

l "DataWarehouse Naming Conventions" on the previous page

l "Try/Catch" on page 369

l "Conditionals" on page 370

l "Flat File Targets" on page 370

Datastore

Description Naming Convention and Examples
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Connection to database with source
application views

Datastore names have a prefix with the datastore name
and a suffix of _DS.

Format:

<SOURCE APP>_DS

Examples:

l AMVIEW_DS

l PPMVIEW_DS

l SMVIEW_DS

Connection to transactional entity
staging database

SRCSTAGING_DS

Connection to target entity staging
database

DWSTAGING_DS

Connection to data warehouse
database

DW_DS

Datastore Alias

Description Naming Convention and Examples

Name of Datastore for the specific source in
SAP BusinessObjects Data Services

Alias names have a prefix with the source
application name and a suffix of  _ALIAS.

Format:

<SOURCE APP>_ALIAS

Example AMVIEW_ALIAS

Alias user for transactional entity staging
database

SRCSTAGING_ALIAS

Alias user for target entity staging database DWSTAGING_ALIAS

Alias user for data warehouse database DW_ALIAS

Project

Description Naming Convention and Examples
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Allows you to group jobs that have
dependent schedule or belong to the same
application

Project names have a prefix with the source
application name or purpose of the project and a
suffix of  _PJ.

Format:

<DESCRIPTION>_PJ

Example FPA_PJ

Job Names

Description Naming Convention and Examples

SAP BusinessObjects Data Services job
which is a group of objects that you can
schedule and execute together

Job names have a prefix with the name of the source
application. An internal segment can describe the
job purpose. There is a suffix of _JB.

Format:

<SOURCE APP>_<PURPOSE>_JB or
<PURPOSE>_JB

Examples:

l AM_SOURCE_EXTRACT_JB

l DW_JB

Workflows

Description Naming Convention and Examples

Defines a decisionmaking
process to execute a
dataflow

Workflow names have a prefix with the source or target name. A
SUB-CATEGORY segment describes the ETL phase. There is
suffix of _WF.

Format:

<SRC NAME/TARGET NAME>_<SUB-CATEGORY>_WF

Examples:

l AM_AMRIGHTSUSESCOUNT_EXT_WF

l AM_MSI_CONTAINER_WF
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Dataflows

Description Naming Convention and Examples

Data flows extract,
transform and load
data

Dataflow names have a prefix with the source or target name. A SUB-
CATEGORY segment describes the ETL phase. There is a suffix of _
DF.

Format:

<SRC NAME/TARGET NAME><SUB_CATEGORY>_<ACTION>_DF

Examples:

AM_AMRIGHTSUSESCOUNT_EXT_DF

AM_SWAUDITDETAIL_MSI_DF

Variables - Global - Local Variables - Parameters

Description Naming Convention and Examples

Variables defined in a job
Variables defined in a job/
workflow Parameters in a
workflow/ dataflow

Variable names have a dollar sign ($) and prefix to identify the
type of variable (G for global, L for local, or P for parameter).
The suffix identifies the purpose or identifying parameter
name.

Format:

$G_<PURPOSE> or $L_<PURPOSE> or $P_<PURPOSE>

Examples:

l $G_BATCH_ID

l $L_STARTDATE

l $P_STATUS

Custom Functions

Description Naming Convention and Examples
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Script functions in Data Integrator
scripting language

Custom function names have a prefix that describes the
purpose of the function.

The suffix is _FN.

Format:

<PURPOSE>_FN

Example STARTJB_FN

Scripts

Description
Naming Convention and
Examples

Scripts created in jobs or work flows. Description can refer to
function the script is performing or the name of the table the
script is loading

Script names have a prefix that
describes the data source or
target name.
A SUB-CATEGORY segment
describes the ETL phase. The
suffix is _SC.

Format:

<SRC NAME/TARGET NAME>
or <SUB_CATEGORY>_SC.

Example AM_
AMRIGHTSUSESCOUNT_
EXT_FAIL_SC

Try/Catch

Description Naming Convention and Examples
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Specify alternative workflows if errors
occur while executing a job

Try/catch names have a prefix that describes the data
source or target name.
A SUB-CATEGORY segment describes the ETL
phase. The suffix is _TRY or _CATCH.

Format:

<SRC NAME/TARGET NAME><SUB_
CATEGORY>_TRY
or <SRC NAME/TARGET NAME><SUB_
CATEGORY>_CATCH

Examples:

l AM_AMRIGHTSUSESCOUNT_EXT_TRY

l AM_AMRIGHTSUSESCOUNT_EXT_
CATCH

Conditionals

Description Naming Convention and Examples

Conditionals are single-use objects used to
implement if-then-else logic in a work flow

Conditional names have a prefix that
describes the data source or target name.

A SUB-CATEGORY segment describes the
ETL phase. The suffix is _COND.

Format:

<SRC NAME/TARGET NAME><SUB_
CATEGORY>_COND

Example AM_
AMRIGHTSUSESCOUNT_EXT_
COND

Flat File Targets

Description Naming Convention and Examples
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Flat file
extracts of
source view

Flat file target names have a prefix that describes the datastore name. Segments
describe the source table name, batch ID, and A SUB-CATEGORY segment
describes the ETL phase. The suffix is .txt.

Format:

<DATASTORENAME (without _DS)>_<SOURCETABLENAME_BATCHID>
_<SUB-CATEGORY>.txt

Example AMVIEW_AMRIGHTSUSESCOUNT_' ||$G_Batch_ID||'
_EXTRACT_FF.TXT AMVIEW_AMRIGHTSUSESCOUNT
_' ||$G_Batch_ID||'_EXTRACT_DELETE_FF.TXT
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Data Warehouse Command Reference
This section is a syntax reference for the out-of-box scripts that are available to ETL designers and
developers.

The data warehouse contains out-of-box .xml files in this directory:
<DWH_home_directory>\DataWarehouse\conf

The table in the Command Summary section lists the out-of-box scripts that you can use to
accomplish command line tasks. These scripts produce specific results. Changing themmay
produce unpredictable results when they run. For details, see "DWH CommandReference" on
page 381.

This section includes:

"ABC CommandReference" on the next page

"DWH CommandReference" on page 381

"The Automation Tool" on page 390
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ABC Command Reference
This section describes all of the out-of-box ABC command files that are available to administer the
ABC functions. The table in the Command Summary section lists the out-of-box files that you can
use to accomplish ABC tasks.

Although SAP BusinessObjects Data Services runs the jobs that extract, transform, and load data,
ABC manages the actual launch, execution, and sequencing of the steps in these jobs. If you run
jobs using SAP BusinessObjects Data Services only, there can be conflicts, sequence errors, and
data corruption, and run-time statistics can be lost.

The data warehouse provides the out-of-box file (upstream.xml) that contains the required job
steps. The primary ABC tasks are to launch ETL batch jobs at regularly scheduled intervals and
ensure that the individual job steps run as soon as they are ready. In addition, the ABC Audit and
Control reports enable you to view information pertaining to the utilities.

Syntax Conventions
Command options in square brackets ([ ]) are optional.

Italicized lowercase expressions are variable values.

If a command option argument is a text string that contains blank spaces, youmust enclose it in
quotationmarks. Otherwise, the text before the blank space is considered the entire argument and
the remaining text becomes an undefined option.

Command Summary
The following command script files are available in this directory:
<Installation Directory>\agora\DataWarehouse\bin

Name Purpose Primary User

"dw_abc_batch_control "
on the next page

Start and stop batch job streams. Administrator

"dw_abc_load_batch " on
page 375

Load a batch job stream or register it as a
scheduled task.

Administrator

"dw_abc_run_steps " on
page 377

Run job stream steps (the ABC engine) or
register it as a scheduled task.

Administrator

"dw_abc_retry_step " on
page 378

Restart a job stream step. Administrator

"dw_abc_job_launcher "
on page 379

Start or stop job steps within a job stream. Administrator or
ETL developer

"dw_abc_set_status " on
page 380

Capture the status of job stream steps that are
implemented as batch scripts.

Administrator or
ETL developer
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dw_abc_batch_control
Use this script to start and stop batch job streams. The dw_abc_batch_control utility enables you
to:

l Suspend an active batch job stream

l Resume a suspended batch job stream

l Abort a running batch job stream

User
Administrator

Syntax
DWH_Admin

dw_abc_batch_control (-abort | -resume | -suspend)
(streamID <streamid> | -all)
[-help]

Options

Option Required? Description

Choose one of the following options:

-commandName all No Complete the named command action on all loaded
job streams.

-abort No Terminate -all or a specific streamID where the
streamID value is the catalog parameter value for
dwid="xxxx".

-abortAndKillJobs No Abort the specified stream and kill all currently
running SAP BusinessObjects Data Services jobs
(if any currently running).

-resume No Re-start -all or a specific streamID where the
streamID value is the catalog parameter value for
dwid="xxxx".
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-suspend No Temporarily stop -all or a specific streamID where
the streamID value is the catalog parameter value
for dwid="xxxx"

Choose one of the following options:

l -streamId streamId No The streamID value is the catalog parameter value
for dwid="xxxx" found in the xml file that describes
the stream: <Installation Directory>\agora\Content
Packs\Core\ABC\upstream.xml

l -all No All streams currently executing.

-help No Display command syntax

Examples

l dw_abc_batch_control -suspend -streamid Stream1

l dw_abc_batch_control -resume -all

dw_abc_load_batch
Use this script to load a batch job stream or register it as a scheduled task.

The dw_abc_load_batch utility is responsible for starting an ABC ETL track. You can run this
utility manually at the command line, or scheduled it to run at scheduled intervals.

Batch job streams can run concurrently if each job stream is independent of other job streams;
however, if two concurrent batch jobs invoke the same job stream, they cannot run successfully. If
the dw_abc_load_batch utility successfully loads a batch job, as long as that batch job is running,
any attempt to load a second instance of the same batch job will fail. Running the out-of-box
upstream.xml job stream in overlapping batches produces errors.

The dw_abc_load_batch utility initializes the ABC stream and prepares the stream steps for
execution.

The dw_run_steps utility looks for these steps that are ready and starts each one individually. The
batch jobmanages the details of extracting entities from source databases.

All the job steps in the batch job reference the same batch ID. The initial state of the batch is
Active. The initial state of all of the pending processes (job steps) is Waiting.

User
Administrator
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Syntax
dw_abc_load_batch -streamId <string>

[-register (-every <string> |-starttime <string>)]

[-unregister]

[-list]

[-help]

Options

Option Required? Description

Choose one of the following options:

-list No List tasks scheduled to run.

-list _streamId
<streamId>

Yes Identify the stream ID value that is specified in the
stream file parameter dwid="xxxx".

-register No Create a scheduled task to run dw_abc_load_batch at
regular intervals.

-unregister _streamId
<streamId>

No Unregister all the events for the specified streamId
stream.

-starttime hh:mm No Start the task to load the batch where the value for hh
is 00–24 and the value for mm is 00–59.

-streamid stream_id Yes Identify the stream ID value that is specified in the
stream file parameter dwid="xxxx".

-help No Display command syntax.

Examples

l dw_abc_load_batch -streamId streamId

l dw_abc_load_batch -streamId streamId -register -every 720

l dw_abc_load_batch -streamId streamId -register -starttime 22:30

l dw_abc_load_batch -unregister -streamId streamId

l dw_abc_load_batch -list -streamId streamId

l dw_abc_load_batch -unregister
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l dw_abc_load_batch -list

dw_abc_run_steps
Use this script to run job stream steps or register the action as a scheduled task.

The command verifies the successful execution of each step before a dependent step begins. It
also compiles a list of parallel and sequential execution steps that are ready to run, then launches
each step that is ready for execution.

The command:

l Determines which steps are ready to run and starts them.

l Creates processes for each step in a batch job stream.

l Reports execution state for each process, then updates a final execution status for the batch.

l Sets a status of Max_Execution_Time_Exceeded if a step exceeds its maximum execution
time.

l If Max_Execution_Time_Exceeded occurs, stops job step execution.

l Finds all steps that are blocking the execution of a job stream and reports them.

l Retries any step that terminates with an error and has not exceeded the specifiedmaximum
number of retries.

You can specify amaximum number of retries when an error occurs, and amaximum execution
time for each step in the job stream definition file. Because they are optional parameters, they have
default values of no retries and unlimited execution time. For details see "Change the Number of
Retries for a Failed ETL Step" on page 396.

User
Administrator

Syntax
dw_abc_run_steps [-streamId <string>]

[-every <interval>]

[-register]

[-unregister]

[-list]

[-help]
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Options

Option Required? Description

-every nnn No Start the batch load task every nnnminutes.

-list No Display a list of the registered events for all the stream
Ids.

-list _streamId
<streamId>

No Display a list of the registered events for the specified
streamId.

-register No Create a scheduled task to run dw_abc_run_steps at
regular intervals.

-unregister _streamId
<streamId>

No Unregister all the events for the specified streamId
stream.

-streamId stream_id No Stream ID value for the step to restart.

-help No Display command syntax for this command.

Examples

l To run all possible steps with a ready status:
dw_abc_run_steps -streamId Upstream

l To create a scheduled task that executes the dw_abc_run_steps command every 60
minutes:
dw_abc_run_steps -register -every 60 -streamId Upstream

l To remove a scheduled task that starts the dw_abc_run_steps:
dw_abc_run_steps -unregister -streamId Upstream

l To list a scheduled task that starts the dw_abc_run_steps:
dw_abc_run_steps -list -streamId Upstream

l To remove all scheduled tasks that starts the dw_abc_run_steps:
dw_abc_run_steps -unregister

l To list all scheduled tasks that starts the dw_abc_run_steps:
dw_abc_run_steps -list

dw_abc_retry_step
Use this script to restart a job stream step.

The dw_abc_retry_step utility re-starts a job step. When you specify amaximum number of
retries, the ABC engine blocks the job stream when that number is exceeded.
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User
Administrator

Syntax
dw_abc_load_batch -streamId <string>

-stepId <string>
[-help]

Options

Option Required? Description

-stepId step_id Y Step ID value for the step to restart.

-streamId stream_id Y Stream ID value for the step to restart.

-help N Display command syntax.

Example
dw_abc_retry_step -streamId Upstream -stepId step_id

dw_abc_job_launcher
Use this script to start or stop specific SAP BusinessObjects Data Services jobs.

User
Administrator or ETL developer

Syntax
dw_abc_job_launcher -jobname <string>

[-stop]
[-help]

Options

Option Required? Description

-jobname job_name Y Name of the job that you want to run.

-stop job_name N Stop job execution.

-help N Display command syntax.

If you omit the -process option, youmust set an environment variable%DW_PROCESS_ID% that
contains the value of the process ID.

Example
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l dw_abc_job_launcher -jobname DW_JB

l dw_abc_job_launcher -stop -jobname DW_JB

dw_abc_set_status
Use this script to set the status of job stream steps that are implemented as batch scripts.

User
Administrator or ETL developer

Syntax
dw_abc_set_status (-error | -final | running | -success | -warning)

[-info <string>]
[-help]

Options

Option Required? Description

Choose one of the following status parameters:

l -error N If an error occurs, update the data warehouse
with the error status.

l -final N If an error occurs, update the data warehouse
with themost severe status.

l -running N If an error occurs, update the data warehouse
with the run status.

l -success N If successful, update the data warehouse with
the success status.

l -warning N If a warning status occurs, update the data
warehouse with the warning status.

-help N Display command syntax.

The -info "message_text" is optional free text that you can display.

This script requires the DW_PROCESS_ID environment variable to be set with the value of the
process ID before you run this script.

Example
dw_abc_set_status -error -info "Job failed"
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DWH Command Reference
The following command script files are available in this directory:
<DWH_home_directory>\DataWarehouse\bin

Data Warehouse Script Files

Name Purpose Primary User

"dw_bods_xml_import" on the next page Import ETL from XML
files to the SAP
BusinessObjects Data
Services repository.

Administrator

"dw_cleandb" on page 383 Clean data from staging
and target databases to
imitate initial load. For
details, see "Clean Up
the Staging and Target
Databases" on page
353.

Administrator

"dw_ds_gen" on page 383 Generate themetadata
repository.

ETL developer

"dw_ds_import" on page 384 Import source files into
themetadata repository

ETL developer

"dw_etl_export" on page 384 Export the SAP
BusinessObjects Data
Services jobs,
workflows, and other
ETL components.

ETL developer

"dw_etl_import" on page 385 Import the SAP
BusinessObjects Data
Services jobs,
workflows, and other
ETL components.

ETL developer

"dw_etl_update_containers" on page 386 Build an ETLworkflow
container.

ETL developer

"dw_foundation_setup" on page 386 Build the data
warehouse foundation

Installer
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"dw_generateschemas" on page 387 Generate schemas and
tables.

ETL developer

"dw_initdb" on page 388 Initialize the data
warehouse database
schema

Administrator

"dw_tz_update_dst" on page 389 Update time zone
information

Administrator

dw_ds_automation.bat Data Source
Configuration using the
Automation Tool. For
details, see "The
Automation Tool" on
page 390.

Administrator

dw_bods_xml_import
Use this script to import ETL from XML files to the SAP BusinessObjects Data Services repository.

The input XML files are located in the indicated directory, or its subdirectories.

User
Administrator

Syntax
dw_bods_xml_import [-help] [-fromfile "<xmlfile>" | -fromdir "<directory>"]

Options

Option Required? Description

-fromdir <fromdir> N The directory, in the data source repository,
that contains the ETL XML files to import .

-fromfile <fromfile> N The XML file, in the data source repository,
from which the ETL is imported .

-help N Display command syntax.

Examples
dw_ds_gen -datastore all -outputdir c:\datastores dw_ds_gen -datastore PPM -outputdir
c:\datastores\PPM
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dw_cleandb
Use this script to clean data from the staging and target databases to start an initial load..

User
Administrator

Syntax
dw_clean_data [-help]

Options

Option Required? Description

-help N Display command syntax.

Examples
dw_clean_data.bat

dw_ds_gen
Use this script to generate one or more datastores. SAP BusinessObjects Data Services imports
these datastores to enable SAP BusinessObjects Data Services jobs to connect to the database.

User
ETL developer

Syntax
dw_ds_gen -datastore <dws|dwst|dwt|dwabc|PPM|AM|SM|all>

-outputdir <directory>
[-verbose]
[-help]

Options

Option Required? Description

-datastore Y Generate the specified data source (dws,
dwst, dwt, dwabc, PPM or AM). Specify all to
generate all sources.

-outputdir directory_name Y Path and name of the target directory where
the data source files are to be generated.

-verbose N Producemore detailed output.
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-help N Display command syntax.

Examples
dw_ds_gen -datastore all -outputdir c:\datastores dw_ds_gen -datastore PPM -outputdir
c:\datastores\PPM

dw_ds_import
Use this script to import source files from a named directory into themetadata repository. For
example, to import a collection of files into the datastore directory.

User
ETL developer

Syntax
dw_ds_import -inputdir directory

[-help]

Options

Option Required? Description

-inputdir directory_name Y Path and name of the directory where the data
source files are to be imported.

-help N Display command syntax.

Example
dw_ds_import -inputdir "c:\datastore\Source Files"

dw_etl_export
Use this script to export Data Services jobs, workflows, data flows, and functions to a zip file.

User
ETL developer

Syntax
dw_etl_export -zip <zipfile>

[-help]
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Options

Option Required? Description

-zip zip_file_name Y Export to the specified archive file.

-help N Display command syntax.

Example
dw_etl_export -zip c:\etlFiles.zip

dw_etl_import
Use this script to import Data Services jobs, workflows, data flows, and functions to a zip file.

User
ETL developer

Syntax
dw_etl_import [-atl <atlFile>]

-topdir <directory>
[-zip <zipfile>]
[-help]

Options

Option Required? Description

-atl atl_file_name N Import the specified .atl file.

-topdir directory_name Y Import all .atl files under a specified directory and
subdirectory.

-zip zip_file_name N Import the contents of the archive file.

-help N Display command syntax.

Examples
dw_etl_import -topdir c:\etlFiles

dw_etl_import -topdir "c:\ETL Files"

dw_etl_import -zip c:\etlFiles.zip

dw_etl_import -atl c:\functions.atl
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dw_etl_update_containers
This script loads .atl files during the installation process.

User
ETL developer

Syntax
dw_etl_update_containers -topdir <directory>

[-verbose]
[-help]

Options

Option Required? Description

-topdir directory_name Y Name of the directory that contains all
application-specific .atl files.

-verbose N Producemore detailed output.

-help N Display command syntax.

Return codes
0 – Success
1 – Success with warnings
>1 – Errors

Examples
dw_etl_update_containers -topdir "c:\My Application"

dw_etl_update_containers -topdir c:\MyApplication

dw_foundation_setup
Use this script to call the scripts that initialize the data warehouse, or load themetadata for data
source connections into the database.

Syntax
dw_foundation_setup [-args <taskArguments>]

-taskName <taskName>
[-verbose]
[-help]
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Options

Option Required? Description

-args task_argument N Name of the task argument.

-taskName task_name Y Name of the requested task.

-verbose N Producemore detailed output.

-help N Display command syntax.

You can see the individual tasks and associated arguments called by dw_foundation_setup if you
open this file with a text or xml editor:
<DWH_home_directory>\DataWarehouse\etc\xml\dw_foundation_setup.xml

Return codes
0 – Success
1 – Success with warnings
>1 – Errors

dw_generateschemas
Use this script to generate schemas and tables.

Syntax
dw_generateschemas [-aggregates]

[-application <application>|all]
[-autoloadingmode true|false]
[-interface]
[-noninteractive]
[-product <product>|all]
[-staging]
[-target]
[-verbose]
[-help]

Options

Option Required? Description

-aggregates N Generate or update the aggregation tables.

-application application_
name | all

N Load the named application or load all applications.
All is the default if you are in non-interactivemode.

-autoloadingmode N Specify true or false. True is the default value.
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-interface N Generate the SQL script files to create the interface.

-noninteractive N Run this script without prompting for user input. Use
all default values.

-product product_name | all N Load the specified product. All is the default value.

-staging N Generate or update the staging tables.

-target N Generate or update the target tables.

-verbose N Producemore detailed output.

-help N Display command syntax.

Interfaces will always be written to a file, whether autoloadingmode is on or not. Each interface for a
Data Source Connection is written to a separate file. If you do not specify a specific phase, all
phases execute.

Example
dw_generateschemas -application myApp -autoloadingmode true -target

dw_initdb

Use this script to initialize data warehouse foundation database schemas.

Syntax
dw_init.bat [-confdir <directory>]

[-schema <schemaname>]
-sqldir <directory>

[-help]

Options

Option Required? Description

-confdir directory N Name of the directory that contains the
.properties file for the designated schemaname.

-schema schemaname N Name of the schema, such as dwmetadata, dws,
dwst, or dwt.

-sqldir directory Y Name of the directory that contains the schema
and .properties file.

-help N Display command syntax.
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Examples
dw_init.bat -sqldir c:\myDbDirectory
dw_init.bat -sqldir c:\myDbDirectory -schema dwmetadata -confdir “c:\my Config
Directory”

dw_tz_update_dst
Load or update the time zone information for a data source and the data warehouse.

Run this utility whenever you deploy new source data or when youmanually change the time zone.

Time zone is expressed in GMT format: GMT +\-nn:nn.

Syntax
dw_tz_update_dst.bat

[-help]
[-verbose]

Options

Option Required? Description

-help N Display command syntax.

-verbose N Producemore detailed output.

Return codes:
0 – Success

1 – Success with warnings

>1 – Errors

Example
dw_tz_update_dst -verbose
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The Automation Tool
The automation tool is built and designed to simplify the different tasks of Data Source
Management.

It contains Data SourceManagement back-end tools that simplify the usage, add some necessary
validations, and set the different statuses. The functions are used by the Data SourceManagement
user interface but also provides a command line interface so it can be used outside the application
server.

The following Command Line Interface (CLI) is available for Data SourceManagement functionality
outside the UI. The command script files are found in this directory:
<DWH_home_directory>\DataWarehouse\bin

TestConnection
Usage: dw_ds_automation.bat -task TestConnection -cp xxx -xmlFilePath [Path to
datasources.xml file]

Description: Test the connection to the data source. Should be used before running the
configuration task in order to validate correct connection details.

Register Instance
Usage: dw_cp_register.bat -addInstance –name <CP_NAME>

Description:

l Use to add an additional instance of the data source.

l The DataWarehouse then looks for the CP in the Content Packs Folder.

l The instance ID is displayed in the output.“Instance ID: XX has been added to Content Pack:
<CP_NAME>”

l It is also added to the CONTENT_PACK table.

ConfigureInitial
Usage: dw_ds_automation.bat -task ConfigureInitial -cp <content pack name>-instance
<INSTANCE_ID>-xmlFilePath [Path to datasources.xml file]

Description:

l Configure the CP connection settings before the CP has been initialized.

l Use prior to CP initialization (Deploy).

Note: To successfully run this command, the ALM passwordmust be encrypted before saving
it in the Staging database.

Configure
Usage: dw_ds_automation.bat -task Configure -cp <content pack name>-instance <INSTANCE_
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ID> -xmlFilePath [Path to datasources.xml file]

Description:Configure the CP connection settings and regenerate the datastore of the product.
Can be used only after the CP has been successfully initialized.

Note: If any the following sources HP Application Lifecycle Management, HP Business
ServiceManagement, or HP Universal ConfigurationManagement Database are configured
via a back-end too, the relevant URL listed below should be run before the ETL is run:

l HP Application Lifecycle Management:
http://localhost:10002/dw/integrations/generic/reset/ALM

l HP Business Service Management:
http://localhost:10002/dw/integrations/bsm/reset/connection

l HP Universal Configuration Management Database:
http://localhost:10002/dw/integrations/ucmdb/ucmdb/reset/connection

Deploy
Usage: dw_ds_automation.bat -task Deploy -cp <content pack name>-instance <INSTANCE_ID>

Description: Initialize the CP and set the CP status as Initialized.

Activate
Usage: dw_ds_automation.bat -task Activate -cp <content pack name>-instance <INSTANCE_
ID>

Description:Activate the CP using the stream Assembler and set the CP status as Activated.
Activating the CP causes its ABC stream to bemerged with theMain (Core) CP stream. Activated
CP stream steps will be executed during the execution of theMain (Core) ABC Stream.

Deactivate
Usage: dw_ds_automation.bat -task DeActivate -cp <content pack name>-instance
<INSTANCE_ID>

Description:Deactivate the CP using the stream assembler and set the CP status as Non-
Activated. Deactivate performs the opposite action from Activate. Deactivate subtracts the
deactivated CP ABC Steps from theMain ABC Stream Steps.

AutoActivate
Usage: dw_ds_automation.bat -task AutoActivate

Description:Deploy and activate all CPs with "autostart" flag according to the order set by
"autostartpriority" in themanifest
used by the post- install tool. Themanifest found in cp_manifest.properties, is a list of attributes
located in the root folder of the Content Pack.

Administrator Guide
DataWarehouse Back-EndMaintenance

Page 391 of 413HP IT Executive Scorecard (9.41)

http://localhost:10002/dw/integrations/generic/reset/ALM
http://localhost:10002/dw/integrations/bsm/reset/connection
http://localhost:10002/dw/integrations/ucmdb/ucmdb/reset/connection


Advanced Data Warehouse Administration
This section describes some of the advanced commands for DWH processes. DWH also provides
a set of reports that provide the administrator with awareness and insight into the DWH processes.

This section includes:

"Advanced Utilities" on the next page

"Validate Catalog and Stream Definitions" on page 395

"Change the Number of Retries for a Failed ETL Step" on page 396

"Change DataWarehouse Passwords" on page 398

"Improve Performance" on page 400

"Check the Runtime Status of Batch Jobs" on page 401

"Resolve an ETL Error" on page 402

"Monitor and Tune the DataWarehouse" on page 403

"Purge Validation Tables" on page 404

"Upgrade Content Packs" on page 405

"Consolidate Entities using the XREFMechanism" on page 406

"SA Password Change" on page 408
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Advanced Utilities
The DataWarehouse enables you to run advanced ABC utilities.

dw_abc_job_launcher
Use this script to start or stop specific SAP BusinessObjects Data Services jobs.

User
Administrator or ETL developer

Syntax
dw_abc_job_launcher -jobname <string>

[-stop]
[-help]

Options

Option Required? Description

-jobname job_name Y Name of the job that you want to run.

-stop job_name N Stop job execution.

-help N Display command syntax.

If you omit the -process option, youmust set an environment variable%DW_PROCESS_ID% that
contains the value of the process ID.

Example

l dw_abc_job_launcher -jobname DW_JB

l dw_abc_job_launcher -stop -jobname DW_JB

dw_abc_set_status
Use this script to set the status of job stream steps that are implemented as batch scripts.

User
Administrator or ETL developer

Syntax
dw_abc_set_status (-error | -final | running | -success | -warning)

[-info <string>]
[-help]
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Options

Option Required? Description

Choose one of the following status parameters:

-error N If an error occurs, update the data warehouse
with the error status.

-final N If an error occurs, update the data warehouse
with themost severe status.

-running N If an error occurs, update the data warehouse
with the run status.

-success N If successful, update the data warehouse with
the success status.

-warning N If a warning status occurs, update the data
warehouse with the warning status.

-help N Display command syntax.

The -info "message_text" is optional free text that you can display.

This script requires the DW_PROCESS_ID environment variable to be set with the value of the
process ID before you run this script.

Example
dw_abc_set_status -error -info "Job failed"
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Validate Catalog and Stream Definitions
ABC utilities automatically validate xml syntax and perform more sophisticated validation, such as
loop detection in a job stream and valid catalog references to the job stream (dwid=Upstream).

If an error occurs, you can view the DW ABC Streams Management UI for stream information. Fore
details, see " ETLManagement " on page 112.

Additionally you can review the ABC Operational Status report to see where the process failed. For
details, see "ABC - Operational Status Report"
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Change the Number of Retries for a Failed ETL Step
The job stream batch file has a job stream step for each required task in the end-to-end ETL process
and for each data source. Each job stream step has a parameter value that specifies the number of
retries allowable before the job step terminates with an error. You canmanually edit this value to
increase or decrease the number of retries.

Change the number of retries

1. Navigate to the installation directory structure to locate the following file:
<Installation Directory>\agora\contentpacks\{$CP}\ABC\${stream name}.xml,
(depending on the ${CP})

2. Save a backup copy of the file before you proceed.

3. Open upstream.xml with a text editor. There is a sequential list of job stream steps that
manage the entire ETL process.

<ns1:JobStreamSteps>
<ns1:JobStreamStep dwid="SYS_READY" businessname="check ETL pre
conditions" ... maxretries="4"/>
<ns1:JobStreamStep dwid="EXTERNAL_FILE" businessname="extract External
Files" ... maxretries="4"/>
<ns1:JobStreamStep dwid="PPM_SOURCE_EXTRACT" businessname="extract PPM
to FF"... " maxretries="4"/>
<ns1:JobStreamStep dwid="AM_SOURCE_EXTRACT" businessname="extract AM to
FF" ... maxretries="4"/>
<ns1:JobStreamStep dwid="ENTERPRISE_XREF" businessname="load Xref
table" ... maxretries="4"/>
<ns1:JobStreamStep dwid="PPM_EXT" businessname="load PPM FF" ...
maxretries="4"/>
<ns1:JobStreamStep dwid="AM_EXT" businessname="load AM FF" ...
maxretries="4"/>
<ns1:JobStreamStep dwid="PPM_SSI" businessname="PPM Single Source
Identity" ... maxretries="4"/>

4. Locate the job stream step that you want to modify and changemaxretries="4" to
maxretries="nn"where nn is the number of retries before the job step terminates.

5. Save and close the file.

6. In order to activate the new ABC definitions, youmust activate the changed CP ABC
definitions.
a. If the ABC definitions weremodified in the CORE content pack, any change to the content

packs state would update the change.

b. If the ABC definitions weremodified in any of the Integration Content packs, youmust re-
activate the content pack to import the new definitions.
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7. Open the Data SourceManagement user interface, and re-activate themodified CP of which
definitions youmodified. For details, see "Data SourceManagement" on page 95.
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Change Data Warehouse Passwords
The installation and configuration process gathers all data warehouse and SAP BusinesObjects
passwords, encrypts them, and stores them in the DataWarehouse platform settings
management.

Note: In order for the ETL to successfully run after you have changed a password, youmust
change the Database Password and the Database Login Password in DataWarehouse
Settings UI. For details, see "DataWarehouse Settings" on page 140.

Change a password

1. Stop any ETLs that are running, or abort a job stream if it is running.

2. On the RDBMS server, change the password for a specific logon name.

3. Click Admin > Data Warehouse, and update the relevant logon with the new password from
step 2.

Note: Changing the password in the DataWarehouse user interface does not modify the
password in the database servers. It is preferable to rely on the user performing the
password updatemanually.

4. The DataWarehouse creates a database link which then uses the DataWarehouse and SAP
BusinessObjects Enterprise passwords. The Linked Server is created in the following
situations:

5. a. The staging and target databases are installed on different servers.

b. The populated database server name in the post-install is different than the database host
name on the system server for server id_0.

In these situations, if you reset DWH user passwords (for dwabc, dwmetadata, dws, dwst, or,
dwt), go to Linked Servers in theMicrosoft SQL Server Management Studio, and change the
relevant passwords in theSecurity tab of the Linked Server Properties, as follows.
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6. When you change the passwords in the DataWarehouse user interface as well as the
database server youmust run the following:

n <DWH root dir>\bin\dw_ds_gen.bat -outputdir \tmp\datastores -datastore all

n <DWH root dir>\bin\dw_ds_import -inputdir \tmp\datastores

7. Reload the batch using dw_abc_load_batch.bat.

8. Run ETL.

9. Note that a reboot is recommended after passwords change.

Note: It is recommended to avoid using localhost as the server database name.
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Improve Performance
Normal procedures require database administrators to set up aggregation, indices, and partitions
that can enhance performance.

Enhancing and tuning overall database performance also improve the data warehouse performance.

Because the end-to-end ETL process involves accessing remote source databases and network
connections, youmay want to evaluate where performance degradation occurs and apply tuning
strategies to these external connections.
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Check the Runtime Status of Batch Jobs
You can check the status of batch jobs and step status using the DW ABC Streams Management
UI.

Additionally, the data warehouse produces operational and administrative reports that contain
information about job status and other critical data warehouse activities.

When you view the ABC Operational Status report, you can see the global status and state of each
ETL job stream and a snapshot of the runtime status of each job stream step.

For details, see " ETLManagement " on page 112

To view reports, see ABC -Operational Status in "Control Reports" .
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Resolve an ETL Error
ETL jobs contain stream steps that you can restart.Using the DW ABC Streams Management UI,
you can view relevant step information.

If the stream step is ready for processing, the next scheduled execution of abc_run_steps.bat will
restart the stream step automatically.

If there is another impediment, such as source database or connection issues, youmust resolve
that issue before the step can complete successfully.

In the DW ABC Streams Management UI you can view step status, manually retry steps, as well
as schedule run_steps command.

For details on viewing errors and step information, see " ETLManagement " on page 112.

For back-end details, see "ABC CommandReference" on page 373.
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Monitor and Tune the Data Warehouse
The overall health of the data warehouse depends on the administrative skill of the RDBMS
administrator.

TheMicrosoft SQL Server 2008 database administrator uses standard operating procedures for
daily database operations.

The data warehouse is governed by these same processes and procedures.

For monitoring and tuning details, see theMicrosoft SQL Server 2008 documentation.
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Purge Validation Tables
There is no automated process to purge these tables on a regular schedule.

Because organizations require audit and validation information to be retained for varying amounts of
time, you should verify what the appropriate retention period is in your organization.

Use the following SQL script to delete all records in each of the validation tables that are older than
the defined retention period.

CREATE OR REPLACE PROCEDURE sp_del_valf_info AS
--declare variables
BEGIN
--Delete All Required records in selection
DELETE FROM *.VALF
WHERE --trunc(Date) &lt; '09-FEB-06'
);
COMMIT;
END sp_del_valf_info &gt;
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Upgrade Content Packs
In a case where you have a newer Content Pack folder that contains updates or fixes for the OOTB
CP you can perform the following.

Upgrade Content Packs: dw_ds_automation.bat -task Upgrade -cp [cp name] -
newContentPackPath [path of the new cp]

The following steps are automatically included in the upgrade tool:

1. Deactivate all Integration Content Packs that are activated. It is recommended to stop ETL
running and cancel all scheduling.

2. Zip the original Content Pack directory.

3. Copy the Content Pack to a new folder and run the upgrade command for that path.

This overwrites the existing Content Pack folder.

4. Activate the Core Content Pack as well as the remaining Content Packs.

5. Update the content_pack table according to the new manifest, cp_manifest.properties, a list of
attributes located in the root folder of the Content Pack being upgraded.

For activation and deactivation details, see "Data SourceManagement" on page 95.

Note the following usage limitations:

l ETL Stream should not be in a runningmode - all streams must be aborted.

l The new CP folder must be a valid CP folder.

l CP should not be in Installed state, Integration Content Packs should be activated at least once
before upgrade.

l If Core is being upgraded, it must be in theActivated state.

Note: In order to avoid upgrade failure, do not change the executables in the ABC catalog.
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Consolidate Entities using the XREF Mechanism
The consolidation process for data sources enables you to take information from the various
sources and consolidate it into a single entity. Information from two or three sources is incorporated
in the data warehouse in order to create a new entity. The XREFmechanism enables you to give
priorities to a specific source when the same entity is extracted from different sources. Additionally
you can give priority to instances of the same source.

Set Consolidation Priorities
You can change the specific consolidation priority at the entity level using an Excel spreadsheet.
Each source has an Excel which contains a list of the entities that can be consolidated, which you
can prioritize according to number, starting with 1. If you do not want an entity from a particular
source to be consolidated, enter a priority of -1.

Tasks
"Change the entity priority" below

"Cancel the consolidation of a specific entity" on the next page

Change the entity priority

1. UsingWindows Explorer, navigate toC:\<Installation
Directory>\agora\ContentPacks\<name of CP>\ETL\flatfiles. For XREF consolidation
following deployment, navigate toC:\<Installation
Directory>\agora\DataWarehouse\ExternalSources.

2. Open the specific consolidation file, for example: CONSOLIDATION_PRIORITIES_PPM.

3. Enter the priority you want to assign to each entity (DW_ID).
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4. Save and close the file.

Note:

l Consolidation priorities for multiple instances of the same data source are given according
to the order of deployment.

l If in the same instance several records have the same priority qualifier, there is
consolidation between those entities (the process does not fail), and the latest priority is
utilized.

Cancel the consolidation of a specific entity

1. In the database, open [dwmetadata].[ConsolidationPriorities].

2. Change the priority number to -1 for the specific entity.

3. Save the changes.

Note: It is not permitted tomanually change the -1 priority for OOTB entities that cannot be
consolidated.
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SA Password Change
The procedure for changing this password is complex, therefore it is recommended not to be done
often.

Change the SA password

l On BOE server:
a. Change the password in BOE ODBC connection to the new password and restart the BOE.

b. Perform the following only if you created your own universes and you are using your own
connections (not one of the following: XS_APP_JDBC, XS_DWH_JDBC, ita_admin, ita_
operations).

i. Import all of your universes into the BOE designer.

ii. In the Tools menu, select Connections.

iii. Change the SA password for all of your connections.

iv. Save and export the Universes.

v. Make sure that Period_Universe appears under the XS_Studio folder.

l On the DWH server:
a. Stop running Executive Scorecard.

b. Copy the run_postinstall.bat file from \<Installation
Directory>\installation\HPXS903\backup\agora\confwizard to
\HPXS\agora\confwizard and execute this file.

c. In theMNGDB page of the wizard, change the password for the SA user.

d. Before the final wizard step, select Skip Data Warehouse configuration and continue
completing the post-install wizard.

e. Open the DataWarehouse UI, using the following url: http://<DWH Server name
(FQDN>/dwh

f. Log on to the application using the same credentials you used to log on to the XS application.

g. Navigate toAdmin > Data Warehouse and change the passwords for all SA users.

h. Restart the DWH server.

i. If you used the SA user as a BODS user (not recommended configuration), perform the
following from the CMD dir <<Installation Directory>\agora\DataWarehouse\bin>:
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i. dw_ds_import.bat -inputdir \tmp\datastores

ii. dw_etl_update_containers.bat –topdir \tmp\datastores -upgrade

j. If you are not sure which user was used for BODS repository configurations, navigate to
Admin > Data Warehouse and check theRepository Username parameter in the SAP
BusinessObjects Data Services for HP FPA area.

l On the XS server:
a. Stop running Executive Scorecard.

b. Remove biar XS_SP2.biar from \<Installation
Directory>\agora\confwizard\conf\scripts and renameXS_SP3.biar toXS_SP2.biar.

c. Remove dwh_target_sp2_views from \<Installation
Directory>\agora\confwizard\conf\scripts\database\mssql and rename dwh_target_
sp3_views to dwh_target_sp2_views.

d. Copy the run_postinstall.bat file from \<Installation
Directory>\installation\HPXS903\backup\agora\confwizard to
\HPXS\agora\confwizard and execute this file.

e. In theManagementDatabase page of the wizard, change the password for the SA user.

f. In the Result Database page of the wizard, change the password for the SA user.

Make sure that you always connect to the existing DB when running configurations.
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Glossary

A

ABC

Audit, Balance, and Control (ABC) is an application that triggers the ETL processes. Audit
ensures consistency during ETL processing. It measures the number of records in and the
number of records out for each step and displays these runtime statistics in a collection of
audit reports. Balance verifies that data in the data warehousematches data in the source
system. For example, if the data warehouse stores project dollar amounts then the balance
process verifies that the aggregate project dollars in the data warehousematches the
aggregate project dollars in the source application data. Control governs ETL processes.
Control makes sure that there is a proper restart and recovery when a system error occurs.
Control alsomanages job dependencies at runtime.

Activity Based Costing (ABC)

The ABC methodology assigns an organization's resource costs through activities to
the products and services provided to its customers.

D

Dimension

An entity that describes, qualifies, or otherwise adds meaning to themeasurements (facts)
that business users want to analyze.

E

ETL (Extract Transform Load)

E - The extract process extracts delta data from the source systems and writes it to delimited
flat files on the file system. The data warehouse uses the Change Data Capture (CDC)
technique for extracting data from the source tables. T - During the transformation process,
ITFM transforms data into the format of the target tables and populates the load-ready target
staging tables. The Transformation layer contains load-ready tables that match the internal
structure of the data warehouse target tables. L - The load process adds new records,
updates existing records, and flags deleted records in the data warehouse target layer fact
and dimension tables.

M

Measure

A value collected by the executable during execution, such as the number of rows processed
during an ETL job, or an amount extracted from a table that describes expenses in a source
application. The ABC application does not make any assumptions about the business tasks
performed by the executable or impose any semantic requirements on computedmeasure
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values. The ABC application provides an interface for the executable to storemeasures. The
ABC reports provide drill down capabilities into the storedmeasures.

Metadata

Agreed-upon definitions and business rules stored in a centralized repository to ensure that
business users use common terminology for key business terms.

Metric

A framework to establish and collect measurements of success or failure on a regulated,
timed basis that can be audited and verified.

Multi-Dimensional

The aggregation of data by the dimensions of the business. For example, sales by region by
product by time.
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We appreciate your feedback!
If you have comments about this document, you can contact the documentation team by email. If
an email client is configured on this system, click the link above and an email window opens with
the following information in the subject line:

Feedback on Administrator Guide (IT Executive Scorecard 9.41)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client,
and send your feedback to SW-Doc@hp.com.
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